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FLIPVIEWER® XPRESS CREATOR 3.0
LICENSE AGREEMENT AND WARRANTY DISCLAIMER
E-BOOK SYSTEMS, INC.

FLIPVIEWER® XPRESS CREATOR 3.0 IS NEITHER SHAREWARE NOR
FREEWARE.
REDISTRIBUTION IS EXPRESSLY PROHIBITED.

IMPORTANT -- READ CAREFULLY: This End-User License Agreement ("EULA") is a
legal agreement between you (either an individual person or a single legal entity,
who will be referred to in this EULA as “You” and “Your”) and E-Book Systems,
Inc. ("E-Book”) for the E-Book software product that accompanies this EULA,
including any associated media, printed materials and electronic documentation
(the “Software”). The Software also includes any software updates, add-on
components, web services and/or supplements that E-Book may provide to You
or make available to You after the date You obtain Your initial copy of the
Software to the extent that such items are not accompanied by a separate license
agreement or terms of use. By clicking the "I Accept” button or installing, copying,
downloading, accessing or otherwise using the Software, You agree to be bound
by the terms of this EULA. If You do not agree to the terms of this EULA, click the
“I Do Not Accept” button, and do not install, access or use the Software; instead,
You should return it to Your place of purchase for a full refund.

1. GRANT OF LICENSE

(@) E-Book grants You a non-exclusive, non-transferable license to use the
Software for the sole purpose of creating digital multimedia content (“FlipBooks")
either (i) on storage media such as CD-ROM, CD-R, Zip Disk or similar media
containing such content created by and within the Software (*Media Versions”), or
(ii) for distribution over a computer network, including the internet (*Online
Versions”). If You have purchased the Enterprise-Basic version, You may use the
Software on up to ONE (01) standalone computer under Your control. For
Enterprise-Standard and Enterprise-Professional users, You may use the Software
on up to THREE (03) standalone computers under Your control or on any other
number of standalone computers explicitly granted by E-Book.

(b) If You are using the Software for evaluation purposes without charge for a
period of thirty (30) days or any other period of time explicitly granted by E-Book,
any use of this Software beyond the thirty (30)-day evaluation period or the
period explicitly granted by E-Book requires that You enter into a separate
agreement with E-Book.

Unregistered use of this Software after the thirty (30)-day evaluation period or
any other period of time explicitly granted by E-Book is in violation of U.S. and
international copyright laws.

(c) You may only use the Software solely to create FlipBooks for your own use.
You may not use the Software to create and sell FlipBooks to Your customers or
other 3rd parties. In order to obtain the right to distribute or sell FlipBooks to
Your customers or other 3rd parties, You must enter into a separate distribution
agreement with E-Book.



You may make only one copy of the Software for backup purposes. The same
copyright and proprietary notices of the original Software must appear on the
backup copy. You may not remove these notices from either the original Software
or backup copy.

If the Software contains documentation that is provided only in electronic form,
You may print one copy of such electronic documentation. You may not copy the
printed materials accompanying the Software.

2. LIMITATIONS

You are expressly prohibited from sublicensing, selling, transferring, renting,
leasing or otherwise distributing copies of the Software or rights to use the
Software. You may not use the Software for any use prohibited by law.

You may not disassemble, modify, reverse-engineer, adapt, decompile, translate
or create derivative works based upon the Software or any part thereof.

Except as expressly permitted in this Agreement, You may not separate any parts
of the Software for use on more than one computer.

You may not create obscene, scandalous or infringing works, as defined by any
applicable federal, state or local law at the time the work is created, using the
Software.

This Agreement does not automatically grant You any right to any enhancements
or updates to the Software.

3. COPYRIGHT

All title and intellectual property rights in and to the Software are owned by E-
Book or its licensors. The Software is protected by the copyright laws of the
United States and international copyright treaties. All title and intellectual

property rights in and to the content accessed through the Software, including

any sample content contained in the Software, is the property of the applicable
content owner and may be protected by applicable copyright or other laws. THIS
LICENSE DOES NOT GIVE YOU ANY RIGHTS TO SUCH CONTENT AND E-BOOK
SHALL HAVE NO LIABILITY WITH RESPECT TO YOUR USE OF ANY SUCH CONTENT.

4. LIMITED WARRANTY; DISCLAIMERS

E-Book warrants that the Software will perform substantially in accordance with
E-Book's published specifications for the Software for a period of ninety (90) days
from the date You acquire the Software. Your exclusive remedy, and E-Book's
entire liability, for any breach of this limited warranty shall be, in E-Book' sole
discretion, to replace the Software with functionally equivalent software or refund
the license fees paid by You for the Software, upon return of the nonconforming
Software. Any replacement Software will be warranted for the remainder of the
original warranty period or thirty (30) days, whichever is longer.

E-BOOK MAKES NO OTHER WARRANTY, EXPRESS, IMPLIED OR STATUTORY,
INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT OF THIRD-PARTY RIGHTS. SOME JURISDICTIONS DO NOT
ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO THIS DISCLAIMER MAY NOT
APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY



License Agreement

JURISDICTION. NO E-BOOK AGENT OR EMPLOYEE IS AUTHORIZED TO MAKE ANY
MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. The
foregoing warranty shall not apply to any non-conformities caused by any
modifications made to the Software by You; by accident, abuse or improper use;
or by Your violation of the terms of this EULA.

E-BOOK DOES NOT WARRANT THAT YOUR REQUIREMENTS WILL BE MET WITH
THE SOFTWARE FUNCTIONS OR THAT THE SOFTWARE’'S OPERATION WILL BE
ERROR-FREE OR UNINTERRUPTED OR THAT DEFECTS WILL BE CORRECTED. E-
BOOK SHALL ALWAYS RESERVE ITS RIGHTS AND DISCRETION TO CORRECT ANY
DEFECTS AS IT SEES FIT AND TO MAKE AVAILABLE FURTHER RELEASES AND
UPGRADES AS AND WHEN IT DEEMS NECESSARY.

5. LIMITATION OF LIABILITY

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT,
OR OTHERWISE, SHALL E-BOOK OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO
YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
EXEMPLARY OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, EVEN IF E-
BOOK SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.
IN NO EVENT SHALL E-BOOK'S TOTAL LIABILITY, WHETHER IN TORT, CONTRACT
OR OTHERWISE, ARISING OUT OF OR RELATING TO THIS EULA OR THE
SOFTWARE EXCEED THE AMOUNT PAID BY YOU FOR THE SOFTWARE. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

6. TERM OF AGREEMENT

Your rights with respect to the Software and Your rights to have individuals
(“Subscribers”) who have followed procedures prescribed by You to receive
access to one or more FlipBooks using the Software, shall commence from the
moment You accept this EULA and continue unless and until You breach any
provision of this Agreement, at which time this Agreement and Your rights
hereunder shall automatically terminate. Upon termination, You must remove the
SWEF file that comes with the Software (“Xpress Viewer Code”) from Your server
or Your ISP’s server and return to E-Book, or with E-Book’s permission destroy,
any and all copies of the Software and Xpress Viewer Code in Your possession.
Termination of this Agreement shall not relieve either party of any obligations
that accrue prior to the date of such expiration or termination.

7. DIGITAL RIGHTS MANAGEMENT

You may have elected to obtain certain digital rights management features of E-
Book's technology, to protect FlipBooks from access by unauthorized users. For
maximum effectiveness of the digital rights management features, it is necessary
that You deploy the relevant E-Book technology in the manner directed in
E-Book's documentation for the digital rights management features.
Nevertheless, You acknowledge that Subscribers will obtain access to FlipBooks
via publicly-available computer networks and that although E-Book has used key
encryption and authentication technology for its digital rights management
features, such methods are susceptible to failure, attack and defeat. You agree
that E-Book shall have no responsibility or liability for unauthorized dissemination
of or access to FlipBooks, whether as a result of improper implementation of
digital rights management features on the part of E-Book or You, defeat of data
security, misappropriation or misuse of license keys, or any other cause



whatsoever, and that, as between the parties, You assume all risk of
unauthorized dissemination of or access to FlipBooks and their content.

8. U.S. GOVERNMENT LICENSE RIGHTS

All Software provided to the U.S. Government pursuant to solicitations issued on
or after December 1, 1995 is provided with the commercial license rights and
restrictions described elsewhere herein. All Software provided to the U.S.
Government pursuant to solicitations issued prior to December 1, 1995 is
provided with RESTRICTED RIGHTS as provided for in FAR, 48 CFR 52.227-14
(JUNE 1987), or DFAR, 48 CFR 252.227-7013 (OCT 1988), as applicable.

9. EXPORT RESTRICTIONS

You acknowledge that the Software is subject to U.S. export restrictions. You
agree to comply with all applicable international and national laws that apply to
the Software, including the U.S. Export Administration Regulations, as well as
end-user, end-use and destination restrictions issued by U.S. and other
governments.

10. TERMINATION

Your license to use the Software is terminated if You violate this EULA. Upon
termination, You must destroy all copies of the Software and related
documentation.

11. GENERAL PROVISIONS

This EULA is the exclusive agreement between You and E-Book concerning the
Software and supersedes any and all prior or contemporaneous oral or written
agreements, representations, negotiations or other dealings between You and E-
Book with respect to the Software; provided, however, that if You have signed a
written license agreement for the Software which has not expired or terminated,
then that license agreement will supersede this EULA. This EULA will be governed
by the laws of the State of California applicable to contracts executed and
performed entirely in California by residents of that state. If any part of this EULA
is found to be void, unenforceable or invalid, it shall not affect the other
provisions of this EULA. This EULA can only be modified by a paper writing signed
by both parties. Failure by either party to enforce any provision of this EULA will
not be deemed a waiver of future enforcement of that or any other provision.

For further information regarding the Software or this EULA, contact E-Book at
supportstd@ebooksys.com or visit http://www.flipviewer.com.
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1.0. Introduction

1.1. Welcome to FlipViewer® Xpress
Creator

Thank you and congratulations on choosing FlipViewer (FV) Xpress Creator. FV
Xpress Creator guides you step-by-step to publish FV Xpress FlipBooks.



1.2. Introduction

FlipViewer (FV) Xpress Creator is a wizard-based software that lets you publish FV
Xpress FlipBooks. You could choose PDF, image or/and Flash documents as input
to FV Xpress Creator.

FV Xpress FlipBooks can be viewed through standard Web browsers like Internet
Explorer (IE), Firefox and Safari and Adobe Flash plugin is required.
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1.3. System Requirements

Recommended System Requirements:

Intel Core 2 Duo 2Ghz processor and above

2GB RAM or more

Windows 7, Windows Vista, Windows XP

Internet Explorer 7.0 or above

Adobe Flash plugin (version 9,0,115,0 and above)



1.4. Features

Here are some of FlipViewer (FV) Xpress Creator's features:

Convert PDF, image and Flash documents to FV Xpress FlipBook
FV Xpress Creator could convert PDF, image and Flash documents into a FV
Xpress FlipBook.

Customize Look-and-Feel of FlipBook

You can customize how your FV Xpress FlipBook looks like. You can customize
About Us, Branding logo and URL, specify number of buttons and customize skins,
Information button URL, showing of page tips and tooltips, shadow of FlipBook,
etc.

Add Advertisements to Book Background
On top of book background, you can add animated Flash advertisement to the
available spaces beside front and back covers.

Generate Files for Search Engines

FV Xpress Creator will generate files for search-engine search purposes. After
uploading the files to Web Server and register them with Google search engine,
your FV Xpress FlipBooks are ready to be searched by search engines (Google,
MSN and Yahoo!).

Create Table of Contents
You can create table of contents for readers to quickly navigate to corresponding
sections.

Create Downloadable Package
You can package your FV Xpress FlipBook into a single file for easy download.

Add Bookmarks to Pages
You can define your bookmark style and add bookmarks to important pages to
provide quick references for readers.

Add Page and Background Audio
You can specify page audio for each page and background audio for a range of
pages.

Add DRM Protection
You can add DRM protection for your FV Xpress FlipBook. You can protect the
contents of your FlipBook by encrypting your FlipBook.

Upload your FlipBook
After publishing your FV Xpress FlipBook, you can upload it through FV Xpress
Creator Uploader to your Web Server to publish it online.

Register FlipBook to FlipAnalyzer Server

After publishing your FV Xpress FlipBook, you can register it to FlipAnalyzer
Server through FV Xpress Creator. This will activate your FlipBook to be tracked
by FlipAnalyzer.
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Add FlipBook License to DRM Server

If your FlipBook is using Server License, you can add the FlipBook license to DRM
Server through FV Xpress Creator after publishing. After adding the FlipBook
license to DRM Server, your FlipBook will be activated and ready to be viewed.

Single-Page Viewing

The Publisher can now publish FlipBooks that can be viewed in either the regular
two-page flipping mode, or the single page mode. The Publisher can also set the
default viewing mode to be single page or two-page mode.

Archive

The Publisher can now set up an online archive integrated into the viewer such
that the readers can access archived issues by clicking the Archive button. The
archive function is achieved together with an additional tool called the FlipViewer
Xpress Creator Archive Tool.

Create iPad Projects

Publishers can now create FlipBooks for computers and at the same time for the
iPad platform as well. This will require users on an iPad to download the
iFlipViewer App to view the content.

Customization of Book Background with Color or Texture
The Publisher can customize the book background color or texture that will be
displayed before the actual FlipBook is displayed.



2.0. Using FlipViewer Xpress
Creator

2.1. Opening FlipViewer Xpress Creator

If you have accepted the default options in the installation process, you can start
FlipViewer (FV) Xpress Creator by using the following method:

Click Start > Programs > E-Book Systems > FlipViewer Xpress Creator >
FlipViewer Xpress Creator

Welcome

To activate your FV Xpress Creator the first time, you need to enter your
FlipViewer Xpress Creator ID. This ID will be provided by your license issuer.

4 Activate FlipViewer Xpress Creator &J

Enter your FlipViewer ¥press Creator ID to activate your
FlipWiewer Xpress Creator

FlipViewer Xpress Creator ID:

Activate H Cancel

b -

-
¥

fA-
? You must be connected to the Internet when activating and
using your FV Xpress Creator.

If you have entered a valid FV Xpress Creator ID, your FV Xpress Creator will be
opened successfully as follows.

10



Using FlipViewer Xpress Creator

A FlipViewer Xpress Creator =) i

Create/Open Project

Create a new project or browse to open an existing project.

Project

@ Create a New Project
Mew Project Mame:
MyFlipBook

Select a folder for your Project and FlipBook:

C:\Users\jared\Documents\EBookSys'FlipViewerXpressCreator

Select Project Template:
Default Project Template - J

) Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...

FlipViewer®
Xpress Creator [ CutputPlatforms
@ Computers liPad

About FlipViewer Xpress Creator

You can open the About box of FV Xpress Creator by clicking the FV Xpress

Creator icon on the left side of the title bar, then choose About FlipViewer
Xpress Creator from the drop-down list. From the About box of FV Xpress

Creator, you can know the version number of FV Xpress Creator.

4 FlipViewer Xpress Creator = i
Restore
Mave "oject.
Size

—  Minimize

Maximize e a Mew Project
Project Mame:
lipBook

Update FlipViewer Xpress Creator ID

About FlipViewer Xpress Creator
I} ct a folder for your Project and FlipBook:

x  Close Alt+F4
sersjared\Documents \EBookSys'FlipViewerXpressCreator

Select Project Template:
[Defﬁult Project Template - J

_) Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...

FlipViewer®
Xpress Creator [ OutputPlatforms
@ Computers liPad

11



Update FlipViewer Xpress Creator ID

If your FV Xpress Creator ID has expired, please contact your license issuer. You
can update your FV Xpress Creator ID by clicking the FV Xpress Creator icon at
the title bar and choose Update FlipViewer Xpress Creator ID from the drop-
down list.

A FlipViewer Xpress Creator = e

Restore
Move -oject.
Size

—  Minimize
Mazximize = a New Project
Update FlipViewer Xpress Creator ID Project Name:

A % lipBook
About FlipViewer Xpress Creator
ct a folder for your Project and FlipBook:

Close Alt+F4

* * sersjared\Documents \EBookSys'FlipViewerXpressCreator

Select Project Template:
Default Project Template - ]

(") Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...

FlipViewer®
Xpress Creator [ CutputPlatforms
(@) Computers ()iPad

You will see your currently used FlipViewer Xpress Creator ID and its expiry date.
Enter your FV Xpress Creator ID and click the Update button to get the latest
updated license. You can enter another FV Xpress Creator ID to switch to another
license.

2 Update FlipViewer Xpress Creator ID ﬁ

FlipViewer Xpress Creator ID:  pNewID

Expiry Date: Mot Applicable

Ipdate ” Cancel

12



Using FlipViewer Xpress Creator

2.2. Create or Open Project

This project wizard can start a project from scratch or open an existing one for
editing. Select one of the available options before proceeding.

A FlipViewer Xpress Creator =) i

Create/Open Project

Create a new project or browse to open an existing project.

Project
@ Create a New Project
Mew Project Mame:

MyFlipBook

Select a folder for your Project and FlipBook:

C:\Users\jared\Documents\EBookSys'FlipViewerXpressCreator

Select Project Template:
Default Project Template - |

Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...

FlipViewer®
Xpress Creator Qutput Platforms
@ Computers iPad

Create a New Project

Enter a Project Name. The project name cannot contain special characters, e.g.
[X?N<> |\

b -

-
¥

fA-
? Your Project Name must be in pure English only.

Select a folder to store your project files and FlipBooks. The default folder is "<My
Documents path>\EBookSys\FlipViewerXpressCreator\". You can click the
Browse... button to choose another folder.

If the default folder is not changed, your project files will be stored under "<My
Documents path>\EBookSys\FlipViewerXpressCreator\". A project consists of a
XML-based project (.fvx) file and a project folder ("<Project Name>_prj_files").

The output files (i.e. FlipBook and deployment files) will be in the folder "<Project
Name>_output". The name of the FlipBook by default will be the same as the
project name.

Or

13



Open an Existing Project

To open an existing project, select the Open an Existing Project option and
click the Browse... button. Browse to a folder and choose an .fvx XML document.

Click the Next>> button to go to the next step.

14



Using FlipViewer Xpress Creator

2.3. Select Source Files

You can select PDF* (.pdf), image! (.jpg, .jpeg, .png, .gif) or/and Flash* (.swf)
documents to be inserted as pages of your FlipBook.

A FlipViewer Xpress Creator = = % =
Select Source Files MyFlipBook

Select source files to be inserted into FlipB

File Mame Type Mo, of Pages
PDF 1.pdf POF 25

picture 1.JPG IMAGE 1
picture2. JPG IMAGE 1

picture3,JPG IMAGE 1
SWF Lewf Flash 1

SWF2.swf Flash 1

Detect Centerfold Pages Automatically

< <Back H Mexts=

Add Files

To add files as pages into your FlipBook, click the Add button. You will see the
following dialog box.

F N
4 Open @
Lookin: |, PDF - @ m-
MName = Date modified Type Size
'E] PDFL.pdf 6/22/201012:58 PM  Adobe Acrobat D... 195 KB
E.I] PDF2.pdf 6/22/201012:58 PM  Adobe Acrobat D... 23E KB
t&:] PDF3.pdf 6/22/201012:58 PM  Adobe Acrobat D... 381 KB
File name:
Files of type: | Supported Files (" pdf;* jpg:*jpea;” png:™ gif;" swf) v] [ Cancel ]

15



Browse to the folder in your hard disk that contains PDF (.pdf), image
(.jpg, .jpeg, .png, .gif) or/and Flash (.swf) files and select them. FV Xpress
Creator will later convert PDF and image files into Flash (.SWF) files.

If your PDF documents are password-protected, you will be prompted to enter the
PDF password.

b -

-
¥

E :
? You need to prepare the PDF documents according to given guidelines
before adding them into FV Xpress Creator. One of the steps to prepare your
PDF documents is optimizing your PDF documents. (See_PDF Optimization.)
Optimizing the PDF documents will ensure necessary fonts are embedded and
the PDF compatibility is Acrobat 6.0 (PDF 1.5). You should add links after
optimizing PDF documents as optimization may cause the PDF links to be lost.

b -

-
¥

fA-
? It is advisable that total number of pages is an even number, otherwise
FV Xpress Creator will insert a blank filler page at the back cover.

Remove Source Files

To remove files from FlipBook, select those files in the list and click the Remove
button.

If you want to remove all files, click the Remove All button.

Move Up and Move Down

To adjust the position of a file in the FlipBook, select the file and click the Move
Up or Move Down buttons.

The files will be sequentially (top to bottom) arranged and displayed as
corresponding pages in the FlipBook.

Detect Centerfold Pages Automatically

By default, the Detect Centerfold Pages Automatically check box will be
selected. If the check box is selected and the width of the page is bigger than its
height, the Centerfold check box for the corresponding page will be selected
automatically at Page Settings.

Notes:
1 If you cannot select any PDF, SWF or image files, it means that your FV Xpress Creator ID does not
have the permissions.

16



Using FlipViewer Xpress Creator

2.4. Page Settings

Page-level Settings are settings applicable to each page in your FlipBook.

3 FlipViewer Xpress Creator = X
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Name Page Mumber | Centerfold | Bookmark Primary Secondary | Background FDF Show Shadow -
Page Audio | Page Audio Audio Optimization Level [v
POF1_1.swf 1 Standard |_
PDF1_2.swf 2 [ Standard [v
PDF1_3.swf 3 [~ Standard [v
POF1_4.swf 4 [ Standard [v
PDF1_5.swf 5 [ Standard [v
POF1_6.swf g l_ Standard [v
POF1_7.swf 7 [ Standard [v
PDF1_8.swf 3 |_ Standard [v
PDF1_9.swf 9 [ Standard [v
PDF1_10.swf 10 [ Standard [v
PDF1_11.swf 11 [ Standard [v
PDF1_12.swf 12 [ Standard [v

PDF1_13.swf 13 |_ Standard [v il

Preview | | Settings. .. | | <<Back ‘ | Publish Trial ‘ | Publish Final

2.4.1. File Name

Under the File Name column, you will see a list of file names for pages in your
FlipBook.

All file names will have file extension .swf as each source file will be converted to
the Flash (.swf) file format.

If your PDF document is a multiple-page PDF (i.e. one PDF file containing multiple
pages), you will see the filename of each page as follows: "<Filename of PDF
(without .pdf extension)_<Page Number>.swf". For example, if the filename of
your PDF document is "abc.pdf" and it has 4 pages, the filename of each page in
FlipBook will be "abc_1.swf", "abc_2.swf", "abc_3.swf", "abc_4.swf".

b -

E -

# -

? You can see the full path of the filename at tooltips when mouse-over
cells under File Name column.
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2.4.2. Page Number

Under the Page Number column, you will see page number of your FlipBook.

Page numbers will be shown in multiple places. They are used as mouse-over
hints when readers are using the book thickness to navigate to other pages of the
FlipBook. When performing search or go to a page, your readers can use page
numbers as cues.

Front Cover is page 1. The second page will be page 2 and so on. You can
customize the format of your page numbering by first selecting the cell
corresponding to the page under the Page Number column then click the ...
button. The Edit Page Number dialog box will be shown as below.

4 Edit Page Number ot S

Mumber Format: 1,2,3.., -
Page Mumbering
Continue from previous section
Q@ Startat: 1 =

Empty

Page Description
Indude Page Description

Mote: Page Mumber will appear at the position of
symbal #

| Display two page numbers for centerfold pages

| Remove |[ QK H Cancel

Change Number Format

At the drop-down list beside the Number Format, choose a desired number
format, i.e. "1,2,3...", "-1,-2,-3...", "i,ii,iii..." or "I,II III...".

Restart Page Numbering

You can restart page numbering from any page.

1. Select the cell corresponding to the page under the Page Number column
where you want to restart the page numbering. Click the ... button and you will
see the Edit Page Number dialog box.

2. Select Continue from previous section to make your page numbering

continue from the previous section or select Start at <page number> to restart
your page numbering from a specified number.
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If you choose Empty, page numbers will not be displayed on these pages when

viewed in FV Xpress.

=3 Edit Page Number

LX)

Mumber Format: 1,2,3.., -
Page Mumbering
Continue from previous section
@ Startat: 2 =
(") Empty

Page Description
["]indude Page Description

Mote: Page Mumber will appear at the position of
symbal #

Display two page numbers for centerfold pages

[ remove |[_ox ][ conce

Add Page Description

sour

To include page description together with page numbering, select the Include
Page Description check box. Enter the page description, e.g. "Page #" and page

numbering will appear at the position of the # symbol.

Example:
= Edit Page Number

LX)

Mumber Format: 1,2,3... -

Page Mumbering
(@) Continue from previous section
() Startat: |0
(") Empty

Page Description

Indude Page Description

Page %

Mote: Page Mumber will appear at the position of
symbal #

Display two page numbers for centerfold pages

[ remove |[ ok ][ conce

Based on the example above, page numbering will look like "Page 1, Page 2, Page

19



For Centerfold Pages
If you want to display two page numbers for centerfold pages, select the

“Display two page numbers for centerfold pages” check box. If you uncheck
this option, only one page number will be displayed for a centerfold page.

20



Using FlipViewer Xpress Creator

2.4.3. Centerfold

Centerfold

Selecting the check box at the Centerfold column will change the display of the
corresponding page to the centerfold mode. In other words, the page will be
displayed in a full-page spread. By default, this check box is not selected and the
pages will be displayed in two-page mode, i.e. each page will cover half of a full-
page spread.

If the width of the page is bigger than its height, the Centerfold check box for
the corresponding page will be selected automatically.

If you want all pages to be displayed in centerfold mode, i.e. all check boxes
under Centerfold column to be selected, select the check box below the main
header “Centerfold”.

4 FlipViewer ¥press Creator = |
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Mame Page Mumber | Centerfold | Bookmark Primary Secondary | Background FDF Show Shadow -
[v Page Audio | Page Audio Audio Optimization Level [v
PDF1_Lswf 1 Q Standard -
PDF1_2.swf 2-3 [v Standard [v
PDF1_3.swf 4-5 [v Standard [v
POF1_4.swf 6-7 [v Standard [v
PDF1_5.swf 8-9 [v Standard [v
PDF1_6.swf 0-11 [v Standard [v
POF1_7.swf 12-13 [v Standard [v
PDF1_8.swf 14-15 [v Standard [v
PDF1_9.swf 16-17 [v Standard [v
PDF1_10.swf 18-19 [v Standard [v
PDF1_11.swf W0-21 [v Standard [v
PDF1_12.swf 22-23 [v Standard [v

PDF1_13.swf 24-35 [v Standard [v il

Preview | | Settings. .. | | <<Back ‘ | Publish Trial ‘ | Publish Final

b -

¥

fA-
? Centerfold settings are not applicable to cover pages.

2.4.5. Bookmark!

The Bookmark column allows you to customize the bookmark text and color for
each corresponding page.
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To add a bookmark to a page, select the corresponding cell at the Bookmark
column and enter the desired text for the bookmark. Click the color button to
select a color for your bookmark. The Color dialog box will be shown as below.
After selecting a color, click the OK button to confirm.

2 FlipViewer Xpress Creator = 2
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Name Page Mumber | Centerfold | Bookmark Primary ] Secondary ] Background ] FDF Show Shadow -
v P - - - ~rization Level v
Cal @
POFL_Lanf 1 — d -
PDF1_2.swf 2-3 ¥  |[contents | || Basiccolors: d I
PDFL_3.5wf 4-5 ~ | FENTT EEE 2
PDFI_4.50f 5-7 rd T EEE NN E ra
PDFL_5.swf 8-9 v EEEEEENE v
PDFL_6.swf 10-11 v FEEEEENE v
PDFL_7.5wf 12-13 2 AEEEEEENE 2
PDFI_8.5wf 14- 15 rd EERENTE B ra
PDF1_9.swf 16 - 17 2 j | Pe—— d v
PDF1_10.swf 18 -19 v d v
S F EEEEEEEm | F
PDF1_11.sw 20-21 (3 (3
= EEEEEEEE
PDF1_12.5wf 2-23 r2 d r2
POF1_13.smf 24.35 v [ Define Custom Colors == ] a v il
|
——
Preview Settings... < <Back Publish Trial Publish Final

Notes:
L If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.4.5. Primary and Secondary Audio

Primary and secondary page audio are audio files assigned to a page.

The secondary page audio will play simultaneously with the primary page audio.
When the primary page audio stops playing, the secondary page audio will also
stop playing. For example, primary page audio could be narration audio files and
the secondary page audio are sound effect files. When the narration stops, the
sound effect will also stop playing.

To assign primary page audio, select the corresponding cell at the Primary Page
Audio® column and click the ... button. The Add Primary Page Audio dialog box
will be shown as below.

Page Mumber: 1
Audio Files | Comments |
CoFVE ALdio \AOHK. mp3

C:\PVAudio\AYBC.mp 3

Mowe Dawn

[~ Enable Audio Loop
oK ] ’ Cancel

To assign secondary page audio, select the corresponding cell at the Secondary
Page Audio® column and click the ... button. The Add Secondary Page Audio
dialog box will be shown as below.
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Page Mumber: 1
Audio Files | Comments |

C:\PViaudio \FUAM. mp3

[~ Enable Audio Loop

QK ] I Cancel

Add Page Audio Files

1. To add audio files, click the Add button and browse to select one or multiple
audio files (.MP3).

2. Click the OK button to confirm.

Remove Page Audio Files

1. To remove any audio files in the play list, select the audio file and click the
Remove button.

2. Click the OK button to confirm.

Adjust Page Audio File Positions

1. To adjust the position of audio files in the play list, select the desired audio
file(s) and click the Move Up or Move Down buttons. Audio files will be played
sequentially from top to bottom.

2. Select the Enable Audio Loop check box if you want to repeat the playing of
the audio files in the play list after the last audio file finishes playing.

3. Click the OK button to confirm.
Other FAQs:

If the duration of the secondary page audio is shorter than the primary page
audio, and the secondary page audio is enabled to play in a loop, the secondary
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page audio will continue to play within the duration of the playing of the primary
page audio.

For a FlipBook that is displayed in two-page mode, its left and right page may be
assigned different primary page audio. If the left primary page audio is enabled to
play in a loop but the right primary page audio is not, the left primary page audio
will be played first followed by the right primary page audio before the primary
page audio will be played repetitively.

If both the left and right primary page audio are enabled to play in a loop, the left
primary page audio will be played first followed by the right primary page audio
and then both will be played in this sequence repetitively.

2.4.6. Background Audio

Background Audio is where you specify the audio files that play in the background
while the primary page audio and secondary page audio are playing. You can
specify background audio for a range of pages. The background audio will play
continuously within the specified page range.

To assign background audio, select the cell corresponding to the start page under
the Background Audio® column and click the ... button. The Add Background
Audio dialog box will be shown as below.

From Page: 1

To Page: 54 -

Audio Files Comments |
C:\FVX \Audio \JGCX. mp3

["| Enable Audio Loop

From Page will be the page number to start playing the background audio.
Select the last page to play the background audio from the drop-down list beside
To Page.
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b -

M

? Note: If a page selected to start playing background audio is a page on
the right side of the FlipBook, the background audio will only take effect from
the next page.

Select the Enable Audio Loop check box if you want to repeat the playing of the
audio files in the play list after the last audio file finishes playing.
Add Background Audio Files

1. To add audio files, click the Add button and browse to select one or multiple
audio files (.MP3).

2. Click the OK button to confirm.

Remove Background Audio Files

1. To remove any audio files in the play list, select the audio file and click the
Remove button.

2. Click the OK button to confirm.

Adjust Background Audio File Positions

1. To adjust the position of audio files in the play list, select the desired audio
file(s) and click the Move Up or Move Down buttons. Audio files will be played
sequentially from top to bottom.

2. Click the OK button to confirm.

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.4.7. PDF Conversion Optimization Level

You can customize the PDF Conversion Optimization Level to achieve
optimum conversion. Majority of PDF pages have no problem with "Standard"
level.

However, some pages after being converted using "Standard" level could not be
opened properly in FV Xpress. For these cases, select the cell corresponding to
the problematic page under the PDF Optimization Level column and click the ...
button. The PDF Conversion Optimization Level dialog box will be shown as
below.

PDF Conversion Optimization
= — g e - -
@ Standard: Links and keyword highlighting during search are prezerved.
Lewel 1: Links and keyward highlighting during search are preserved. Quality of SWF files iz poorer and

canverzion ime may be langer than Standard. Use anly when Standard fails to carvert properly.

Lewe| 2 Linkz are prezerved but keyword highlighting during search iz not available. Uze only when
Standard and Level 1 fail to convert properly.

Lewe| & Linkz and keyword highlighting during search are not prezerved. ze only when Standard,
Level 1 and Level 2 fail to convert properly.

Apply to all pages (]84 | ‘ Cancel

Proceed to try with "Level 1" conversion. If "Level 1" conversion still could not
solve the problem, proceed to try "Level 2" conversion. If "Level 2" conversion
still could not solve the problem, proceed to try "Level 3" conversion. Please take
note that the higher level that you choose, the lower the quality of the converted

Flash pages.

Explanation:

PDF Conversion Description

Optimization Level

Standard Links and keyword highlighting during search are
preserved.

Level 1 Links and keyword highlighting during search are

preserved. Quality of SWF files is poorer and
conversion time may be longer than Standard. Use
only when Standard fails to convert properly.

Level 2 Links are preserved but keyword highlighting during
search is not available. Use only when Standard and
Level 1 fail to convert properly.

Level 3 Links and keyword highlighting during search are not
preserved. Use only when Standard, Level 1 and Level
2 fail to convert properly.

If you would like to apply the selected setting to all pages in the FlipBook, select
the Apply to all pages check box.
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2.4.8. Show Shadow

By default, a shadow effect will be displayed in the middle spine of the FlipBook.
This shadow effect can be made to appear for the whole FlipBook or for specific
pages only. You can determine which particular pages need the shadow effect and
which pages do not by simply selecting/deselecting the respective check box(es).

4 FlipViewer Xpress Creator = |
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Mame Page Mumber | Centerfold | Bookmark Primary Secondary | Background FDF Show Shadow -
[v Page Audio | Page Audio Audio Optimization Level [v
PDF1_1.swf 1 Standard [+,
POF1_2.swf 2-3 [* O Contents Standard y;h
oL 3T s < .......................... standard <
oo ey R Stordord v
PDF1_5.swf 8-9 [v Standard [v
PDF1_6.swf 0-11 [v Standard [v
POF1_7.swf 12-13 [v Standard [v
PDF1_8.swf 14-15 [v Standard [v
PDF1_9.swf 16-17 [v Standard [v
PDF1_10.swf 18-19 [v Standard [v
PDF1_11.swf W0-21 [v Standard [v
PDF1_12.swf 22-23 [v Standard [v
PDF1_13.swf 24-35 [v Standard [v il
Preview ‘ I Settings. .. ‘ I <<Back ‘ I Publish Trial ‘ IPuinsh Final

2.4.9. Add Video to Page

When you move your mouse cursor above any of the File Names of the pages,
you will see the thumbnail of that page with a Video icon on it. Clicking the
thumbnail will launch the Video Tool for you to add an FLV video onto the page.

A FlipViewer Xpress Creator = ES
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Name Page Mumber | Centerfold | Bookmark Primary Secondary | Background POF Show Shadow -
¥ Page Audio | Page Audio Audio Optimization Level rd
PDF1_l.swf 1 Standard v
PDF1_2.swf 2-3 Icd [ contents Standard cd
oo LAt o w b Standard v
POF1_4.swf 6-7 Ird Standard rd
PDF1_5.swf 8-9 [+ Standard v
PDF1_6.swf i0-11 Ird Standard rd
POF 1_7.swf\ 12-13 Ird Standard rd
POF1_8.5wF" 14-15 v Standard rd
POF1_9.swf 16-17 Ird Standard '
POF1_10.swf 13-19 Ird Standard rd
PDF1_1Llswf 20-21 [¥ Standard v
PDF1_12.swf 22-23 Ird Standard rd

PDF1_13.swf 24-25 Ird Standard rd il

Preview I I Settings... I I < <Back J I Publish Trial J lPuhIish Final
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2.5. Book Settings

When you click the Settings button, the FlipViewer Xpress Creator Settings
dialog box will be shown. After you have changed the settings, click the OK
button to save the changes and exit the dialog box. Click the Cancel button to
exit the dialog box without saving the changes.

2 FlipViewer Xpress Creator Settings —t i

Book Settings

Specify settings that are applied to the whole FlipBook.

Book Settings | Customization-1 | Customization-2 | DRM Settings I Table of Contents | Advanced | Embedded Viewer

Page Content Size Qutput
Set Content Size Automatically Set User Interface Language According to Browser's Language
width 421 “ Pixels  Height 595 . Pixels English

Select Default Zoom Level: [1, 5x vJ

Flipping Direction

Enable Click-and-Drag Zoom
SETE $o_ o [ Enable Double-Click Zoom (Click Zoom will be disabled)
ook Backorond Generate Files for Search Engines
|| Display FlipBook in Single-Page Mode
~| Choose Color: D
Packaging

@) Texture File Location:
Create Self-executable Package (.exe)

B
Create Compressed Package (.zip)

Page Loading Backaround Tracking
File Location: Use FlipAnalyzer Tracking

[|Use Google Analytics

Audio
Enable Flipping Sound Enable Audio
I Help I I Sawve Settings As Template. .. J l oK J [ Cancel ‘

If you would like to save settings in this dialog box as template for other projects,
click the Save Settings as Template... button. A dialog box will be opened as
shown below.
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4 Project Templates Iﬁ

Templates Available:

Template 1
Template 2

Mew Template Mame:

Template 3

Remave OK ] | Cancel

b -

¥

E :
? Not all settings in the FlipViewer Xpress Creator Settings dialog box will
be saved in a project template. Those book-related information that will not be
saved in a project template are Page Content Size, Table of Contents and Links
Definition.

To save settings as a new template:
1. Enter a template name at New Template Name text field.

2. Click the OK button to confirm. The new template will be added to the
Templates Available list.

To save settings over an existing template:
1. Choose a template from the Templates Available list.

2. Click the OK button to confirm. The selected template will be updated with the
latest settings.

To remove a template from Templates Available list:
1. Choose a template from the Templates Available list.
2. Click the Remove button.

3. You will be prompted to confirm the action. Click the OK button to confirm.
The selected template will be removed from the Templates Available list.
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Under Book Settings tab, you can specify settings that are applied to the whole

FlipBook.

4 FlipViewer Xpress Creator Settings

Book Settings

Specify settings that are applied to the whole FlipB

e S

Page Content Size
| Set Content Size Automatically

Width 421 = Pixels  Height 595 * Pixels
Flipping Direction
@ Standard Mon-Standard
Book Backaround
Choose Calor: |:|
@ Texture File Location:
Browse...
Page Loading Background
File Location:
Browse...
Audio

+ | Enable Flipping Sound /| Enable Audio

Help | | Save Settings As Template...

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer

Output

| Set User Interface Language According to Browser's Language

nalish

Select Default Zoom Level: | 1.5x

e |

| Enable Click-and-Drag Zoom

Enable Double-Click Zoom (Click Zoom will be disabled)

| Generate Files for Search Engines
Display FlipBook in Single-Page Mode

Packaaing
| Create Self-executable Package (.exe)
| Create Compressed Packaae (.zip)

Tracking
| Use FlipAnalyzer Tracking
Use Google Analytics

QK

| | Cancel

Page Content Size

If the Set Content Size Automatically check box is selected, the size of the
first PDF document found in the source file list will be the page content size. If
there is no PDF document found in the source file list, the page content size will
be based on the first flash document found in the source file list. If neither PDF
nor Flash document exists, the page content size will be based on the first image
document found in the source file list. The size will be indicated in the text boxes

beside the Width and Height.

If you wish to change the Width and Height of Page Content Size manually
based on PDF’s dimension, please enter the dimension of the PDF file in points.
To view a PDF’s dimension in points, in Adobe Acrobat, choose Edit ->
Preferences -> General. Under “Units & Guides”, Change the units of "Page
& Ruler” to "Points”. Click the OK button to save the changes. Mouse-over the
bottom-left corner of the PDF and you will see the PDF dimension in points.

If you wish to change the Width and Height manually based on a Flash page’s
dimension, please enter the width and height of the Flash page. To view a Flash
page’s dimension, in Adobe Flash, choose Modify -> Documents.... You will see
the width and height of the Flash page beside "Dimensions”.

If you change the default values in the text boxes beside Width and Height, the
Set Content Size Automatically check box will be unselected automatically.
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Flipping Direction
Select either Standard (default) or Non-Standard.

Standard direction means the initial position of your FlipBook will be on the right
side of the screen. Your readers will start by flipping pages from right to left in FV
Xpress. Non-Standard direction means the initial position of your FlipBook will
be on the left side of the screen. Your readers will start by flipping pages from left
to right in FV Xpress.

Book Background

To customize the book background, you can choose a color or select a
background image. The customized book background will also be shown at the
pre-loader page while waiting for the FlipBook to be opened.

To choose a color for your book background, select Choose Color and click at
the color box to select a color.

To select a background image, select Texture File Location and click the
Browse... button to select an image (.JPG, .JPEG, .GIF, .PNG). The image will be
stretched to become the book background. If most of your readers' screen
resolutions are 1280 x 1024, your book background image should be in 1280 x
995 pixels.

Page Loading Background:

The customized page loading background will be seen while waiting for pages to
be loaded. If the page loading background is not customized, readers will see
blank pages with page-loading message while waiting for the pages to be loaded.

To customize the page loading background, click the Browse... button to select
an image (.JPG, .JPEG, .GIF, .PNG). If the image size is smaller than the page
content size, it will be placed at the center of the page without changing its size.
However if the image size is bigger than the page content size, it will be shrunk
to fit into the page content size with keeping its aspect ratio.

Audio

To enable flipping sound when pages are flipped in FV Xpress, select the Enable
Flipping Sound check box.

To enable background or page audio of your FlipBook in FV Xpress, select the
Enable Audio check box.
Output

The "Set User Interface Language According to Browser's Language"
check box is by default selected. If this check box is selected, FV Xpress will
display the interface language based on the language of your reader's Internet
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browser. This is useful if your FlipBook is going to be viewed by users from
worldwide.

If you want to fix a language for the user interface language, uncheck the "Set
User Interface Language According to Browser's Language" check box.
Then select your preferred language from the drop-down list beside Select User
Interface Language. Regardless of the language of your reader's Internet
browser, your chosen language will always be used as the default user interface
language.

Select a default zoom level from the drop-down list beside Select Default Zoom
Level. It can be 1.5x%, 2.0x, 3.0x, 4.0x and 5.0x. If 1.5x zoom level is selected, it
means readers will see 1.5 times of the actual content size when the zoom
feature is activated. The user can then zoom in the page to other levels
accordingly.

If you want to enable your FV Xpress FlipBook to be searched by search engines
like Google, Yahoo and MSN, select the Generate Files for Search Engines
check box.

If you do not want your users to be able to click and drag to zoom on the page,
uncheck the Enable Click-and-Drag Zoom check box.

If you want your users to double-click to zoom instead of a single click, check the
Enable Double-Click Zoom (Click Zoom will be disabled) check box.

To display the FlipBook in single-page mode when the FlipBook is opened, select
the Display FlipBook in Single-Page Mode* check box.

Packaging!

Select the Create Self-executable Package (.exe) check box to package the
FV Xpress FlipBook into an EXE (.exe) file.

Select the Create Compressed Package (.zip) check box to package the FV
Xpress FlipBook into a ZIP (.zip) file.

b -

-
¥

fA-
? If your FlipBook is using Server License, users need to have Internet
connection the first time when opening the packages.

b -

¥

E :
? Self-executable Package (.exe) is only for users on Windows platform to
download. For users on Linux and Mac platforms, they need to download the
Compressed Package (.zip). After downloading the zip file, they need to extract
the contents of the zip to a folder.

For Mac users:
Double-click the “FlipViewerXpressMac” icon to launch the FlipBook.

For Linux users:
Change the permission of the file “FlipViewerXpress” to executable:
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Command at terminal:

|chmod a+x FlipViewerXpress

Launch the FlipBook by executing the “FlipViewerXpress” file.
Command at terminal:

|./FlipViewerXpress

FlipAnalyzer Tracking®

If you want to enable your FV Xpress FlipBook to be tracked by FlipAnalyzer,
select the Use FlipAnalyzer Tracking check box..

If you want to enable your FV Xpress FlipBook to be tracked by Google Analytics,
select the Use Google Analytics check box. You will then need to enter your
Tracking ID for that particular FlipBook.

Notes:

1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.6. Customization-1

Under Customization-1 tab, you can customize the look-and-feel of your FV

Xpress FlipBook.

= FlipViewer X;-:lress Creator

Customization

e

Customize the look-and-feel of the FlipBook.

e

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer
Show Buttons Show |
/| Table of Contents | Search /| Page Tooltips | Flipping Area Indicator
| Thumbnail View | Bookmark /| Toolbar Tooltips Book as Single Page View (Fit-to-Page)
/| Share the FlipBook: | Motes
/| Share on Sodal Metworks || Highlights /| Branding
/| save as POF | Settings Logo: ¢ \Fyx\Logo\E-Book Logo.jpg
/| Save Left/Right Page | Auto-fiip URL: http:ffwww. fipviewer.com
Save All Pages | Full Screen 7] Launching Page Logo
| Save Selected Pages | Switch Page Mode File Location: C:\Fvx\Logo\E-Book Logo.jpa
| Help
Show Help Window after Book is Loaded
| View Detalled Help  http: fiwww. flipviewer. comffvx
/| Information: http: /v, flipviewer .com
/| Archive
Help | | Sawve Settings As Template. .. oK ] | Cancel

Show Buttons!

Buttons Description

Table of Select this check box to show the "Table of Contents" button in FV

Contents Xpress.

Thumbnail Select this check box to show the "Thumbnail View" button in FV

View Xpress.

Share the Select this check box to show the "Share the FlipBook" button in FV

FlipBook Xpress.

Share on Select this check box to show the "Share on Social Networks" button in

Social FV Xpress.

Networks

Save as PDF Select this check box to show the "Save as PDF" button in FV Xpress.
Select the "Save All Pages" check box to show "Save All Pages" option
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in "Save as PDF" dialog box. If this check box is selected, when your
FlipBook is viewed in Safari of iPhone/iPad, they will see the
corresponding PDF document of this FlipBook.

Select the "Save Left/Right Page" check box to show "Save Left Page"
and "Save Right Page" options in "Save as PDF" dialog box. Your PDF
documents will be split to individual pages.

Select the "Save Selected Pages" check box to show "Save Double
Spread Page", "Save Selected Pages" and "Save This Story" options in
"Save as PDF" dialog box. Your PDF documents will be split to
individual pages. This check box will only be enabled if you have setup
the PDF-merge script in the same hosting server (Linux-based) as your
FlipBooks. Please contact your license issuer regarding PDF-merge
script.

Search Select this check box to show the "Search" button in FV Xpress.
Search is supported only if your contents are originally PDF documents.
Necessary fonts used in PDF especially fonts other than English, must
be installed by Adobe Reader/Adobe Acrobat before running the FV
Xpress Creator.
Bookmark Select this check box to show the "Bookmark" button in FV Xpress.
Notes Select this check box to show the "Notes" button in FV Xpress.
Highlights Select this check box to show the "Highlights" button in FV Xpress.
Settings Select this check box to show the "Settings" button in FV Xpress.
Auto-Flip Select this check box to show the "Auto-Flip" button in FV Xpress.

Full Screen

Select this check box to show the "Full Screen" button in FV Xpress.

Switch Page Select this check box to show the "Switch to Single Page View/Switch
Mode! to Double Page View" button in FV Xpress.
This button will only be shown when the FlipBook is viewed in single-
page mode.
Help Select this check box to show the "Help" button in FV Xpress.

Select the "Show Help Window after Book is Loaded” check box to
display the Help Window.

Select the "View Detailed Help" check box to show the "View Detailed
Help" button in the dialog of Quick Help. Uncheck the check box to hide
the button.

You can customize the URL of Detailed Help to your URL. When the
"View Detailed Help" button is clicked and the default URL is not
changed, readers will be able to access detailed help of FV Xpress.
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Information Select this check box to show the "Information" button in FV Xpress.
Enter the URL of the website that will be opened when "Information"
button is clicked.

Archive! Select this check box to show the "Archive" button in FV Xpress.

The Archive XML can be prepared through FlipViewer Xpress Creator
Archive Tool. This tool is part of the program installed together with
FlipViewer Xpress creator. Refer to the FlipViewer Xpress Creator
Archive Tool Help File for more details.

Show!

Effect Description

Flipping Area Select this check box to show the flipping-area indicator, i.e. the

Indicator corner of the pages will be curled up when users mouse-over them.

Page Tooltips

Select this check box to show page tooltips when users mouse-over
the pages.

Toolbar Tooltips

Select this check box to show toolbar tooltips when users mouse-
over toolbar buttons.

Book as Single
Page View (Fit-
to-Page)

Select this check box to launch the book in the Single Page View
(Fit-to-Page) mode.

Branding

Select this check box to customize the Branding logo that will
appear at the top-right corner of FV Xpress FlipBook.

Click the Browse... button to select a Branding logo image
(.JPG, .JPEG, .GIF, .PNG) from your hard drive. The maximum size
of a branding logo image can be is 150 x 30 pixels.

Enter the Branding URL that will be opened when the Branding logo
is clicked.

If you do not customize the Branding logo (i.e. option is
unchecked), no logo will be displayed.

Launching Page
Logo

Select this check box to customize the Launching Page Logo that will
appear at the pre-loader page while waiting for the FV Xpress
FlipBook to be opened.

Click the Browse... button to select a Launching Page Logo
(.JPG, .JPEG, .GIF, .PNG) from your hard drive.

Your logo image size should not be bigger than 250 x 250 pixels. If
it is bigger than this size, it will be resized to fit into the area of 250
x 250 pixels with aspect ratio being kept.

Notes:

1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.7. Customization-2

Under Customization-2 tab, you can customize the look-and-feel of your FV
Xpress FlipBook.

4 FlipViewer Xpress Creator Settings ||

and-feel of the Flip

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced I Embedded Viewer

About Us Add Advertisements to Book Background
W ' .

FrahTiLE Policy URL:  |http:
Company Mame:

Company Logo: Beside Front Cover:

Company URL: o i )
Keep Criginal Size Stretch to Fit

Company Address: Beside Back Cover:

Company Tel:

Company Email: Keep Original Size Stretch to Fit

Book Info
Title: MyFlipBook

Author:

Auto-flip
Start auto-flip when book is opened
Minimum 1 Second 3 Seconds Maximum 30 Seconds

4 I

Help | | Save Settings As Template... CK ] | Cancel

About Us?

Enter Company Name, Company Logo, Company URL, Company Address,
Company Tel and Company Email. Click the Browse... button to select a
company logo image (.JPG, .JPEG, .PNG, .GIF) from your hard drive. The
maximum size of company logo image is 140 x 180 pixels.

Book Info

Enter the Title and Author of your FlipBook. By default the Title will be the
same as the Project Name.

b -
-

¥

fA-
? The Title of your FlipBook cannot contain special characters e.g.
[XN<> |\
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Add Advertisements to Book Background:

4 FlipViewer Xpress Creator Settings ||

Customization-2

Customize the look-and-feel of the FlipBook.

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer
About Us Add Advertisements to Book Background
| 2T T Policy URL: | http:/f
Company Mame: E-Book Systems
Company Logo: A \Logo'E-Book Logo. jpg /| Beside Front Cover:
C VX SWR\SWF 4. swf
Company URL: http: ffwww. flipviewer.com
@) Keep Original Size Stretch to Fit
Company Address: Blk 13 Toa Payoh Lorong 8 Singapore 7| Beside Back Cover:
Company Tel: +65 6258 5100 C:\FVX\SWF\SWES, swi
Company Emall:  sales@ebooksys.com @) Keep Original Size Stretch to Fit
Number of seconds before showing Front Cowver: 3 =
Book Info
Title: MyFlipBook
Author; E-Book Systems
Aute-fiip
Start auto-flip when book is opened
Minimum 1 Second 3 Seconds Maximum 30 Seconds
] 3
| Help | | Sawe Settings As Template... | [ OK ] | Cancel |

To add an advertisement beside the front cover, select the Beside Front Cover*
check box. Click the Browse... button to select an advertisement in Flash (.SWF)
format. This Flash advertisement will be added at the available space beside the
Front Cover.

To add an advertisement beside the back cover, select the Beside Back Cover?
check box. Click the Browse... button to select an advertisement in Flash (.SWF)
format. This Flash advertisement will be added at the available space beside the
Back Cover.

The behavior for Keep Original Size is as follows:
e If the advertisement (AD) is bigger than the advertisement area (AD
Area), the AD will be reduced in size to best fit the AD Area, aligned

horizontally and vertically with aspect ratio maintained.

e If the AD is equal in size or smaller than the AD Area, the AD will be
displayed as it is in the AD Area, aligned horizontally and vertically

The behavior for Stretch to Fit is as follows:
e If the advertisement (AD) is bigger than the advertisement area (AD

Area), the AD will be reduced in size to best fit the AD Area, aligned
horizontally and vertically with aspect ratio maintained.
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e If the AD is equal in size or smaller than the AD Area, the AD will be
stretched to best fit the AD Area, aligned horizontally and vertically with
aspect ratio maintained.

To delay the display of the Front Cover while showing the advertisement, specify
the number of seconds to delay beside Number of seconds before showing
Front Cover. If you specify 3 seconds, the Front Cover will only be displayed 3
seconds after the advertisement has been loaded.

Alternatively, an advanced way to add advertisements to book background is by
specifying a policy URL. Select the Policy URL! check box and enter the URL.

The URL can be in the following formats:
(a) An URL to a CSV file: FV Xpress will read the CSV file directly. For
example,
"http://asp6.digitalflip.com/training/xpress/ads/coverads/adscover.csv".

(b) An URL to a folder: FV Xpress will automatically append <Bookd ID>.csv
behind the folder URL to obtain the URL of the CSV file. The <Book ID> is a
unique string that is different for each book. It is the value of the tag “bookid”
within the “<drm enabled>" tag, which can be found in the "<Project
Name>.xml" file.

(c) An URL points to a CGI file that will return a CSV file: The URL must
be appended with a dummy “type=.cgi” at the back. The URL may look
something like this:
“http://www.abc.com/myscript.cgi?paraml=valuel&type=.cgi”

The CSV file should be in the following format:
[front_policy]
<firstone>|<randomly>|<byindex>
<index>

[back_policy]
<firstone>|<randomly>|<byindex>
<index>

[front]

[weight], [interval], [bestfit], [URL of SWF]
[weight], [interval], [bestfit], [URL of SWF]
[back]

[weight], [interval], [bestfit], [URL of SWF]
[weight], [interval], [bestfit], [URL of SWF]

A sample of CSV file:
[front_policy]

randomly

[back_policy]

randomly

[front]
20,3,1,chinesetext.swf
20,3,1,englishtext2.swf
60,3,1,japanesetext.swf
[back]
20,,,demoFVX.swf

Explanation of CSV file:
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1. “[front_policy]” and “[back_policy]” determines how FV Xpress chooses
an advertisement Flash (.SWF) URL to be added to the book background beside
Front Cover and Back Cover respectively.
(a) “firstone” means the first advertisement in the list will be chosen.
(b) “randomly” means the advertisement will be chosen randomly from a list
of advertisements.
(c) "byindex” means the advertisement will be chosen from a list of
advertisements based on specified index. The index for first item in the list is
17,

2. “[front]” and “[back]” are sections specifying list of advertisements for

beside Front Cover and Back Cover respectively.
(@) “[weight]” (optional field) is a number indicating the weight of the
advertisement. The higher the weight of an advertisement compared with
other advertisements, the higher chances that the advertisement will be
chosen. The total weight of all advertisements may not necessary must be
equal to 100. The default value is 1.
(b) “[interval]” (optional field) specifies humber of seconds before showing
front cover after the advertisement is shown. It is only applicable to
advertisement beside front cover. The default value is 3.
(c) “[bestfit]” (optional field) can be a number "1" (default value) or "0". If
“[bestfit]” is specified as "1", the Flash advertisement will be stretch to fit the
available space and its aspect ratio will be kept. If it's specified as "0", the
original size of the advertisement will be kept regardless of changing of
browser windows or screen resolutions.
(d) “[URL of SWF]"” (compulsory field) is the URL of the Flash advertisement.
The URL can be an absolute URL starts with “http://” or a URL that is relative
to the CSV file (the SWF should be in the same folder with the CSV file). The
available space size for each Flash advertisement is 430 pixels (width) and
600 pixels (height).

b -

-
¥

fA-
? The Flash advertisements must be designed according to the Flash
specification for FV Xpress.

Auto-Flip?

You can enable the FlipBook to start auto-flip when the FlipBook is opened by
selecting the "Start auto-flip when the book is opened" check box.

You can control the auto-flipping interval by clicking and dragging the scroll
button of the slider. Minimum auto-flipping interval is one second and maximum
is 30 seconds.

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.8. DRM Settings

Under DRM Settings tab, you can specify DRM settings for your FlipBook.

Under License Type, if you select Server License?!, you will see the options in

the dialog box below:

3 FlipViewer Xpress Creator Settings

DRM Settings

Specify DRM settings that are applied to the FlipBook.

5 e

License Type

@ Server License _| Embedded License

Book Security
|| Encrypt FlipBooks
Set Time Limit
2012-06-16  |[T1H
Options

Password reguired to open FlipBook

Subscription Website

URL: http: ffwww. flipviewer. com fsubscription

Book Settings I Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer

Allow Readers To

Zoom Pages

Select & Copy Text

Watermark

|| add watermark

Print Pages

For Pages with Mixed-Viewing Rights

Customize Alternative Page
C:\FV¥\Logo'\E-Book Logo. jpg
Print Settings

[ "] Print Single Page Only

|:| Set Print Quota per Session

Browse...

Help I I Sawve Settings As Template. ..

Ok ] [ Cancel

If you select Embedded License!?, you will see the options in the dialog box

below.
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3 FlipViewer Xpress Creator Settings |

DRM Settings

Specify DRM settings that are applied to the FlipBook.

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer
License Type Allow Readers To

Server License @ Embedded License /| Zoom Pages /| Print Pages

V| Select & Copy Text

Book Security
Encrypt FlipBooks
!
Set Time Limit Wiatermark
| Add Watermark Settings...
- - ivinin
201.2-)0 =] .l
For Pages with Mixed-Viewing Rights
Options

Customize Alternative Page
| Password required to open FlipBook

Password: ~  FFEEEE CrVFVX]

xxxxxx

Confirm Password:
Print Settings

Subscription Website Print Single Page Only

Set Print Quota per Session | 1

| Help | | Sawve Settings As Template. .. oK ] | Cancel

Allow Readers To

If you have selected the Embedded License option, you can assign permission
settings for this FlipBook by selecting the desired check boxes besides the
permissions. For example, if you select the Zoom Pages check box, you allow
your readers to zoom pages in FlipViewer Xpress.

Permissions Description

Zoom Pages Allow readers to enlarge pages for the comfort of
reading.

Print Pages Allow readers to print the contents in the FlipBooks.

Select & Copy Text Allow readers to select and copy text from pages.

Book Security

Encrypt FlipBooks

To encrypt your FlipBook, select the Encrypt FlipBooks check box. If you select
the Encrypt FlipBooks check box, each page (.SWF) in the FlipBook will be
encrypted.

If your PDF documents are password-protected, please select the Encrypt
FlipBooks check box.

b -

¥

fA-
? If the FlipBooks have Flash objects of version 6.0 or above, some
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advanced features in these Flash objects may not be displayed properly if the
FlipBooks are encrypted. Thus, to show these Flash objects properly, you can
choose not to encrypt the FlipBooks.

Set Time Limit

If you have selected the Embedded License option, you can set time limit for
this FlipBook by specifying the Expiry Date. Click the calendar button to choose
an absolute date from the calendar. Your FlipBook will expire after the specified
date.

b -

-
¥

fA-
? If you select the Server License option, permission and time limit for
this FlipBook are specified through the FlipBook Registration website. (See
FlipBook Registration Website.)

Add Watermark:

If you want to add watermark to the pages in your FV Xpress FlipBook, select the
Add Watermark check box. You will see the dialog box as shown below.

b -

-
¥

fA-
? Watermark could only be added to pages converted from PDF documents.
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Select Type
. . = (") Image
FlipViewer
Xpress ,
@) Text
Enter watermark text balow:

FlipViewer (R) Xpress

Rotate angle: ¢ ;}

[~ Select Position
(7) Top Left () Center Right
(") Top Center (") Bottom Left
(*) Top Right (") Bottom Center
() Center Left () Bottom Right
Depth: | « [l » @ Center ) Tied
[ OK ] [ Cancel

You could select an image or specify text as the watermark.

If you select Image, click the Browse... button to select an image (.JPG, .JPEG
and .BMP) from your hard disk.

If you select Text, enter the text at the text field and click the Font... button to
change font type and font size.
Specify the angle to rotate the text beside Rotate angle.

Select the position of the watermark at Select Position section.

LY T '.‘

F -

? If you select Tiled under Select Position section, the flipping and page
zooming speed will be slower.

You could control the depth of the watermark by clicking and dragging the scroll
button of the slider beside Depth. Moving the scroll button of the slider to the
right will increase the depth of the watermark.

After all settings are completed, click the OK button. You will see the Add
Watermark check box is selected.
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Password required to open FlipBook

If you have selected the Embedded License option, you can specify a password
to protect your FlipBook. Under Options, select the Password required to
open FlipBook check box. Enter the same password beside the Password and
Confirm Password text fields. When your readers open the FlipBook, your
readers will be prompted to enter a password.

For Pages with Mixed-Viewing Rights?

If you have selected the Server License option, you can customize pages that
cannot be viewed with an alternative image or Flash page. This is useful when
you are preparing a book for preview or marketing purpose and only allow your
readers to view a few pages of the FlipBook. You can specify the page range that
your readers can view under Rights Template creation at FlipBook Registration
website. For those pages that your readers cannot view, by default they will be
shown blank. However, you can customize these blank pages with an image or
Flash page with this customization.

To customize the pages that cannot be viewed, select the Customize
Alternative Page check box. Then click the Browse... button to choose an
image (.JPG, .JPEG) or a Flash (.SWF) page.

Print Settings

If you select "Print Single Page Only" check box, your readers will only see
"Print Left Page" and "Print Right Page" options in "Print" dialog box of FV Xpress.
In other words, your readers cannot print multiple pages at one time. This is
useful if you want to restrict your readers from printing multiple pages at one
time.

If you select "Set Print Quota per Session" and set a printing quota, your
readers can only print up to the printing quota per reading session. For example,
if you enter 10 (by default), your readers can only print up to 10 pages each time
they open the FlipBook.

Subscription Website

If you have selected the Server License option, you can enter the URL of your
website that allows non-subscribers to subscribe to your FlipBooks. If your
FlipBook requires subscription ID to open but is viewed by non-subscribers, the
non-subscribers need a clue on where to subscribe to your FlipBook. The non-
subscribers can click on the "More Info" button that appear at the bottom of the
subscription ID prompt and they will be led to the website that you have specified
here.

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.9. Table of Contents

Under Table of Contents! tab, you can create table of contents for readers to
quickly navigate to corresponding sections in the FlipBook.

b -

-
¥

E h-
? If your PDF document has bookmarks, they will be converted to items in
table of contents. Only the first-five level of bookmarks will be converted to
items in table of contents. The first level of bookmarks will be converted to
main titles and subsequent level of bookmarks will be converted to sub-titles.

A FlipViewer Xpress Creator Settings e

Table of Contents

Create Table of Contents for readers to quickly navigate to corresponding sections in the FlipBook.

Book Settings I Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer |
Page Mumber: - “paaEte
Title Indent Page Number | - Remave
1.0. Introduction 7
.o 1.1, Welcome to FlipViewer & Xpress Creator 4 b 7
... 1.2, Introduction 1 s 8 ove LUp
..+ 1.3, System Requirements 4 3 9 ove Do
.+ 1.4, Features ] 3 10
2.0, Using Flipviewer Xpress Creator 4 3 12
vo2. 1. Opening FlipViewer Xpress Creator 4 3 12
....2.2 Create or Open Project 4 3 15
...2.3. Select Source Files 4 b 17
.24, Page Settings 4 3 20
v 2i4 1, File Name 1 s 20
| Export Table Of Contents ... | | Import Table Of Contents ... |
| Help | | Save Settings As Template... | [ QK ] | Cancel |

Add an item to Table of Contents

1. Enter a Title for an item.

2. Click the Link to... button to select a page that you want to link to from a set
of thumbnails. The corresponding page number will be shown beside Page
Number. Alternatively, you can select the page to link to from the drop-down list
beside Page Number. If you do not want this item to link to any page, select
“<No Action>" at the drop-down list beside Page Number. If this title is not
linked to any page, you can choose "No Action" from the drop-down list of Page
Number.
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3. Click the Add button to add the item to be part of Table of Contents. You will
see the newly added item at the bottom of the list.

4. If you want to make the item a sub-title of the above title, click the right-arrow
button at corresponding Indent column.

Update an item in Table of Contents

1. Select the item from the Table of Contents list.

2. You will see the title and the page number appears at the text fields beside
Title and Page Number respectively. Update the title or/and the page number.

3. Click the Update button to confirm the changes.

Remove an item from Table of Contents
1. Select the item from the Table of Contents list.

2. Click the Remove button to remove the item from the list.

Remove all items from Table of Contents

Click the Remove All button to remove all items from the list.

Insert an item to Table of Contents

1. Select the item in the Table of Contents list where you want to insert a new
item above it.

2. Enter the Title for an item under Table of Contents.

3. Click the Link to... button to select a page that you want to link to from a set
of thumbnails. The corresponding page number will be shown at the Page
Number field.

4. Click the Add button to insert the item above the selected item in the list.

5. If you want to make the item a sub-title of the above title, click the right-arrow
button at corresponding Indent column.

Import Table of Contents

You can add items in table of contents by importing them from an XML file. This is
useful if you have a long list of table of contents.

1. Click the Import Table of Contents... button to choose a Table of Contents
(.xml) file.

The format of the XML file should be something like the following.
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Format:

<?xml version = "1.0" encoding = "UTF-8"?>

<FlipBook ID = "4873a7balddf2d7ef28ec3083b7a6a8c">

<pagedescription sequence = "<Page Number>" content = "<Main Title 1>"/>
<pagedescription sequence = "<Page Number>" content = "<Main Title 2>">
<pagedescription sequence = "<Page Number>" content = "<Second-level
Title 1 under Main Title 2>"/>
<pagedescription sequence = "<Page Number>" content = "<Second-level
Title 2 under Main Title 2>">
<pagedescription sequence = "<Page Number>" content = "<Third-level
Title 1 under Second-level Title 2>"/>
<pagedescription sequence = "<Page Number>" content = "<Third-level

Title 2 under Second-level Title 2>"/>
</pagedescription>
</pagedescription >

<pagedescription sequence = "<Page Number>" content = "<Main Title 3>">
<pagedescription sequence = "<Page Number>" content = "<Second-level
Title 1 under Main Title 3>"/>
<pagedescription sequence = "<Page Number>" content = "<Second-level

Title 2 under Main Title 3>"/>
</pagedescription >

</FlipBook>

Example:

<?xml version = "1.0" encoding = "UTF-8"?>

<FlipBook ID = "4873a7bal4df2d7ef28ec3083b7a6a8c">

<pagedescription sequence = "2" content = "Main Title 1"/>
<pagedescription sequence = "3" content = "Main Title 2">
<pagedescription sequence = "4" content = "Second-level Title 1 under
Main Title 2"/>
<pagedescription sequence = "5" content = "Second-level Title 2 under
Main Title 2">
<pagedescription sequence = "6" content = "Third-level Title 1 under
Second-level Title 2"/>
<pagedescription sequence = "7" content = "Third-level Title 2 under
Second-level Title 2"/>
</pagedescription>
</pagedescription >
<pagedescription sequence = "8" content = "Main Title 3">
<pagedescription sequence = "9" content = "Second-level Title 1 under
Main Title 3"/>
<pagedescription sequence = "10" content = "Second-level Title 2 under

Main Title 3"/>
</pagedescription >

</FlipBook>

(@) The XML file should be saved in UTF-8 format.

(b) Four levels of sub-titles are supported under a main title.

(c) Please ignore the field "FlipBook ID".

(d) <Page Number> should be the sequence number of the page. The

sequence number of a page is counting from front cover as page "1",
first page after front cover as page "2" and so on.
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2. After selecting the text file, click the Open button to confirm.

3. If the items are imported successfully, you will see them added to the list.

b -

¥

fA-
? You can add single or multiple titles to a page number. The sequence of
the items appearing in the table of contents of FV Xpress is according to their
sequence in the list at this step.

b -

¥

fd™
? The special characters must be encoded in the following manner in the
XML file:

|Specia| Characters ||Specia| Characters in XML |
& [8amp; |
< [&dt; |
> [&gt; |
i |[&quot; |
I [8:apos; |

Export Table of Contents

You can export table of contents that has been added as XML file so that you can
re-import them later. To export table of contents, click the Export Table of
Contents button. Select a folder and give a filename for the XML file. Then click
the Save button to save the file.

Notes:
L If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.10. Advanced

Under Advanced tab, you can specify advanced settings that are applied to your
FlipBook.

2 FlipViewer Xpress Creator Settings L&J

Advanced

Specify advanced settings that are applied to the FlipBo

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer

Stories Definition

File Location:  C:\Fy¥\Doc\stories_new. xml Browse...

Links Definition
File Location:  C:\FyX\DocYframes, cav Browse...
Customize Skin Main Toolbar Position
Use Customized Skin
Browse @ Top Bottom
Customer Support Website Settings For Search
@ Translucent Select Highlight Color: I:‘
L Underline
Rectangle .
Collect Reader's Information at Book Launch
| Publish for Mobile Devices

Quality Factor: 50 =

Help | | Save Settings As Template... oK l | Cancel

Stories Definition!

This section will be enabled if you have selected "Save Selected Pages" at
Customization tab. You can define page range of each story in an XML definition
file. When users try to save a story as PDF in FV Xpress, the PDF pages will be
merged by the PDF-merge script on server based on the page range defined in
the XML file and be delivered to the users.

Click the Browse... button to select an XML file.

Format of a Story Definition file (.xml):

<?xml version = "1.0" encoding = "UTF-8"?>
<stories bookid = "0d640a388a80c53936¢ffdf85b16fdfd">

<story title="<story title 1>" start="<start page number>" end="<end
page number>"/>

<story title="<story title 2>" start="<start page number>" end="<end
page number>"/>
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</stories>

Example of a Story Definition file (.xml):

<?xml version = "1.0" encoding = "UTF-8"?>

<stories bookid = "0d640a388a80c53936¢ffdf85b16fdfd">
<story title="how do we survive" start="1" end="5"/>
<story title="who am I?" start="6" end="10"/>

</stories>

Links Definition:

b -

¥

fA-
? This feature is only applicable if your source files are PDF documents.

Click the Browse... button to select a CSV file, called "iframe.csv" from your
hard drive. The CSV file "iframe.csv" should contain the links definition.

This is an advanced method to specify links for your FV Xpress FlipBook. A simple
and direct method of specifying links in PDF document is explained in section
"Create Links in Adobe Acrobat". This advanced method is useful especially for
catalog publishers who will have a lot of links in their PDF documents. Managing
links in CSV file provide a convenience for publishers to specify links after
preparation of PDF documents.

The steps to prepare the CSV file "iframe.csv" are as follows:

1. Open the Microsoft Excel program.

2. Prepare the contents of the "iframe.csv"

Format:

<URL of the main script>

an|<parameter 1><parameter 2> |tooltipst|tooltipsb

<value of an>|<value of parameter 1>|<value of parameter 2> |<title of
tooltips shown when mouse-over>|<description of tooltips when mouse-over>

Example:

http://www.flipviewer.com/fvenp/?

an|opf|ver|tooltipst|tooltipsb
eng|http://www.flipviewer.com/home.opf|1.0|English|FlipViewer Xpress is a
flash-based browser viewer that does not require download or installations
chs|http://www.flipviewer.com/home.opf|2.0|Simplified Chinese|FlipViewer
Xpress is a flash-based browser viewer that does not require download
cht|http://www.flipviewer.com/home.opf|3.0|Traditional Chinese|FlipViewer
Xpress is a flash-based browser viewer that does not require download
jpn|http://www.flipviewer.com/home.opf|4.0|Japanese|FlipViewer Xpress is
a flash-based browser viewer that does not require download
ita|http://www.flipviewer.com/home.opf|5.0|Lingua italiana|FlipViewer Xpress
€ un browser basato su Flash-spettatore che non richiede il download o
installazioni

52



Using FlipViewer Xpress Creator

fra|http://www.flipviewer.com/home.opf|6.0|Lingua francese|FlipViewer
Xpress est un flash a base de navigateur
deu|http://www.flipviewer.com/home.opf|7.0|Deutsch Sprache|FlipViewer
Xpress ist ein Flash-basierten Browser-Viewer, dass ist es nicht erforderlich

(a) "an", "tooltips" and "tooltipsb" are parameters that will be handled by FV
Xpress. "an" parameter is compulsory and the rest of parameters are optional.
Your main script does not need to handle these three parameters.

Parameter Description
an FV Xpress will prepare the final URL to be displayed in the
DHTML window based on this parameter.

tooltipst The title of the tooltips when mouse-over the link in the
FV Xpress FlipBook. It will also be displayed as the title of
the DHTML window.

tooltipsb The description that appear in the tooltips box.

(b) You can add as many parameters as needed by your main script at the
second row of the CSV.

(c) When a link is clicked in FV Xpress, FV Xpress will prepare the final URL to
be displayed in the DHTML window based on the "an" parameter specified in the
link.

This is how a linked opened in DHTML window will look like:

R Y Y QWS 8N

Mah 3005 48

W FlipViewer-

R} Magusines

ogs | Rese

Total E-Book =
Solution f -
that meets your needs 3 !

E-Book Systoms offers the widest range of E-Book (or

(d) The final URL will look something like this: <URL of the main
script>?<parameter 1>=<value of parameter 1>&<parameter 2>=<value of
parameter 2>
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Based on the example "iframe.csv" above, example of final URL if parameter
"an:eng" appears in the link:
| http://www.flipviewer.com/fvenp/?opf=http://www.flipviewer.com/home.opf&ver=1.0 |

Based on the example "iframe.csv" above, example of final URL if parameter
"an:chs" appears in the link:
| http://www.flipviewer.com/fvenp/?opf=http://www.flipviewer.com/home.opf&ver=2.0 |

3. Save the CSV file in "Unicode Text" format. The filename must be
"iframe.csv".

4. Specify the links at your PDF document as follows. You can specify the links at
your PDF document before preparing the CSV file "iframe.csv".

(@) Open your PDF document in Adobe Acrobat. Your PDF document must
have been optimized according to specification (See PDF Optimization).

(b) Draw the link area using the Link Tool. Under the Link Action, choose
Open a web page. Enter "an: <value of an>" at the text box.

Format:
| an:<value of an> |

Example:
| an:eng |

Edit URL

Enter a URL For this link:

anieng v

[ OK ] [ Cancel

(c) The value of the parameter "an" must tally with the value specified in the
"iframe.csv". When the link is clicked in FV Xpress, FV Xpress will refer to the
"iframe.csv" and prepare the final URL to be displayed in the DHTML window
based on the "an" parameter.

(d) Save your PDF document.

b -

-
¥

fA-
? If you wish to open the link in a browser window instead of a DHTML
window, please change the parameter "an" to "bn" in "iframe.csv" and your
PDF document.

Settings for Search
There may be occasions where the default highlight style and color do not fit into

the page background color or the type of content used in the FlipBook. You can
choose from three different styles for your highlight:
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Translucent - the search text will be highlighted by a translucent color strip
Underline - the search text will be underlined
Rectangle - the search text will be highlighted by a rectangle outline

You can also select the highlight color and if you select either Underline or
Rectangle, you will be able to select the Line Width as well.

Customize Skin!

To customize button graphics, select the Use Customized Skin check box and
click the Browse... button to select a folder that stores the customized graphics.
(See Customizable Button Guidelines on how to prepare button graphics.)

If you do not customize skin, FV Xpress's default button graphics will be displayed.

Main Toolbar Position?

You can customize the showing of the toolbar position to be at the top or at the
bottom of the FlipBook. Select the "Top"” option for the toolbar to be shown at the
top of the FlipBook and the “"Bottom” option for the toolbar to be shown at the
bottom of the FlipBook.

Customer Support Website

The URL that you enter at Customer Support Website will appear together with
any error message that is shown during FlipBook reading. This URL will direct
your readers to your website to look for assistance when an error message occurs
during FlipBook Reading.

Collect Reader's Information at Book Launch?

Select the Collect Reader's Information at Book Launch check box is you
want to prompt readers to enter name and email address before the FlipBook is
opened. This is only applicable to Embedded License and Server License (with
Silent License) FlipBooks that are viewed from an online location.

Publish for Mobile Devices

To publish for Mobile Devices, you can create an HTML version. As long as
Publish for Mobile Devices is checked (by default), FV Xpress Creator will
convert your source document to several image files that can be uploaded to your
web server. You can set the Quality Factor to determine the quality of the
image files. The quality factor is defaulted at a value of 80% and you can vary
the quality from 1% to 99%o, with 1% being the lowest quality and 99% being
the highest quality. Bear in mind that as the image quality increases, the file sizes
of these image files will increase as well. This will indirectly affect the loading
time of the pages when the FlipBook is launched on the browser.

Features currently available for the HTML version include:

1. Page transitions in both portrait and landscape modes
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2. Direct jump to Front Cover/Back Cover
3. Direct jump to a particular page of the FlipBook by entering the page number
4. Zoom (through double-tapping or pinch-zoom)

5. Thumbnail Overview (clicking on thumbnail jumps directly to the respective
page)

6. Table of Contents (clicking on the Table of Contents item jumps directly to the
respective page)

7. Search (clicking on the search result jumps directly to the respective page)

8. Clickable links within FlipBook (links are available in both standard and zoom
mode

9. About Us Box (displaying FlipBook Title, Publisher, Website and Email)

Notes:
L If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.11. Embedded Viewer

Under Embedded Viewer! tab, you can specify settings that are applied to the
Embedded Viewer generated. An Embedded Viewer is a smaller version of the
FlipBook for publishers to use as marketing materials on their web sites. Users
will be able to flip the pages of the Embedded Viewer using the "Flip Left" and
"Flip Right" buttons but the other buttons and features will not be available.
Clicking on the Embedded Viewer itself will launch the actual FlipBook.

4 FlipViewer Xpress Creator Settings | |

Embedded Viewer

Specify settings that are applied to Embedded Viewe.

Book Settings | Customization-1 | Customization-2 | DRM Settings | Table of Contents | Advanced | Embedded Viewer
/| Generate Embedded Viewer

| Convert all pages to images for faster loading

Size Page Range
| Adjust Width or Height according to "Page Content Size™ From Page: 1 -
Width 420 ~| Pixels  Height 297 - Pixels ToPage: 18-19 -
Book Background Auto-flip
Choose Color: D Start auto-flip when book is opened
@ Texture File Location:
Browse... 1 k
FlipBook URL
URL: .. Alipviewerxpress.himl
Help | | Sawve Settings As Template. .. oK ] | Cancel

Select the Generate Embedded Viewer check box to activate the rest of the
settings for the Embedded Viewer.

Select the Convert all pages to images for faster loading check box so that
the Embedded Viewer will load faster on your web page.

For the Size of the Embedded Viewer, you can adjust the Width and Height
accordingly. Ensure that the Adjust Width or Height according to "Page
Content Size" check box is selected to ensure that the Embedded Viewer is not
distorted.

You can determine the Page Range of the Embedded Viewer by simply selecting

the range from the drop-down list of From Page and To Page. You can select
the page range to be from cover to cover or a few pages of the actual FlipBook.
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You can add a Book Background to the Embedded Viewer. Just click the
Browse button to navigate to the file location to select the image.

If you would like your Embedded Viewer to auto-flip, select the Start auto-flip
when book is opened check box and choose the auto-flip timing by dragging
the sliding bar.

When a user clicks on the Embedded Viewer, the browser will launch the actual
FlipBook in another window. Thus you will need to define the URL of the actual
FlipBook. If you already know the absolute URL of the actual FlipBook, you can
enter the URL of the FlipBook (e.g.
"http://asp6.digitalflip.com/training/xpress/testuploader/fvxcreatorusermanual_2
3/flipviewerxpress.html") in the FlipBook URL field. If you do not know the URL,
you can leave the default relative URL (i.e. ../flipviewerxpress.html) as it is.
The default URL is a relative URL to the Embedded Viewer.

After you have published the FlipBook, the files of Embedded Viewer can be found
at this folder:"<My Documents
path>\EBookSys\FlipViewerXpressCreator\<Project Name>_output\web\embed".
The URL to launch the Embedded Viewer is the URL of the "flipviewerxpress.html"
found in the "embed" folder.

After publishing, you can use FV Xpress Creator Uploader to upload the
FlipBook to your hosting server. FV Xpress Creator Uploader will upload relevant
files and folders found under the output folder ("<My Documents
path>\EBookSys\FlipViewerXpressCreator\<Project Name>_output\web") to your
hosting server. Thus, your Embedded Viewer will be uploaded together with your
FlipBook. If you are uploading the output by yourself using 3rd-party FTP
program, please make sure you upload every files and folders found under the
output folder.

After uploading your FlipBook, the URL of your FlipBook should be something like
this: "http://fvxpress.digiflip.com/fvx/flipviewerxpress.html"

The URL of your Embedded Viewer should be something like this:
"http://fvxpress.digiflip.com/fvx/embed/flipviewerxpress.html"

How to Embed an Embedded Viewer into a Website

There are two common ways to embed an Embedded Viewer into a website:

1. If your web page is using multi-frame and you want the Embedded Viewer to
appear in one of the frame, edit the HTML codes of the frame to point to the URL
of the Embedded Viewer. For example:

If the URL of the Embedded Viewer is:

"http://asp6.digitalflip.com/training/xpress/testuploader/fvxcreatorusermanual_2
3/embed/flipviewerxpress.html"

The following is an example of the HTML codes that is using multi-frame. Change
the URL of one of the frame at "src" to point to the URL of the Embedded Viewer.

Example:

<frameset rows="*,31" cols="*" frameborder="no" border="0" framespacing="0">
<frameset rows="*" cols="494,*" framespacing="0" frameborder="no" border="0">
<frame
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src="http://asp6.digitalflip.com/training/xpress/testuploader/fvxcreatorusermanu
al 23/embed/flipviewerxpress.html" name="leftFrame" scrolling="yes"
id="leftFrame" title="leftFrame" />
<frame src="testframe2.html" name="mainFrame" id="mainFrame"

title="mainFrame" />

</frameset>

<frame src="testframel.html" name="bottomFrame" scrolling="No"
noresize="noresize" id="bottomFrame" title="bottomFrame" />
</frameset>

2. If your web page is a single HTML page, you can copy the Embedded Code by
clicking the "Copy Embedded Code" button at the last step of FlipViewer Xpress
Creator Uploader. Then insert the copied code into your HTML page. The
Embedded Code looks like the following:

Example:

<object id="flipviewerxpress" classid="clsid:D27CDB6E-AE6D-11cf-96B8-
444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#ve
rsion=9,0,115,0" width="420" height="272">
<param name="movie"
value="http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed
/main.swf?opf=MyFlipBook.xml&amp;bgColor=0x0080C0&amp;bgTexture=&amp;bookurl=. ./
flipviewerxpress.html&amp; flatstructure=&amp;mode=mini">
<param name="quality" value="high">
<EMBED
SRC="http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/m
ain.swf?opf=MyFlipBook.xml&amp;bookurl=../flipviewerxpress.html&amp;bgColor=0x00
80C0&amp;bgTexture=gamp; flatstructure=&amp; mode=mini"
style="420px;height:272px; z-index:1"
PLAY="true"
TYPE="application/x-shockwave-flash"
PLUGINSPAGE="http://www.macromedia.com/shockwave/download/inde
x.cgi?Pl Prod Version=ShockwaveFlash">
</EMBED>
</object>

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=9,0,115,0
http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=9,0,115,0
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bgColor=0x0080C0&bgTexture=&bookurl=../flipviewerxpress.html&flatstructure=&mode=mini
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bgColor=0x0080C0&bgTexture=&bookurl=../flipviewerxpress.html&flatstructure=&mode=mini
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bgColor=0x0080C0&bgTexture=&bookurl=../flipviewerxpress.html&flatstructure=&mode=mini
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bookurl=../flipviewerxpress.html&bgColor=0x0080C0&bgTexture=&flatstructure=&mode=mini
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bookurl=../flipviewerxpress.html&bgColor=0x0080C0&bgTexture=&flatstructure=&mode=mini
http://asp6.digitalflip.com/training/xpress/testuploader/MyFlipBook/embed/main.swf?opf=MyFlipBook.xml&bookurl=../flipviewerxpress.html&bgColor=0x0080C0&bgTexture=&flatstructure=&mode=mini
http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=ShockwaveFlash
http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=ShockwaveFlash

2.12. Preview

You can have a quick review of how your book will look like by clicking the
“Preview” button. This preview function allows you to preview the book and all
the settings (default or otherwise) that you have made at any point of the
creation process. The Preview function will only display the first 10 pages or 5%
of the FlipBook, whichever is higher. You can click the “Preview” button as many
times as you like without worrying about your license entitlements.

2 FlipViewer Xpress Creator = X
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Mame Page Mumber | Centerfold | Bookmark Primary Secondary | Background PDF Show Shadow -
— Page Audio | Page Audio Audio Optimization Level [v
PDF1_1l.swf 1 2 File(s) 1File(s) 1File(s) Standard [v
POF1_2.swf 2 [~ [ contents Standard [v
PDF1_3.swf 3 - [ chapter 1 Standard [v
POF1_4.swf 4 [ Standard [v
PDF1_5.swf 5 [ Standard [v
POF1_6.swf [ |_ Standard [v
POF1_7.swf 7 [ Standard [v
PDF1_8.swf 3 |_ Standard [v
PDF1_9.swf 9 [ Standard [v
PDF1_10.swf 10 [ Standard [v
PDF1_11.swf 11 [ Standard [v
PDF1_12.swf 12 [ Standard [v

PDF1_13.swf 13 l_ Standard [v il

I Preview L\U Settings. .. ‘ I <<Back ‘ I Publish Trial ‘ IPuinsh Final
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2.13. Publish Trial

2 FlipViewer Xpress Creator = X
Page Settings MyFlipBook
Specify settings for eac e. Click Settings button to specify other

File Mame Page Mumber | Centerfold | Bookmark Primary Secondary | Background PDF Show Shadow -
Page Audio | Page Audio Audio Optimization Level [v
PDF1_1l.swf 1 2 File(s) 1File(s) 1File(s) Standard [v
POF1_2.swf 2 [~ [ contents Standard [v
PDF1_3.swf 3 - [ chapter 1 Standard [v
POF1_4.swf 4 [ Standard [v
PDF1_5.swf 5 [ Standard [v
PDF1_6.swf [ |_ Standard [v
POF1_7.swf 7 [ Standard [v
PDF1_8.swf 3 [ Standard [v
PDF1_9.swf 9 [ Standard [v
PDF1_10.swf 10 [ Standard [v
POF1_1l.swf 1 l_ Standard [v
PDF1_12.swf 12 [ Standard [v

PDF1_13.swf 13 |_ Standard [v il

I Preview I I Settings... I I < <Back J I Publish Trial &I Publish Final J

Click the Publish Trial* button to publish a FV Xpress FlipBook (Trial). This
FlipBook will expire within a short time frame (determined by your license issuer)
and is not meant for final publishing. You can upload the FlipBook to your Web
Server to provide online preview to your counterparts.

b -

¥ E h.-

? The FlipBooks published through Publish Trial are using Embedded
License and will expire within a short time frame (determined by your license
issuer). You need to have Internet connection every time launching the
FlipBook.

After clicking the Publish Trial button, you will see the following dialog box to
confirm your action. You will see your current entitlement, i.e. how many times
you can publish FV Xpress FlipBook (Trial). Click the OK button to proceed or
Cancel button to cancel the operation.

Confirm h lg

Proceed to publish FlipViewer Xpress FlipBook (Trial)?

Your current entitlerment: 84

ok || Ccancel |

After publishing is completed, you will see the summary page as shown below.
Your entitlement of publishing FV Xpress FlipBook (Trial) will be deducted by one.

61



4 FlipViewer ¥press Creator =) i

FlipViewer Xpress FlipBook (Trial) Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook (Trial).

Location of your FlipViewer Xpress FlipBook (Trial):

C:\Users\jared\Documents \EBookSys\FlipViewerXpressCreator MyFlipBook_outputiweb

This FlipBook will expire on 5/19/2012

To upload your FlipViewer ¥press FlipBook (Trial) to your Web Server for preview,
oa
all files and sub-folders should be uploaded. P

To publish trial again or publish final for distribution, dick the Finish button and reopen the project.

Click the View button to view the FV Xpress FlipBook (Trial) from your computer.
Since the FlipBook is in your hard disk, some buttons will not be seen (even
though you have enabled their showing), like "Share the FlipBook", "Save as PDF"
and "Download FlipBook". This is because these buttons will only be seen if your
FlipBook is online.

To preview your FlipBook online, you need to upload the FlipBook to your Web
Server. To upload, click the Upload button to launch the Uploader (part of FV
Xpress Creator installation). Follow the steps in Uploader to upload your
FlipBook.

Click the Finish button to go back to the Create or Open Project step.

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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2.14. Publish Final

2 FlipViewer Xpress Creator = X
Page Settings MyFlipBook
Specify settings for each page. Click Settings button to specify other book-related settings.

File Mame Page Mumber | Centerfold | Bookmark Primary Secondary | Background PDF Show Shadow -
Page Audio | Page Audio Audio Optimization Level [v
PDF1_1l.swf 1 2 File(s) 1File(s) 1File(s) Standard [v
POF1_2.swf 2 [~ [ contents Standard [v
PDF1_3.swf 3 - [ chapter 1 Standard [v
POF1_4.swf 4 [ Standard [v
PDF1_5.swf 5 [ Standard [v
POF1_6.swf [ |_ Standard [v
POF1_7.swf 7 [ Standard [v
PDF1_8.swf 3 |_ Standard [v
PDF1_9.swf 9 [ Standard [v
PDF1_10.swf 10 [ Standard [v
PDF1_11.swf 11 [ Standard [v
PDF1_12.swf 12 [ Standard [v

PDF1_13.swf 13 l_ Standard [v il

’ Preview ] ’ Settings. .. ] ’ <<Back ] ’ Publish Trial ] ’Publish Final[L

Click the Publish Final* button to publish a FV Xpress FlipBook for final
distribution to your readers.

After clicking the Publish Final button, you will see the following dialog box to
confirm your action. You will see your current entitlement, i.e. how many times
you can publish FV Xpress FlipBook. Click the OK button to proceed or Cancel

button to cancel the operation.

corir B . Ee-

Proceed to publish FlipViewer Xpress FlipBook (Embedded License)?
Your current entitlement: 90

Ok l ’ Cancel

After publishing is completed, you will see the summary page as shown below.
Your entitlement of publishing FV Xpress FlipBook will be deducted by one.
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4 FlipViewer ¥press Creator (=] |-

FlipViewer Xpress FlipBook Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook.

Location of your FlipViewer Xpress FlipBook:

C:\Users\jared\Documents \EBookSys\FlipViewerXpressCreator MyFlipBook_outputiweb

Steps to publish your FlipViewer Xpress FlipBook online:

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer
3. Publish FlipBook for viewing on iPad.

4, Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FY Xpress FlipBook is the URL of the "flipviewerxpress.html.™ Upload

5. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines™

If you have selected Server License instead of Embedded License, you should see
the following summary page.

4 FlipViewer ¥press Creator (=] |-

FlipViewer Xpress FlipBook Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook.

Location of your FlipViewer Xpress FlipBook:

C:\Users\jared\Documents \EBookSys\FlipViewerXpressCreator MyFlipBook_outputiweb View

Location of the FlipBook License for this FlipViewer Xpress FlipBook:
C:\Users\jared\Documents \EBookSys\FlipViewerXpressCreator MyFlipBook_outputicense

Steps to publish your FlipViewer Xpress FlipBook online:

1. Register FlipBook license with DRM Server to activate your FlipBook. DRM Server
2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer
3. Publish FlipBook for viewing on iPad.

&

Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FV Xpress FlipBook is the URL of the "flipviewerxpress.html.™ Upload

tn

. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines”

b -

¥

fA-
? For FlipBook using Server License, the "View" button will only be enabled
after you have added its FlipBook license to DRM Server.

64



Using FlipViewer Xpress Creator

b -

-
¥

fA-
? After FV Xpress FlipBook is published, if you have any files that will be
used by the Flash SWF files like FLV video files, you need to copy them to the
resource folder of your FV Xpress FlipBook.

Click the View button to view the FV Xpress FlipBook from your computer. Since
the FlipBook is in your hard disk, some buttons will not be seen (even though you
have enabled their showing), like "Share the FlipBook", "Save as PDF" and
"Download FlipBook". This is because these buttons will only be seen if your
FlipBook is online.

b -

-
¥

E :
? If you try to view the FV Xpress FlipBook from your computer (i.e
launching "flipviewerxpress.html" located in your hard disk using web
browsers), you may receive a prompt that Adobe Flash Player is trying to
access to servers. To avoid seeing such prompt, please try the following:

1. Click the Settings button at the prompt.

2. Under Edit drop-down list, click the Add Location link.

3. Copy the path under "Tip" to the text box under "Trust this location".
Remove the part from "main.swf" onwards. The path should just be the
folder path that contains the "main.swf".

4. Click the Confirm button.

5. Close the browser and restart the browser and open the book again.

Steps to publish your FV Xpress FlipBook onlinet:

1. If you have chosen Server License in DRM Settings, you need to add the
FlipBook license to DRM Server. Click the DRM Server button to launch the
FlipViewer Xpress Creator License Registration dialog box as shown below.

2 FlipViewer Xpress Creator =] (S|

Book Mame: FWXC User Manual

Group Mame: DefaultFyXpressGroup

The Group name "DefaultFyXpressGroup” has been pre-created in the DRM Server
and can be used for most publications.

subscription IDs,please go to FlipBook Registration website,
For advanced users who want to create new Groups, Rights Templates and add
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b -
-

¥

fA-
? Adding FlipBook License to DRM Server is not applicable if you have
chosen Embedded License under DRM Settings.

(@) The default Book Name will be the same as the Project Name. You
could enter another name.

b -
-

¥

fA-
? If you have added a book to DRM Server with the same Book Name
before, you need to enter another Book Name.

(b) The default Group Name is "DefaultFVXpressGroup". This Group has
been pre-created in the DRM Server and can be used for most publications.
For advanced users who want to create new Groups, Rights Templates and
add subscription IDs, please go to FlipBook Registration website.

2. If you have enabled this FlipBook to be tracked by FlipAnalyzer, you need to
register the FlipBook with FlipAnalyzer Server to activate tracking by clicking
the FlipAnalyzer button. FV Xpress Creator will register the FlipBook with
FlipAnalyzer Server in the background. If the registration is successful, you will
see the message as shown below.

Information LiE-J

'o_- h Your Flipbook has been successfully added to FlipAnalyzer Server,

3. To view your FlipBook online, you need to upload the FlipBook to your Web
Server. To upload, click the Upload button to launch the Uploader (part of FV
Xpress Creator installation). Follow the steps in Uploader to upload your
FlipBook. The final URL to view the FV Xpress FlipBook is the URL of the
"flipviewerxpress.html".

b -

-
¥

fA-
? Alternatively, you can upload the FlipBook to your Web Server through any FTP
software like FileZzilla. Here are the steps:

1.The published FlipBook is located here in your PC (by default):
<My Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\

2. You need to upload all files and folders found within the “web” folder to your Web
Server.

3. The final URL to view the FV Xpress FlipBook is the URL of the
“flipviewerxpress.html”.
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4. To enable your FlipBook to be searched by common search engines like
Google, Yahoo! and MSN, follow steps under topic "Enable FlipBook to be

Searched by Search Engines".

Click the Finish button to go back to the Create or Open Project step.

b -
-

¥

fA-
? If you want to create a CD that will open the FlipBook when the CD is
being popped into the CD-ROM drive, you need to burn all files under the

output folder, i.e. “<My Documents
path>\EBookSys\FlipViewerXpressCreator\<Project Name>_output\web\”

to CD.

Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does

not have the permissions.

67



2.15. Enable FlipBooks to be Searched
by Search Engines

General steps to enable your FlipBooks to be searched by search
engines (Google, MSN and Yahoo!):

1. When you are uploading your FV Xpress FlipBook, please make sure the
"WebSearch" folder in the "web\ <Project Name>_opf_files" folder is also
uploaded.

If you are hosting "WebSearch" folder not in the same folder with the
"main.swf", you need to edit the file paths in the JavaScript file "bookInfo.js",
which located in the "WebSearch" folder. Open the JavaScript file in the
Notepad. The content of "bookInfo.js" should look like the following. Save this
JavaScript file and re-upload it to the same location in your Web Server after
editing.

var swf = "../main.swf";
var opf = "[URL or file path of main XML file]";
var lang = "[FV Xpress language]";

var subid = "";

var groupid = "";

var width = "100%";

var height = "100%";

var ACSRC = "../FVX_RunActiveContent.js";

var logo = "[URL or file path of Launching Page Logo]";

Variable | Definition
Name
swf The URL or file path of the FV Xpress client ("main.swf"). The
file path should be relative to the launching HTML file.
Please change this value if you are not hosting the
"WebSearch" folder in the same folder with the "main.swf".
opf The URL or file path of the main XML file of FV Xpress FlipBook.
The XML file is usually with filename "<Project Name>.xml".
The file path should be relative to the "main.swf".
Please change this value if you are not hosting the
"WebSearch" folder in the same folder with the "main.swf".
lang The selected language of FV Xpress.
"ENG": English
"CHS": Simplified Chinese
"CHT": Traditional Chinese
"JPN": Japanese
"DEU": German
"FRA": French
"ITA" : Italy
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"CSY": Czech

subid Subscription ID of your FV Xpress FlipBook.

groupid Group ID of your FV Xpress FlipBook.

width Width of your FV Xpress FlipBook (counting from side toolbar).

height Height of your FV Xpress FlipBook (counting from top toolbar).

ACSRC The URL or file path of "FVX_RunActiveContent.js". The file path
should be relative to the launching HTML file.

Please change this value if you are not hosting the
"WebSearch" folder in the same folder with the "main.swf".

logo The URL or file path of Launching Page Logo. The file path
should be relative to the launching HTML file.

Please change this value if you are not hosting the
"WebSearch" folder in the same folder with the "main.swf".

2. Generate a sitemap XML file using free sitemap generator over here:
http://www.xml-sitemaps.com/.

(@) Under Starting URL, enter the URL of the "summary.html" in the
"WebSearch" folder, which has been uploaded to your Web

Server. e.g."http://asp6.digitalflip.com/training/xpress/xpressmypdfflipbook/W
ebSearch/summary.html"

(b) Then click the Start button to start generating the sitemap XML file.

(c) Once the XML is generated, download the XML from the link provided under
"Download un-compressed XML Sitemap".

(d) Upload the "sitemap.xml" to your Web Server and to be in the same folder
with the "summary.html".

3. Register the URL of the "sitemap.xml" to Google.

(a) Login with your Google account to the online Google Webmaster Tools
(http://www.google.com/webmasters/tools).

(b) If you have not register the site of your Web Server (that hosts your
FlipBooks), enter its URL and click the Add Site button.

(c) Under the Sitemap column, click the Add button to add a sitemap.

(d) At the Add Sitemap step, choose "Add General Web Sitemap" from the
drop-down list.

(e) Enter the URL of "sitemap.xml" at step 3. Then click the Add General Web
Sitemap button to confirm.
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4. Follow the steps at MSN Live Search website to add your website and sitemaps
for indexing.

5. Follow the steps at Yahoo! Search website to add your website for indexing.

b -

Al
? If you do not perform step 2, 3, 4 and 5 mentioned above, it may take
longer for your FlipBooks to be indexed by search engines.
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2.16. Creating iPad Projects

Output Platforms!

A FlipViewer Xpress Creator

Create/Open Project

= .5

Create a new project or browse to open an existing project.

FlipViewer®

Xpress Creator

Project
@ Create a New Project
Mew Project Mame:

MyFlipBook

Select a folder for your Project and FlipBook:

C:\Users\jared\Documents\EBookSys'FlipViewerXpressCreator

Select Project Template:
Default Project Template - J

) Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...
Cutput Platforms
@ Computers liPad

FV Xpress Creator allows you to create FlipBooks for computers and at the same
time for the iPad platform as well. The creation of FlipBooks for computers is as
described in Sections 2.2 to 2.14. There are two basic ways of creating FlipBooks

for iPad.

Creating FlipBooks for both Computer and iPad

For users who wish to create FlipBooks for both the computer and iPad platforms,
follow the FlipBook creation process as described in Sections 2.2 to 2.14. At the
end of the publish process, the summary page will appear as follows.
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A FlipViewer Xpress Creator =) i
FlipViewer Xpress FlipBook Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook.

Location of your FlipViewer Xpress FlipBook:

C:\Users\jared\Documents \EBookSys\FlipViewerXpressCreator MyFlipBook_outputiweb

Steps to publish your FlipViewer Xpress FlipBook online:

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer

3. Publish FlipBook for viewing on iPad.

.
&

bt
m

4, Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FY Xpress FlipBook is the URL of the "flipviewerxpress.html.™ Upload

5. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines™

To continue publishing FlipBook for iPad, click the "iPad" button and the "Select
Source File" dialog will be displayed. The dialog is "empty", that is, without any
source file that you have added earlier when publishing the FlipBook for computer.
The source file has to be added again at this stage. Please note that only asingle
PDF source file can be added. Other file formats or multiple files are not
accepted.

b -

E -

# -

? Only a single PDF can be added as source file. Other file formats or
multiple files are not accepted.

72



Using FlipViewer Xpress Creator

A FlipViewer Xpress Creator =) i

Select Source Files MyFlipBook

Select source files to be inserted into FlipBook for iPad.

File Mame Type Mo, of Pages

PDF1.pdf PDF 28

Remaove

Settings... I [ <<Back J [ Publish Trial ‘ IPuinsh Final

Once the source file is added, you may customize the “About Us” information by
clicking the “Settings” button.

2 FlipViewer Xpress Creator Settings —t i

Customization

Customize the look-and-feel of the FlipBook.

Customization

About Us
Show About Us

Company Mame: E-Book Systems

Company Logo: C:\Jsers\jared\Document
Company URL: http: fjwww. flipviewer. com

Company Address: Elk 13 Toa Payoh Lorong 8 Singapore
Company Tel: +65 62586100

Company Email: salesBebooksys, com

Book Info
Title: MyFlipBook
Author: E-Book Systems

Ok J [ Cancel
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Then proceed to click the "Publish Trial" or "Publish Final" button. You will see
your current entitlement, i.e. how many times you can publish FlipBook for iPad.
Click the OK button to proceed or Cancel button to cancel the operation.

Crt __—— =

Proceed to publish FlipViewer Xpress FlipBook (Embedded License) for iPad?
Your current entitlement: 100

Ok l I Cancel

After publishing is completed, you will see the summary page as shown below.
Your entitlement of publishing FlipBook for iPad will be deducted by one.

4 FlipViewer Xpress Creator = i
FlipViewer Xpress FlipBook for iPad Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook for iPad.

Location of your FlipViewer Xpress FlipBook for iPad:

C:\Users\jared\Documents\EBookSys\FlipViewerXpressCreator MyFlipBook_outputiwebjPad

Steps to publish your FlipViewer Xpress FlipBook online:

3. Publish Fl; k for viewi Ci ters.
ubli ipBook for viewing on Computers

4, Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.

The final URL to view the FV Xpress FlipBook is the URL of the "flipviewerxpress.html.™

5. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines”

To view your FlipBook online, you need to upload the FlipBook to your Web
Server. To upload, click the Upload button to launch the Uploader (part of FV
Xpress Creator installation). Follow the steps in Uploader to upload your
FlipBook. The final URL to view the FV Xpress FlipBook is the URL of the
"flipviewerxpress.html".

b -

$ -

# -

? Alternatively, you can upload the FlipBook to your Web Server through any
FTP software like FileZilla. Here are the steps:

1. The published FlipBook is located here in your PC (by default):
<My Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\

2. You need to upload all files and folders found within the "web" folder to
your Web Server.
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3. The final URL to view the FV Xpress FlipBook is the URL of the
"flipviewerxpress.html".

Creating FlipBooks for iPad only

For users who simply want to create FlipBooks for iPad only, start off by entering
the Project Name, selecting the iPad radio button and click the Next>> button.

A FlipViewer Xpress Creator =) o Z5

Create/Open Project

Create a new project or browse to open an existing project.

Project

@ Create a New Project
Mew Project Mame:
MyFlipBooks

Select a folder for your Project and FlipBook:

C:\Users\jared\Documents\EBookSys'FlipViewerXpressCreator

Select Project Template:
Default Project Template - ]

") Open an Existing Project

\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook. fux | Browse...

FlipViewer®
Xpress Creator [ CutputPlatforms
() Computers @) iPad

For source files, only a single PDF is allowed. Other file formats or multiple files
are not accepted.
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4 FlipViewer Xpress Creator =" = % =

Select Source Files MyFlipBook

Select source files to be inserted into FlipBook for iPad.

File Mame Type Mo, of Pages

PDF1.pdf PDF 28

Remaove

[ Settings... l [ <<Back ] [ Publish Trial ] [Publish Final l

Once the source file is added, click the "Publish Trial" or "Publish" button. You
will see your current entitlement, i.e. how many times you can publish FlipBook
for iPad. Click the OK button to proceed or Cancel button to cancel the operation.

Cort ___—— =

Proceed to publish FlipViewer Xpress FlipBook (Embedded License) for iPad?

Your current entitlernent: 100

Ok ] ’ Cancel

After publishing is completed, you will see the summary page as shown below.
Your entitlement of publishing FlipBook for iPad will be deducted by one.
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4 FlipViewer ¥press Creator =) i

FlipViewer Xpress FlipBook for iPad Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook for iPad.

Location of your FlipViewer Xpress FlipBook for iPad:
C:\Users\jared\Documents\EBookSys\FlipViewerXpressCreator MyFlipBook_outputiwebjPad

Steps to publish your FlipViewer Xpress FlipBook online:

3. Publish FlipBook for viewing on Computers.

4, Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FY Xpress FlipBook is the URL of the "flipviewerxpress.html.™ Upload

5. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines™

To view your FlipBook online, you need to upload the FlipBook to your Web
Server. To upload, click the Upload button to launch the Uploader (part of FV
Xpress Creator installation). Follow the steps in Uploader to upload your
FlipBook. The final URL to view the FV Xpress FlipBook is the URL of the
"flipviewerxpress.html".

b -

¥

fA-
? Alternatively, you can upload the FlipBook to your Web Server through any
FTP software like FileZilla. Here are the steps:

1. The published FlipBook is located here in your PC (by default):
<My Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\

2. You need to upload all files and folders found within the "web" folder to
your Web Server.

3. The final URL to view the FV Xpress FlipBook is the URL of the
"flipviewerxpress.html".

Differences between FlipBooks for Computers and FlipBooks for
iPad

1. All page and book settings are not applicable.

2. All customization buttons are not applicable.

3. DRM Settings are not applicable.

4. Table of Contents, though added in the process of creating FlipBooks for
Computers are not applicable for FlipBooks for iPad.

5. Advanced settings are not applicable.

6. Embedded Viewer is not applicable.
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Notes:
1 If you cannot use some settings in FV Xpress Creator, it means that your FV
Xpress Creator ID does not have the permissions.
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3.0 Using FlipViewer Xpress
Creator Packager

3.1. Package FlipBook

FV Xpress Creator Packager! is provided for you to package your FlipBooks
under certain circumstances outside of normal publishing flow. For example, if
your Flash pages are calling external FLV video files, you need to manually copy
those FLV files to the resource folder of your FV Xpress FlipBook after publishing.
However, your downloadable packages may not have these FLV files yet. So to
include these FLV files into your downloadable packages, you need to re-package
the FlipBook.

If you have accepted the default options in the installation process, you can open
the FV Xpress Creator Packager by using the following method:

Click Start > Programs > E-Book Systems > FlipViewer Xpress Creator >
FlipViewer Xpress Creator Packager

FV Xpress Creator Packager will be opened as shown below.

4 FlipViewer Xpress Creator et ]

Source

Location of Flipk ook: C:hU zershjarjartD ocumentzhE B ook Sps\FlipyiewerspressCreatarMuf Browsze ..

Location of Licenze: | C:hUzershjarartDocumentzhE BookSesFliptiewerspressCreatarMuf Browsze ..

Dutput

o | Set Uzer Interface Language According to Browser's Language
Englizh
| Create Self-executable Package [ exe]

| Create Compressed Fackage [.zip]

TN
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Click the Browse... button corresponding to Location of FlipBook to select the
main XML file ("<Project Name>.xml") of the FlipBook to be packaged from your
hard disk. Usually your FlipBook is located at the default output folder "<My
Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\".

Select a language of FV Xpress at the drop-down list of Select User Interface
Language.

Select the Create Self-executable Package (.exe) check box to package the
FV Xpress FlipBook into an EXE (.exe) file.

Select the Create Compressed Package (.zip) check box to package the FV
Xpress FlipBook into a ZIP (.zip) file.

b -

¥ E h.-

? Self-executable Package (.exe) is only for users on Windows platform to
download. For users on Linux and Mac platforms, they need to download the
Compressed Package (.zip). After downloading the zip file, they need to extract
the contents of the zip to a folder.

For Mac users:
Double-click the “FlipViewerXpressMac” icon to launch the FlipBook.

For Linux users:
Change the permission of the file “FlipViewerXpress” to executable:
Command at terminal:

|chmod atx FlipViewerXpress

Launch the FlipBook by executing the “FlipViewerXpress” file.
Command at terminal:

|./FlipViewerXpress

Click the Package button to start packaging the FlipBook.

If your FlipBook is using Server License, you will see the summary page as shown
below after the process is completed. As re-packaging will modify the main XML
file ("<Project Name>.xml") and the license files, you need to re-register the
FlipBook license with DRM Server and re-register FlipBook with FlipAnalyzer
Server (if any). Then you need to re-upload the FlipBook to your Web Server.
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2 FlipViewer Xpress Creator | S|

FlipViewer Xpress FlipBook Packaged

You have successfully packaged the FlipWiewer Xpresz FlipBo

Location of your FlipViewer Xpress FlipBook:

C:\Users'jared\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook _outputiweb

Location of the FlipBook License for this FlipViewer Xpress FlipBook:
C:\Users'jared\Documents \EBookSys \FlipViewerXpressCreator MyFlipBook_outputilicense

Steps to publish your FlipViewer Xpress FlipBook online:
1. Reaqister FlipBook license with DRM Server to activate your FlipBoak. DRM Server

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer [

3. Upload FlipBook to your Web Server. Al files and sub-folders should be uploaded. Upload
The final URL to view the FV Xpress FlipBook is the URL of the “flipviewerxpress. himl.

4, To enable FlipBook to be searched by comman search engines, follow steps under topic
“Enable FlipBook to be Searched by Search Engines”™

b -

¥

fA-
? For FlipBook using Server License, the "View" button will only be enabled
after you have added its FlipBook license to the DRM Server.

b -

¥

fA-
? If your FlipBook is using Server License, users need to have Internet
connection the first time when opening the packages.

If your FlipBook is using Embedded License, you will see the summary page as
shown below after the process is completed. As re-packaging will modify the main
XML file ("<Project Name>.xml") and the license files, you need to register your
FlipBook with FlipAnalyzer Server (if any). Then you need to re-upload the
FlipBook to your Web Server.
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2 FlipViewer Xpress Creator | S
FlipViewer Xpress FlipBook Packaged

You have successfully packaged the FlipWiewer Xpresz FlipE

Location of your FlipViewer Xpress FlipBook:

C:\Users'jared\Documents\EBookSys \FlipViewerXpressCreator WMyFlipBook _outputiweb

Steps to publish your FlipViewer Xpress FlipBook online:

LIRJ¥

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer
3. Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.

The final URL to view the FV Xpress FlipBook is the URL of the “flipviewerxpress. himl.

4, To enable FlipBook to be searched by common search engines, follow steps under topic
“Enable FlipBook to be Searched by Search Engines”™

Please follow steps at section “4.1 General Publishing Flow"” to publish your
FlipBook online.

Notes:
L If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.

82



4.0. References
4.1. General Publishing Flow

General steps to publish a FV Xpress FlipBook:

1. Publish FV Xpress FlipBook using FV Xpress Creator.
(i) PDF documents to be inserted into FV Xpress Creator must be
prepared in accordance with the guidelines. (See PDF Guidelines).
(i) Flash files to be inserted into FV Xpress Creator must be prepared in
accordance with the guidelines. (See Flash Guidelines).

2. In the final step of FV Xpress Creator after publishing is completed, if your
FlipBook is using Server License, add FlipBook license (output of step 1) to DRM
Server by clicking the DRM Server button to launch the FV Xpress Creator
License Registration dialog box.

3. To track FlipBook usage using FlipAnalyzer, register FlipBook with FlipAnalyzer
Server to activate FlipBook tracking by clicking the FlipAnalyzer button.

4. Upload FlipBook to your Web Server by clicking the Upload button to launch
FV Xpress Creator Uploader dialog box. The final URL to view the FlipBook is
the URL of the "flipviewerxpress.html".

b -

¥

fA-
? Alternatively, you can upload the FlipBook to your Web Server through any FTP
software like FileZilla. Here are the steps:

1.The published FlipBook is located here in your PC (by default):
<My Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\

2. You need to upload all files and folders found within the “web” folder to your Web
Server.

3. The final URL to view the FV Xpress FlipBook is the URL of the
“flipviewerxpress.html”.

5. To enable FlipBook to be searched by common search engines, follow steps
under topic "Enable FlipBooks to be Searched by Search Engines".
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4.2. PDF Guidelines

Before adding PDF documents as source files into FV Xpress Creator, you need to
prepare them according to the given guidelines.

4.2.1. General PDF Guidelines

1. The PDF pages must be optimized according to the recommended settings (see
PDF Optimization). The PDF compatibility must be Acrobat 6.0 (PDF 1.5) and all
used fonts must be embedded in the PDF pages.

2. Please follow specification (see Create Links in Adobe Acrobat) to create
hyperlinks in the PDF documents and internal links to jump to pages inside the FV
Xpress FlipBook.

3. The PDF pages must not have password security that restricts editing and
printing of the documents.

4. The PDF pages must not have crop marks or bleed marks.

5. All PDF pages should preferably have the same dimension to avoid seeing
white spaces.
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4.2.2. PDF Optimization

Reason to optimize PDF documents

Optimizing PDF documents is to make sure the PDF documents are conformed to
the requirements of FV Xpress Creator, i.e. necessary fonts are embedded,
supported PDF version and others.

Background

There are three basic types of PDF document:

e Rasterized: The information in the PDF document has been rendered as a
straight bitmap (usually very high resolution). No font or vector
information remains. The PDF document is neither searchable nor editable.

e Vectorized: The information in the PDF document has been converted to
pure vectors. All the text characters have been converted to vector shapes
and are no longer recognized as text. The PDF document is neither
searchable nor editable.

e Editable: Such a PDF document retains the font and text information. The
PDF document may still contain some vector and bitmap information, but
the text is still recognized as text. The information of the fonts is stored in
the PDF document so that the latter looks the same on any machine,
regardless of whether the font is installed or not. The PDF document is
searchable and editable.

Before optimizing PDF documents

The PDF document that we are going to optimize should be the Editable type. In
other words, the fonts are embedded or stored in the PDF document and the text
can be selected, searched and treated as text.

Steps to optimize PDF documents

Step 1. Add Adobe PDF Setting

1. In Adobe Acrobat 8 Professional, choose Advanced > Print Production >
Acrobat Distiller to open Acrobat Distiller. An alternative way to launch
Acrobat Distiller is through Start > Programs > Adobe Master Collection

CS3 > Acrobat Distiller 8.

2. In Acrobat Distiller, select "Smallest File Size" from Default Settings
drop-down list as shown below.
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r:/,‘xﬁ Acrobat Distiller [Q
File Settings Help
Adobe PDF Settings
Default Settings: ’Smallest File Size !:]

Compatibility: ~ Acrobat 5.0 (PDF 1.4)

. Use these settings to create Adobe PDF documents best suited for on-
screen display, e-mail, and the Internet. Created PDF documents can be
opened with Acrobat and Adobe Reader 5.0 and later.

Progress
Status: Ready

Lanc ot
LancelJoo

PDF File Size Time | PS File Size E Settings PDF Fol

7(] 1 ] {2_‘

Acrobat Distiller 7.0
Started: Friday, March 28, 2008 at 17:56:34

Adobe PostScript software version: 3016.102
CID support library initialization completed.

3. Select Settings > Edit Adobe PDF Settings....

4. Click the Save As... button to save this new Adobe PDF Setting File
(.joboptions) as another name. For example, save this new Adobe PDF Setting as
“PDF FlipBook.joboptions”.

5. Under the General tab, set Compatibility to “"Acrobat 6.0 (PDF 1.5)" and
set Resolution to "150” dots per inch.
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(¥ POF FlipBook
(L] Genetal
(L] Images
(L] Fonts

(L Color

(L] Advanced

[T] Show All Settings

Description

Actobat and Adobe Reader 5.0 and later.

- File Options

Use these sellings to create Adobe PDF documents best suited for on-screen
display, e-mail, and the Inteinet. Created PDF documents can be opened with

Object Level Compression: | Tags only

AutoRotate Pages: | Collectively by File

Bindng: | Leit v
ﬁesoi.ﬁon:{lso | dots perinch
© Al Pages , . ,
O Pages From: To: | |
[ Embed thumbnais
[V] Optirnize foe fast web view
DefaultPageSiag =
Widh: 6120 | Units: | Points vl
Height 7920 |
[savess. ] [ _ok ] [ Cacel | [ heo ]

6. Select the Images tab. For Color Images and Grayscale Images, set the
Image Quality to "Low” (refer to figure below. To have higher quality images
while able to tolerate higher file size, set the Image Quality to "“Medium”.
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PDF FlipBook - Adobe PDF Settings <]

(¥ POF FiipBook Color Images
General Downgample: | Bicubic Downsampling to g 100 3] pixels perinch
(] Fonts for enages above: 150 (%] pixeds per inch
(Z1 Color e | TR '
& Advanced Compression: Automatic JPEG) }]
Image Qualty: | Low E]

Gragscale Images
Downsample: ' Bicubic Downsampling to ﬂ 150 131 pixels perinch
for inages above: 225 2 pixels perinch
Compression: | Automaic (JPEG) ]

Image Qualty: | Low M
Maonochrome Images
Downsample: | Bicubic Downsampling to Z| 300 |3 pixels perinch
for images above: 450 3 pikels perinch
Compression: | I:leT Group 4 7 ;j
Anti-alias to gray: | Off v

D §how All Sems

[ saveps. | | ok | | cCancel | | Hep |

7. For the Monochrome Images, set the Downsample to 300 pixels per inch.
This setting is suitable for contents that have English text. However, if the
contents have foreign-language (Chinese, Japanese, German, others) text, under
the Monochrome Images section, set the Downsample to 500 pixels per
inch (refer to figure below). This will increase the clarity of those foreign texts for
more comfortable reading.
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PDF FlipBook - Adobe PDF Settings X |
|3“ PDF FlipBook Color Images

] General Downsample: | Bicubic Downsampling to 9 100 2] pixels perinch

3 Images

(2] Fonts for images above: 150 |3 pixels perinch

(Z1 Color : e ] -

& Advanced Compression: | Automatic (JPEG) v

Image Quaiy: | Low vl

Gragscale Images
Downsample: "VBictbic Downsampling to 'vl 150 2 pixets per inch
for images above: 225 |3 pixels per inch
Comgression: | Atomatc 0PEG) ||

)

Image Quality: | Low vl
Maonochrome Images
Downsample: | Bicubic Downsampling to E 500 % pixeks perinch
for images above: 750 1 pikels per inch
Compression: CCITT Group 4 7]
Anti-abas to gray. (B v |

D ﬁhow All Sems

[ saveas. | | ok | | Cance | [ Hep |

8. Under the Fonts tab, select the Embed all fonts and Subset embedded
fonts check boxes and set the percentage to 100%. If the PDF document
contains foreign-language fonts (i.e. Chinese, German, French, Japanese, Korean,
etc), the Embed all fonts check box will make sure that those fonts needed to
view the document are embedded.
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(¥ POF FlipBook
() Genesal
(] Images
Fonts
() Color
(L] Advanced

[] Show All Settings

i e

Ermbead Op=nType fants

[V¥] Subset embedded fonts when percent of characters used is less than:
o Only fonts with appropriate permission bits will be embedded

When embedding fals: | Wam and continue

[v]

- Embedding -
Font Source:

| CAWINDOWS Fonts\

]

0 ACaslonProBold

0 ACaslonPro-Bolditalic

0 ACaslonProltabe

0 ACaslonPro-Regulae

0 ACaslonPro-Semibold

0 ACaslonPro-Semibolditalic
0 AGaamondPro-Bold

0 AGaamondPro-Bolditaic
0 AGaramondProltalic

0 AGaamondPro-Reqular
T AgencyFB-Bold

T AgencyFB-Req

T Algerian

T Arial-Black

T Anal-BoldltalicMT

e
==

&

Add -

Add -

Alyays Embed:

100 | %

Neyer Embed:

Add Name...

a emove

[ savess. | |

0K

[ canca | |

Hep |

9. Under the Color and Advanced tabs, do not change anything and their
settings are as shown below.
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[

| @ FOF FlipBook
() Genesal
Images
Fonts
22 Color]

Advanced

[] Show All Settings

- Adobe Color Setts
Seltings File: | None
- Color Management Policies
| Convert All Colors to sRGB
Document Rendering Intent: [Preselve
~\Working Spaces 3
Gray: ‘» Gray Gamma 2.2
RGB: sRGB IECE1986-2.1 v
CMYK: | U.S. Web Coated (SWOP) v2 v
v Preseive CMYK values for calibrated CMYK color spaces
- Device-Dependent Data:
[] Presarve under color remaval and black generation
When transfer functions are found:
] Preserve halftone information
ok J [ Come | [ Heo
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'PDF FlipBook - Adobe PDF Settings

&

[] Show All Settings

(¥ PDF FiipBook | - Opions
(3 General Allow PostSciipt file to override Adobe POF settings
g ::";:9:‘ (%] &low PostSciipt XObjects
(1 Color Convert aradients to smooth shades
Convert smooth lines to curves
Preseive Level 2 copypage semantics
Preserve gverprint settings

Overprinting default is nonzero ovesprinting
[] Save Adobe PDF settings inside POF file
[] Save orignal JPEG images in PDF if possible
[[] Save Portable Job Ticket inside PDF file
["] Use Prologue.ps and Eplogue.ps

Document Structiging Conventions [DSC)
Process DSC comments
[] Log DSC wamings
[7] Preserve EPS infoimation from DSC
[[] Preserve OPI comments
[[] Presetve document information from DSC
Resize page and center atwork for EPS files

[ Save As... ]

[ ok | [ cance |

[

Help

1

10. Click the OK button to confirm the settings and exit the Acrobat Distiller.

Step 2: Optimize the PDF document in Adobe Acrobat

1. Open the PDF document in Adobe Acrobat.

2. Choose File > Print. From the drop-down list of printer name, select "Adobe

PDF”.
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(O Pages from: 1 to: |12

Page Handling‘ =
Copies: 1 ~‘—‘J,

C lll e

Page Scaling: Reduce to Printer Margins l:'

Auto-Botate and Center

Choose Paper Source by PDF page size

[T Print to file

[Plinting lips] u__t:jvanced ]

Subset: All pages in range iv I [ Reverse pages

(= ‘ -
Print b
Printer
Name: Adobe PDF- J _\ﬂ I Properties
Status: Ready Comments and Forms:
Type:  Adobe PDF Converter | Document and Stamps | :]
Print Range Preview
©al K 780.95 S
O Current wiew - —
(O Current page g

.

1.043.9

VIoN
BQSINESS

“RE NADI;SSANCE

R

Fany

L

Units: Points Zoom: 100%
1112(1) }
[ 0K ] [ Cancel ]

3. Click the Properties button and the following dialog box will be shown. Select
the Adobe PDF Conversion Settings tab. From the drop-down list of the
Default Settings, select the settings that have been created at Step 1, e.g.
“PDF FlipBook"”. Then click the OK button to confirm.
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k' o
# Adobe PDF Document Properties

| Layout | Paper/Qualty | L Adobe PDF Settings
Adobe PDF Conversion Settings

lJse these settings to create Adobe PDF documents best suited for on-screen display, e-mail,
() and the Internet. Created PDF documents can be opened with Acrobat and Adobe Reader
¥ 5.0 and later.

Default Settings: | PDF FlipBook [v‘ | Edit...

Adobe PDF Security: !7None [;l E dit

Adobe PDF Dutput Folder | Prompt for Adobe PDF filename v
Adobe PDF Page Sige: |Ad [w] [_Add..

[(J¥iew Adobe PDF results
[] &dd Document Information

Do not send fonts to "Adobe PDF"

Delete log files for successful jobs

[] &sk to Replace existing PDF file

l oK ][ Cancel ]

4. At the Print dialog box, select the Choose Paper Source by PDF page size
check box. Please make sure the size shown at the Preview section is the same
with the PDF document size. Click the OK button to start distilling/optimizing the
PDF document.

5. You will be prompted to save the optimized PDF document in a folder. Browse
to select a folder and give a file name. Click the Save button to confirm. Your
optimized PDF document will be stored in the folder after optimization has
finished.
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Save PDF File As w

Save in: | ) distilled vl QT i m

A
9
My Recent
Documents

Vi
Desktop

7

My Documents

-
haasd
58
My Computer

‘P} File hame: todayoneline.pdf Vj‘ V|
2
MyNetwork | Savesslype: | PDF fies [ PDF) (]

b -

¥

E :
? After distilling the PDF, one way to test whether search feature is
supported for this PDF is by trying to copy the text in Acrobat and paste them
into a Notepad. If the text can be copied properly from the PDF, most likely
there will not be much issue with search feature when it is converted into FV
Xpress FlipBook.

Alternative Way to Optimize PDF Documents

In some cases, the above method of optimizing PDF documents may cause the
keyword search of the PDF documents lost. In these cases, please use the
following alternative method to optimize your PDF documents.

1. Open your PDF document in Adobe Acrobat 8. Choose Advanced > PDF
Optimizer.

2. Beside Make compatible with, please choose "Acrobat 6.0 or later" from
the drop-down list.

3. Click the Fonts option at the left panel. Under Font Settings at the right

panel, make sure all fonts are under the list of Embedded fonts. This will make
sure all fonts are embedded.
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(=
PDF Optimizer

X

Settings: | Custom

[v]

Settings
Current PDF Yersion:
Images
2] Fonts
O Transparency
Discard Objects
Discard User Data
Clean Up
(<] i u f} J

1.6 (Acrobat 7.x)

Font Settings

Audit space usage...

Make compatible with: i Acrobat 6.0 and later ; i]

The following fonts can be unembedded by the PDF Optimizer:

Embedded fonts:

FranklinGothic-Book (Subset) |4 |
FranklinGothic-Book {Subset) |
FranklinGothic-Demi {Subset)
FranklinGothic-Demi {Subset) ‘ A
FranklinGothic-ExtraCond (Subse‘ 3
FranklinGothic-Heavy (Subset)
FXCTWE+LogicSans-Regular {Su
Gillsans-Bold {Subset)
Gillsans-BoldItalic (Subset)

Helvetica (Subset) <
Unl mbim =~ £€0 hmaby & ‘X )
£3 i | [2)

%

Fonts to unembed:

The fonts listed above are currently embedded in the PDF file. To unembed a font, move it to the
right pane. Fonts listed in the left pane will remain embedded.

[ OK I [ Cancel

4. Click the OK button to start optimizing your PDF document.

5. You will be prompted to save the optimized PDF document in a folder. Browse
to select a folder and give a file name. Click the Save button to confirm. Your
optimized PDF document will be stored in the folder after optimization has
finished.
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4.2.3. Create Links in Adobe Acrobat

4.2.3.1 To create internal links to jump to pages inside the
FV Xpress FlipBook:

1. Your PDF document must have been optimized according to specification (see
PDF Optimization).

2. (@) Using Adobe Acrobat, open your PDF document. Draw the link area using
the Link Tool. Under the Link Action, choose Open a web page.

Enter the filename of the page and enter the link tooltips after "|". The link
tooltips will be shown when users mouse-over the link area in FlipBook. If you
do not enter "| <link tooltips>", the default link tooltips is "Flip to Page <Page
Number>"

Format:

<filename of the page to link to> | <link tooltips> |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "Go to Page 12 Article".

todayonelinel_12.swf | Go to Page 12 Article |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "Flip to Page 12" as "todayonelinel_12.swf" is page 12 of the book.

todayonelinel_12.swf |

Edit URL
Enter a URL For this link:
todayonelinel _12.swf | Go to Page 12 Article] V
[ QK ] [ Cancel ]

b -

-
¥

E :
? The filename of a page in FV Xpress FlipBook is always in this format:
"<PDF filename (without extension)>_<Its page Number in the PDF
document>.swf". For example, if your document is "todayonelinel.pdf" and
you want to link to Page 12, the filename of Page 12 after being converted to
SWEF is "todayonelinel_12.swf".

(b) Another alternative way is using Adobe Acrobat, open your PDF document.
Draw the link area using the Link Tool. Under the Link Action, choose Go to a
page view. Click the Next button and you will see a Create Go to View dialog
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box. Go to the page in the same PDF document that you want the link area to
link to. Then click the Set Link button at the Create Go to View dialog box.

The method to jump to a page in another PDF document is also supported.
Open your PDF document. Draw the link area using the Link Tool. Under the
Link Action, choose Go to a page view. Click the Next button and you will
see a Create Go to View dialog box. Open another PDF document and go to
the page you want to link to. Then click the Set Link button at the Create Go
to View dialog box.

(c) Another alternative way to create a link to a page is using Destination. To
create a destination, navigate to the location where you want to create a
destination. In the Destinations panel (View > Navigation Panels >
Destinations), choose New Destination from the options menu and name the
destination. Save the PDF document. In the source PDF document (where you
want to create the link), use the Link Tool to draw a link area. Under the Link
Action, choose Go to a page view. Click the Next button and you will see a
Create Go to View dialog box. In the target document, in the Destinations
panel, double-click the destination. Save the source PDF document. Your source
PDF document and target PDF document can be two different PDF documents.

3. To create hyperlinks and email links, please see topics 4.2.3.2 and 4.2.3.3
below.
4. Save the PDF in step 2.

5. Add the PDF document (saved in step 4) as source files into FV Xpress Creator.

4.2.3.2 To create a hyperlink to link to a website:

1. Using Adobe Acrobat, open your PDF document. Draw the link area using the
Link Tool. Under the Link Action, choose Open a web page.

2. Enter the URL of the website and enter the link tooltips after "|". If you do not
enter "| <link tooltips>", the URL will be shown as link tooltips.

Format:
| <Website URL> | <link tooltips> |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "Go to FlipViewer Homepage".

| http://www.flipviewer.com | Go to FlipViewer Homepage |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "http://www.flipviewer.com".

| http://www.flipviewer.com |
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Edit URL &3

Enter a URL For this link:

Ehttp:waw.flipviewer.com | Go to Flip¥iewer Homepage] ‘ﬂ

[ OK ] [ Cancel ]

3. By default, when the link is clicked in FV Xpress, the link will opened in your
browser window. If you would like your link to be opened in DHTML window like
the following, please specify "iframe:" before the URL of the website. After the
FlipBook is published, go to the folder "C\Program Files\E-Book
Systems\FlipViewer Xpress Creator\System\publish" to obtain a file called
"FVX_RunActiveContent_Opaque.js". Copy this file to the output folder of your
FlipBook, i.e. " <My Documents
path>\EBookSys\FlipViewerXpressCreator\<Project Name>_output\web\ ".
Edit "flipviewerxpress.html" to point to this file
"FVX_RunActiveContent_Opaque.js" instead of pointing to this file
"FVX_RunActiveContent.js".

Format:
| iframe:<Website URL> | <link tooltips> |

Example:
| iframe:http://www.flipviewer.com | Visit FlipViewer website |

This is how a link opened in DHTML window will look like:
Y » Fun g x

Mach 2005 18

=1

FlipViewer® ]

RLJ Magucioes | Bocka | Catsiogs | Oymamic Catwiogs | Reports k

!
Total E-Book
Solution f -
that meets your needs 5 !

E-Book Systems ofers the widest range of E-Book (or

<!
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4.2.3.3 To create an email link:

1. Using Adobe Acrobat, open your PDF document. Draw the link area using the
Link Tool. Under the Link Action, choose Open a web page.

2. To create an email link, enter the email address after "mailto:" and enter the
link tooltips after "|". If you do not enter "| <l/ink tooltips>", the default link
tooltips is "Email to <email address>".

Format:
| mailto:<email address> | <link tooltips> |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "Contact E-Book Systems".

| mailto:supportstd@ebooksys.com | Contact E-Book Systems |

Example: When users mouse-over the link below in FlipBook, users will see the
tooltips "Email to supportstd@ebooksys.com".

| mailto:supportstd@ebooksys.com |

b -

¥ E h.-

? To enable the links in your FlipBooks to be tracked by FlipAnalyzer, you
must have an FlipAnalyzer account!. Select the Enable FlipAnalyzer
Tracking check box under Book Settings. In the final step after publishing is
completed, click the FlipAnalyzer button to register FlipBook to FlipAnalyzer
Server.

Notes:
L If you cannot use some settings in FV Xpress Creator, it means that your FV Xpress Creator ID does
not have the permissions.
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4.3. Flash Guidelines

Before adding Flash (.swf) documents as source files into FV Xpress Creator, you
need to prepare them according to the given guidelines.

4.3.1. General Flash Guidelines

1. In Adobe Flash, design Flash according to the specification, see Flash
specification for FV Xpress. The Flash specification highlights how to make use of
functions provided by_FV Xpress API to interact with FV Xpress. For example, how
to create links using FV Xpress API function.

2. In Adobe Flash, specify the frame rate of your Flash to 30 frames per second
(fps) as FV Xpress is designed in frame rate of 30 fps.

3. Thumbnail generation for Thumbnail View is based on the first frame of your
Flash document. To create a satisfactory thumbnail, only put those layers desired
to be visible at the first frame in Adobe Flash.

4. Publish SWF with at least Flash Player 7 and Action Script 2.0.
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Publish Settings @

Current proﬁle:{Default E] Lh_vl + |5 09
 Formats | Flash |HTML |

Infc

Version:

Load order: | Bottom up {V
ActionScript version: | ActionScript 2.0 || [ Settings...

Options: [:I Generate size report
[]protect from import
[] Omit trace actions
[JPermit debugging
Compress movie
Optimize for Flash Player 6 r65
Export hidden layers
Export SWC

Password:

Script time limit: 15 1 seconds

IPEG quality: | U 80
0 100
Audio stream: MP3, 16 kbps, Mono
Audio event:  MP3, 16 kbps, Mono
[[Joverride sound settings
[CJExport device sounds
Local playback security: | Access local files only EI

[ Publish ]l OK ][ Cancel

L T '.‘

F

('3 If your Flash document is using ActionScript 2.0, you need to use FV
Xpress API written in ActionScript 2.0. If your Flash document is using
ActionScript 3.0, you need to use FV Xpress API written in ActionScript 3.0.
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4.3.2 Flash Specification for FV Xpress

In order to create Flash SWF files that will work optimally in FV Xpress, some
specification need to be followed when designing Flash documents in Adobe Flash.

Steps to make a Flash document works optimally in FV Xpress: (Please
refer to "fvxpress_sample.fla", which can be obtained from your license issuer.)

1. In Adobe Flash, create a new Flash document. Place the class file of FV Xpress
API ("FVXpress.as") (which can be obtained from your license issuer) in a
"classes" folder and place this folder together with your Flash document.

2. In Adobe Flash, add a "xpress" layer as the top layer. Add the following
ActionScript at the first frame of the layer:

#include "classes/FVXpress.as"

_root.initLocalConnection();

function onStart(){
_root.mc_all.gotoAndPlay(2);

by

function onEnd(){
_root.mc_all.gotoAndStop(1);
stopAllSounds ();

b

stop();

Explanation:

(@) The following ActionScripts are for importing the class file of FV Xpress API
("FVXpress.as") and performing initialization.

#include "classes/FVXpress.as"
root.initLocalConnection();

(b) You will add the main Movie Clip instance at step 5. If its instance name is
not "mc_all", please change to the corresponding instance name.

(c) If there are sub-movies in the "mc_all", for example, "mc_R" and "mc_L",
add the following scripts at "onEnd()" function:

_root.mc_all.mc_R.gotoAndStop(1);
_root. mc_all.mc_L.gotoAndStop(1);

(d) Please place ActionScript that will play your animation (Movie Clip) within
the "onStart()" function.
Refrain from using "_root.gotoAndPlay(2);". Directly ask the main Movie
Clip "mc_all" to play by using "_root.mc_all.gotoAndPlay(2);".

(e) Please place ActionScript that will stop and rewind your animation (Movie
Clip) within the "onStop()" function.
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Refrain from using "_root.gotoAndStop(1);". Directly ask the main Movie
Clip instance "mc_all" to stop by using "_root.mc_all.gotoAndStop(1);".

3. The following example shows sample ActionScript of opening a website when
a button is clicked. The button is called "linkButton1" inside the MovieClip
"mc_all" and "http://www.flipviewer.com" is the URL of the website. When the
button is clicked, the website will be opened by a default Web browser. Add the
following ActionScript at the first frame of the top layer.

_root.mc_all.linkButtonl.onRelease = function() {
_root.linkTo("http:/ /www.flipviewer.com");

}s

(@) "_root.linkTo("<URL>");" is a FV Xpress API function used to open the
URL in a Web browser.

4. The following example shows sample ActionScript of flipping to a page inside
the same FlipBook when a button is clicked. The button is called
"internallinkButton" inside the MovieClip "mc_all". When the button is clicked, the
FlipBook will be flipped to page 5. Add the following ActionScript at the first frame
of the top layer.

_root.mc_all.internallinkButton.onRelease = function() {
_root.flipToPage("5");
3

(a) "_root.flipToPage("<Page Number>");" is a FV Xpress API function
used to flip to a page (specified by its page number) in the FlipBook.

5. Add a "Main Movie" layer below the "xpress" layer. Add your main Movie Clip
instance within this layer. Assign an instance name "mc_all" to your main Movie
Clip.

(@) Add "this.stop();" at the first keyframe of the first layer of "mc_all"
instance. This will pause the Movie Clip from being played before we flip to its
page at FV Xpress.

b -

-
¥

fA-
? Tips: To preview your Flash animation in Adobe Flash, you can
temporarily comment the line "this.stop()". However, please make sure it
is uncommented when you publish the final SWF.

6. Publish SWF in Adobe Flash with settings "Flash Player 7" version and
"ActionScript 2.0".
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4.3.3. FV Xpress API

The FV Xpress API provides a list of ActionScript functions that can be used by
Flash creators to communicate with FV Xpress. The FV Xpress API file
("FVXpress.as") can be obtained from license issuer.

b -

E -

# -

? If your Flash document is using ActionScript 2.0, you need to use FV
Xpress API written in ActionScript 2.0. If your Flash document is using
ActionScript 3.0, you need to use FV Xpress API written in ActionScript 3.0.

Steps to include the FV Xpress API file in a Flash document:

1. When creating a Flash document in Adobe Flash, at the first frame of the first
layer of the Flash, you need to add the following ActionScript:

#include "classes/FVXpress.as"
_root.initLocalConnection();

2. The FV Xpress API file should be in a folder called "classes". This "classes"
folder must be in the same folder with the Flash document.
Functions in the FV Xpress API

1. flipToLeft()
Call this function to flip to left.

Example:

_root.btn.onRelease = function(){
_root.flipTolLeft();

bs

2. flipToRight()
Call this function to flip to right.

Example:

_root.btn.onRelease = function(){
_root.flipToRight();

s

3. flipToFrontCover()
Call this function to flip to the front cover.

Example:

_root.btn.onRelease = function(){
_root.flipToFrontCover();

s
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4. flipToBackCover()
Call this function to flip to the back cover.

Example:

_root.btn.onRelease = function(){
_root.flipToBackCover();

bs

5. flipToPage (<pageNumber>)
Call this function to flip to a particular page.
<pageNumber> can be an Integer or a String.

Example 1: The Page Number is obtained from a field.

_root.btn.onRelease = function(){
_root.flipToPage(_root.textField.text);
bs

Example 2: Flip to Page 10

_root.btn.onRelease = function(){
_root.flipToPage(10);
bs

6. linkTo("<URL>")
Call this function to link to a hyperlink or to flip to a page inside the FlipBook.
To launch a hyperlink, specify the full path of the link.

Example:

_root.btn.onRelease = function(){
_root.linkTo(“http://www.flipviewer.com”);
bs

To flip to a page inside the FlipBook, specify the file name of the page to link to.
You can refer the file name from the File Name column in Page Settings step.

Example, "02.swf" is the filename of the page to link to.

_root.btn.onRelease = function(){
_root.linkTo("02.swf");
b

7. set_toolTip (“"<Tooltip Text>")
Call this function to show tooltips when mouse is over a link area.

Example:

_root.btn.onRollOver = function(){
_root.set_toolTip ("Go to Website");

s

8. clear_toolTip()
Call this function to clear tooltips when mouse is out of the link area.
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Example:

_root.btn.onRollOut = function() {
_root.clear_toolTip ();

}s

9. zoomlIn()
Call this function to zoom in the page.

Example:

_root.btn.onRelease = function() {
_root.zoomlIn ();

}s

10. zoomOut()
Call this function to zoom out the page.

Example:

_root.btn.onRelease = function() {
_root.zoomOut ();
b

11. pauseAudio()
Call this function to pause the Background Audio that is being played by FV
Xpress.

Example:

_root.btn.onRelease = function() {
_root.pauseAudio ();

X}

12. resumeAudio()
Call this function to resume the Background Audio that is being paused by
“pauseAudio()” function.

Example:

_root.btn.onRelease = function() {
_root.resumeAudio ();

}s

Loading Externally-Defined URLs from "FVExternalLink.xmlI"

We can define URLs outside of Flash document by defining them in an XML file,
called "FVExternalLink.xml". This XML file needs to be placed in the “xml” folder
which should be located in the resource folder of your FV Xpress FlipBook. The
contents of “FVExternalLink.xml” should be something like the following:

<?xml version="1.0"?>

<Links>
<url key="1" linkTo="http://www.flipviewer.com"/>
<url key="2" linkTo="http://www.flipalbum.com"/>
<url key="3" linkTo="http://www.ebooksys.com"/>
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<url key="4" linkTo="http://www.ebooksystems.co.jp"/>
</Links>

There are 2 main attributes in this XML file, namely the “key” and “linkTo".
“key"” - The keywords used to obtain the corresponding URL. It is used by the
"getLink()" function. See below an example.

“linkTo"” - The URL of the website to be opened by FV Xpress.

A sample of how to call the external URL defined in the XML file:

By calling var URLLink:String=_root.getLink(*1"), the corresponding URL of key
“1” will be obtained from the "FVExternalLink.xml” and be placed at the variable
URLLink. Then by calling _root.linkTo(URLLink), The URL specified by URLLink will

be opened by FV Xpress.

_root.btn.onRelease = function() {
if (_global.isXpress){
var URLLink:String = _root.getLink("1"); //"1" is key
_root.linkTo(URLLink);
b
bs
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4.4. FlipBook Registration Website

After publishing a FV Xpress FlipBook (Server License only) using FV Xpress
Creator, you need to register the FlipBook to DRM Server through FlipBook
Registration website. Click the DRM Server button in summary page to launch
the website in a web browser. In the FlipBook Registration website, you can
register FlipBook license, manage rights and subscriptions.

O3
('3 Registering FlipBook to DRM Server is not applicable if you have chosen
Embedded License under DRM Settings.

4.4.1. Quick Start

Login to FlipBook Registration website with your username and password (note:
login username and password are provided by license issuer). A Main Menu will
be shown as below.

oL

{Quick Start)
Book Management
Book License: Add / Update / Remove
Group Management
Group: Add / Update / Remove
Book in Group: Add / Remove
Rights Template Management
Rights Template (Book & Group): Add / Update / Remove
Rights Template Linkage Management{Hzlp)
Group & Rights Template Linkage: Link / Delink
Book & Rights Template Linkage: Link / Delink
Resultant Rights: Show

Subscription Management
Subscription: Add Single [ Add List / Update / Remove Single / Removye List

Other Management

Display Subscription 10(s) Distributed
Display Subscription 1D(s) that Have Open ok
Display Number of Licenses Created

Copyright 2007 E-Book Systems, Inc. All Rights Reserved,

Steps to register a FV Xpress FlipBook (Server License) at FlipBook
Registration Website:
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1. Add a new Book (choose Book Management > Book License > Add).
2. Add a new Group (choose Group Management > Group > Add).

3. Add the Book to the Group (choose Group Management > Book in Group >
Add).

4. Add a New Rights Template (choose Rights Template Management >
Rights Template (Book & Group)> Add).

5. Link the Rights Template to the Group (choose Rights Template Linkage
Management > Group & Rights Template Linkage > Link / Delink).

6. Add a new Subscription (choose Subscription Management >
Subscription > Add Single).
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4.4.2. Adding a New Book

1. At the Book Management section, click the Add link to add a Book License.
Adding a New Book page will be shown as below.

Book Name: P PDF

Browse to select a Book license to upload

CA\Documents and Settings\jasper.phang\hy Documm

Book Title: FvX PDF {Optional)

Book Type: ‘General iv

| Add Book || Cancel |

2. Enter a Book Name for your FV Xpress FlipBook.

3. Under Browse to select a Book license to upload, click the Browse...
button to select the FlipBook license of your FV Xpress FlipBook. FlipBook license
can normally be found in the "license" folder, which is located in the Output
Folder of FV Xpress Creator.

4. (Optional) Enter a Book Title for your FV Xpress FlipBook.

5. (Optional) Choose a Book Type for your FV Xpress FlipBook. By default, the
Book Type is General.

6. Click the Add Book button to upload the FlipBook license to DRM Server. If
successful, a successful message will be shown as below.

[  <<Home | [ Next>> |
Back to Main Menu Add New Group
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4.4.3. Adding a New Group

A Group is a container of single or multiple Books. Likewise, a Book can be in
single or multiple Groups. A Book in Group A is different from a Book in Group B.
A reader subscribes a Group, not a Book.

1. After adding a new Book successfully, click the Next>> button to add a new
Group. Alternatively, click the Add link at Group Management > Group section.

2. Adding a New Group page will be shown as below.

Group Name: Group FvX PDF
Group Description: This group consists of FvX books converted from PDFg| {optional)

Subscription Type: (Help)

® Sale Mode
@) Book-based Subscription Mode
(@) Time-based Subscription Mode

| Add Group | [ Cancel |

3. Enter a Group Name.
4. (Optional) Enter the Group Description to describe your Group.

5. For Subscription Type, choose from one of these options: Sale Mode, Book-
based Subscription Mode and Time-based Subscription Mode.

Readers will subscribe to groups. Subscription Type of a group will affect how
DRM Server issues licenses for each Book in the Group. (See Subscription

Types).

6. Click the Add Group button to add the new group. If successful, a successful
message will be shown as below.

[ << Home ] [ MNext >> ]
Back to Main Menu Add Book(s) to Group
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4.4.4. Adding Book(s) to Group

1. After adding a new Group successfully, click the Next>> button to add Book(s)
to the Group. Alternatively, click the Add link at Group Management > Book in
Group section. Adding Book(s) to Group page will be shown as below.

Select a Group:

Group FvX PDF R

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go to the next page as shown
below.

Group Name: Group F¥X PDF

Select Book(s):

BBVODFirstXpressBook
Cat_Testl

Cat_Test2
Cat_Test2_FvX

Fvx PDF

xmas

i i

XpressCat
XpressTestFist
XpressTestFLA
XpressTestFLAChina
XpressTestFLADRM
XpressTestingl123

NN NDEMNM

ivi XpressUSDemo

[ Add Book(s) to Group ][ Cancel ]

3. Select one or many Book(s) to be added to the selected Group. Then, click the
Add Book(s) to Group button.
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4. If successful, a successful message will be shown as below.

[ Next>> )
Back to Main Menu Add New Rights Template for Group
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4.4.5. Adding a New Rights Template

A Rights Template contains a set of rights. Before assigning rights to Groups and
Books, Rights Templates need to be added. Then, link Rights Templates to
Groups or/and Books accordingly.

1. After adding Book(s) to Group successfully, click the Next>> button to create
a new rights template. Alternatively, click the Add link at Rights Template
Management > Rights Template (Book & Group).

2. Adding a New Rights Template page will be shown as below.
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Rights Template Name: Rights FvX PDF

Set Time Limit: Yes [

® Start Date: 2008-01-01 (YYYY-MM-DD) Hour 00 [%| Min| 00 v
End Date: 2010-01-01 (YYYY-MM-DD) Hour 23 [%| Min| 53 v

(O Number of days: Hour Min

viewl: ®all pages O Pages:
Enter page index numbers and/for page index ranges
separated by commas. For example, 0,1,3,5-12

Capture Screens: Default \V\
Zoom Pages: Yes \V\
Toggle Window Frames: Default \"\
Play Multimedia Files: Default v/
Print Pages: Yes \V\
Use Right-click Menu: Default |v|
Save Pictures: Default |v|
Enable FV Hot Keys: Default |v|
Copy Text®: Default v
Silent License: No v
Request reader license Yes v

each time opening book:
Check Server Time?: Yes |¥
Auto-add FlipRook ta Fv Library®; | Default [+

Publication Date: Default |v| (YYYY-MM-DD)

LAdd Rights Template ] [ Cancel ]

Note:

1»Q«pplicable to PC Flipviewer only
21f Check server time is ves, your Book cannot be read without Internet connection

3Applicable for online Book(s) only

Please click here to know which Rights are supported by FV Xpress,

3. Enter a Rights Template Name.

4. Specify the rights by referring to table below. To allow a rights, set the rights
to "Yes". To disallow the rights, set the rights to "No". If a rights is set to

116



References

"Default”, in general the rights is disallowed. See Section 4.4.8.1 for more details
of reasons setting rights to “Default”.

Please refer to the table below to know which rights are supported by FV Xpress.

Rights Description
Permission | Supported | Yes/No/Default
by FV
Xpress
Set Time Yes Yes 1. FlipBooks can be opened
Limit within specified Start Date
and End Date.
2. Time limit specified in
terms of Number of days is
not supported by FV Xpress.

No/Default No time limit

View Yes All Pages Allow readers to view all
pages of FlipBooks.

Pages Enter page index numbers
and/or page ranges
separated by commas. For
example, 0,1,3,5-12.
Readers can only view
selected pages.

Capture No Yes Not Applicable

Screens No/Default Not Applicable

Zoom Pages | Yes Yes Allow readers to enlarge
pages for the comfort of
reading.

No/Default Disallow readers to enlarge
pages.

Toggle No Yes Not Applicable

Window No/Default Not Applicable

Frames

Play No Yes Not Applicable

Multimedia No/Default Not Applicable

Files

Print Pages Yes Yes Allow readers to print
contents of FlipBooks.

No/Default Disallow readers to print
contents of FlipBooks.

Use Right- No Yes/Default Not Applicable

Click Menu No Not Applicable

Save Yes Yes Allow readers to download
Pictures and save FlipBook in zip

or/and exe format.
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No/Default

Disallow readers to download
and save FlipBook in zip
or/and exe format.

No

Not Applicable

Copy Text

Yes

Yes

Allow readers to copy text
after selecting text from
pages.

No/Default

Disallow readers to copy text
after selecting text from
pages.

Silent
License

Yes

Yes

Readers do not need to enter
subscription IDs upon
opening FlipBooks. The
feature is designed for free
magazines.

Note: A Book can be in many
Groups. However, a Book can
only have silent-license rights
in one Group.

No/Default

Readers need to enter
subscription IDs upon
opening FlipBooks.

Request
reader
license each
time
opening
FlipBooks

Yes

Yes

Readers will need to have
internet connection and enter
subscription IDs (if required)
when opening FlipBooks.

No/Default

Readers will need to have
Internet connection and enter
subscription IDs (if required)
when opening FlipBooks the
first time. However for
subsequent opening of the
same FlipBook, readers do no
need to enter subscription
IDs but need to have Internet
connection.

Auto-add
FlipBook to
FV Library

No

Yes/Default

Not Applicable

No

Not Applicable
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Check Yes Yes Not Applicable
Server Time

No/Default Not Applicable
Publication Yes Yes Publication Date is the date
Date when the FlipBook is

published. Each FlipBook
should have its own
publication date. If
Publication Date of a FlipBook
falls within readers’
subscription periods, these
readers can read the
FlipBook. This feature is only
applicable to Groups with
subscription type “Book-
based Subscription Mode”.

No/Default Publication Date does not
take effect.

b -

E -

# -

? To know the latest information of which rights are supported by FV
Xpress, please refer to the link "Please click here to know which Rights are
supported by FV Xpress" under Notes section.

5. After setting the rights, click the Add Rights Template button. If successful,
a successful message will be shown as below.

[<<rome

Back to Main Menu Link Rights Template to Group
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4.4.6. Link Rights Template to Group

To assign rights to Groups, link Rights Templates to Groups. After a Rights
Template is linked to a Group, these group-level rights apply to all Books in the
Group. A Rights Template can be linked to single or multiple Groups. When a
Rights Template is updated, all Groups that are linked to the Rights Template are
affected.

1. After creating a new Rights Template, click the Next>> button to link the
Rights Template to a Group. Alternatively, click the Link/Delink link at Rights
Template Linkage Management > Group & Rights Template Linkage.
Group and Rights Template Linkage page will be shown as below.

Select a Group:
Group FVX PDF v

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go to the next page as shown
below.

Group Name: Group F¥X PDF

Select a Rights Template:

Rights FvX PDF v

[ Submit ][ Cancel ]

3. Select a Rights Template and click the Submit button. A summary page
showing the contents of the Rights Template to be linked to the Group will be
shown as below.
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Group Name: Group FVX PDF

The contents of the Rights Template “Rights F¥X PDF" is shown below. Click the Link button to link the Rights Template
to the Group.

Time Limit Start: 2008-01-01 00:00:00; End: 2010-01-01 23:59:00
View All Pages
Capture Screens Default
Zoom Pages Yes
Toggle Windows Frames Default
Play Multimedia Files Default
Print Pages Default
Use Right-Click Menu Default
Save Pictures Default
Enable FV Hot Keys Default
Copy Text Default
Silent License Yes

Request reader license

each time opening FlipBook Yes
Check server time Yes
Auto-add FlipBook to FV Library Default
Publication date Default

5. Click the Link button to confirm linking the Rights Template to the Group. If
successful, a successful message will be shown as below.

[  <<Home | [ Next> |
Back to Main Menu Add New Subscription
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4.4.7. Adding a New Subscription

Each subscription is subscribed to a Group. If a Group has many Books, a
subscription to this Group entitles the reader to read all Books in the Group.

Each subscription has a Subscription ID. Each reader uses his/her own
Subscription ID to open any Books in the Group that has been subscribed. If the
reader has opened a Book in the Group successfully by entering his/her
subscription ID, the rest of the Books can be opened without entering the
Subscription ID.

Note: Readers do not need Subscription IDs to open Books that have Silent
License rights set to yes.

1. After linking the Rights Template to the Group, click the Next>> button to add
a new subscription to the Group. Alternatively, click the Add Single link at
Subscription Management > Subscription. Adding a New Subscription
page will be shown as below.

Select a Group:
Group FvX PDF |ae

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go to the next page as shown
below.

Group Name: Group FYx PDF

Subscription ID: jasper

Subscription Start Date: 2008-01-01 (YYYY-MM-DD)
Subscription End Date: 2008-01-0 (YYYY-MM-DD)

Number of machines allowed to read a Book: 2

[ Add Subscription ] [ Cancel ]

(@) Enter a new Subscription ID. The subscription ID cannot contain any
space or any of the following characters: \/:*?"<>.
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(b) (Optional) In Subscription Start Date field, enter the start date of the
subscription. The date format should be YYYY-MM-DD (i.e. Year-Month-Day).
For example, if the start date is 2008-01-01, it means the start date is 1st of
January 2008.

(c) (Optional) In Subscription End Date field, enter the end date of the
subscription. The date format should be YYYY-MM-DD (i.e. Year-Month-Day).

To add a subscription that has forever subscription period (i.e. the subscription
will not expired), do not enter both Subscription Start Date and
Subscription End Date.

b -

Al

? For Groups that have Subscription Type "Time-based Subscription
Mode", subscription periods will affect the time limit in reader licenses. In
this case, the time limit in a reader license is the overlapping period between
the time limit in Rights Template and subscription period. See Subscription

Types

(d) Enter a number for Number of machines allowed to read a Book. For
example, if you fill in "10", every Book in this Group can be read on ten unique
machines using this subscription ID.

b -
[

¥

fA-
? Each OS (Windows/Mac) login user account for each domain (server that
hosted FV Xpress FlipBook) is counted as a machine by FV Xpress.

In other words, if login user A and login user B share the same PC and read
the same FV Xpress FlipBook, DRM Server will count that there are two
machines have read the Book.

If a FV Xpress FlipBook is hosted at a server with domain Y and a server with
domain Z, and login user A reads the same FV Xpress FlipBook from both of
these servers, DRM Server will count that there are two machines have read
the Book. Thus, it is advisable that FV Xpress FlipBook is only hosted at a
single-domain server.

3. Click the Add Subscription button. If successful, a successful message will be
shown as below.

b -
=

¥

fel™
? To add a Subscription ID dynamically without going through FlipBook
Registration website, see Dynamically Adding a Subscription ID for more
details.
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4.4.8. Advanced Management

4.4.8.1. Link Rights Template to Books

A Rights Template can be linked to a Group or to a Book. When a Rights Template
is linked to a Group, these group-level rights apply to all Books in the Group.
When a Rights Template is linked to a Book in the Group, these book-level rights
apply to this individual Book only.

When a book-level rights is set to "Default", the resultant rights will inherit from
group-level rights. For example, if group-level rights is set to "Yes", and book-
level rights is set to "Default", the resultant rights will be "Yes". When book-level
rights and group-level rights are in conflict (i.e. book-level rights are set to "Yes"
or "No"), book-level rights override group-level rights. For example, if group-level
rights is set to "Yes", and book-level rights is set to "No", the resultant rights will
be "No".

1. Click the Link/Delink link at Rights Template Linkage Management >
Book & Rights Template Linkage. Book and Rights Template Linkage page
will be shown as below.

Select a Group:
Group FvX PDF v

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go to the next page as shown
below.

Group Name: Group F¥X PDF
Select a Book:

FvX PDF v

ESubmit | { Canceﬂ

3. Select a Book and click the Submit button to go to the next page as shown
below.
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Group Name: Group F¥X PDF
Book Name: F¥X PDF
Select a Rights Template:

Rights FvX Book ]

| Submit || Cancel |

4. Select a Rights Template and click the Submit button. A summary page to
show the contents of the Rights Template to be linked to the Book will be shown
as below.

Group Name: Group FVX PDF
Book Name: FVYX PDF

The contents of the Rights Template “Rights F¥X Book" is shown below. Click the Link button to link the Rights Template
to the Book.

Time Limit Forever
View All Pages
Capture Screens Default
Zoom Pages No
Toggle Windows Frames Default
Play Multimedia Files Default
Print Pages Default
Use Right-Click Menu Default
Save Pictures Default
Enable FV Hot Keys Default
Copy Text Default
Silent License Default
g:glﬁi?;ereoapd:r:irl\'gea?pesook Default
Check server time Default

Auto-add FlipBook to FV Library Default
Publication date Default
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For references: The contents of the Rights Template “Rights F¥X PDF" that was added to the Group previously.

Time Limit Start: 2008-01-01 00:00:00; End: 2010-01-01 23:59:00
View all Pages
Capture Screens Default
Zoom Pages Yes
Toggle Windows Frames Default
Play Multimedia Files Default
Print Pages Default
Use Right-Click Menu Default
Save Pictures Default
Enable FV Hot Keys Default
Copy Text Default
Silent License Yes
Request reader license Yes

each time opening FlipBook

Check server time Yes

Auto-add FlipBook to FV Library Default

Publication date Default

6. At the For references section, group-level rights is shown for reference
purposes. Click the Link button to confirm linking the Rights Template to the
Book. If successful, the summary of Resultant Rights will be shown as below.

126



References

Group Name: Group F¥X PDF

Book Mame: F¥X PDF

The Rights Template "Rights F¥X Book" is linked to the Book "F¥X PDF" successfully
Resultant Rights (Group and Book):

Time Limit Farever
View All Pages
Capture Screens Default
Zoom Pages [ [u]
Togagle Windows Frames Default
Play Multimedia Files Default
Print Pages Default
Use Right-Click Menu Default
Save Pictures Default
Enable Fv Hot Keys Default
Copy Text Default
Silent License Yes

Request reader license

each time opening FlipBook ves
Check server time Yes
Auto-add FlipBook to FY Library Default
Publication date Default

P2

? To view Resultant Rights (combination of a Rights Template linked to a
Group and a Rights Template linked to a Book), click the Show link at Rights
Template Linkage Management > Resultant Rights.
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4.4.8.2. Adding a New Subscription List

A list of subscriptions can be added to a Group in a step.

1. Click the Add List link at Subscription Management > Subscription.
Adding a New Subscription List page will be shown as below.

Select a Group:
Group FvX PDF v

[ Submit || Cancel |

2. Select a Group and click the Submit button to go the next page as shown
below.

Group Name: Group FWX PDF
SUbSCriDtiOn ID List (In CSv fUrmat): D\,.MyData\,.temp\]subscnp“onhstCSV

CSV format: Subscription ID, Allove number, Subscription Start Date (YYYY-MM-DD), Subscription End Date (YYYY-MM-DD)

[ Add Subscription List ][ Cancel ]

3. Beside the Subscription ID List (in CSV format) field, click the Browse...
button to select a CSV file from your local hard disk. This CSV file should contain
a list of subscriptions to be added to the Group. Each item in the list must be in
this format:

Subscription ID, Allow number, Subscription Start Date (YYYY-MM-DD),
Subscription End Date YYYY-MM-DD)

Only Subscription ID is compulsory. By default, Allow Number is ?? Subscription
Start Date and Subscription End Date is forever. The CSV file can be created
through Microsoft Excel or created manually using text editor (and save as .csv
file).

Example of the contents of a CSV file:

subidl, 10

subid2, 100

subid3, 20, 2005-01-31, 2005-
12-31

subid4,

subid5, 2, 2005-02-31, 2005-
12-31
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4. Click the Add Subscription List button. If successful, a successful message

will be shown as below.

b -

E -

# -

? To add a Subscription ID dynamically without going through FlipBook
Registration website, see Dynamically Adding a Subscription ID for more
details.
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4.4.8.3. Other Management

4.4.8.3.1. Display Subscription ID(s) Distributed

1. To check subscriptions that have been added, click the Display Subscription
ID(s) Distributed link at Other Management. Display Subscription ID(s)
Distributed page will be shown as below.

From Date: 2007-01-01 (Y -MM-DD)

To Date: 2008-03-31 (YYYY-MM-DD)
Select a Group:

Graup FvX PDF v

[ Submit ][ Cancel ]

2. Enter From Date and To Date. The date format should be YYYY-MM-DD (i.e.
Year-Month-Day). Select a Group and click the Submit button to go to the next
page. The subscription ID(s) that are added to this Group within the specified
period will be displayed as follows.
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From Date:
To Date:
Group Name:

Number of records per page:

37 items found, displaying 1 to 20.

Kdi,2bB0
@
1 jasper
2 subid1
3 subid2
4 subid3
5 subid4
6 subids
7 subidé
- subid7
9 subide
10 subid9
11 subld10
12 subid11
13 subid12
14 =ubid13
1S subidid
16 subid1S
17 subid16
18 subld1?
19 subid18
20 subid19
Export to:

Subsctiotion  subscriptionDate  Subscription StartDate Subscription End Date

2008-01-01
2008-03-31
Group FVX PDF

2008-03-123
16:12:32

2008-03-13
17:59:43
2008-03-13
17:59:43
2008-03-13
17:59:43
2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27
2008-03-13
18:28:27
2008-03-13
18:28:27
2008-03-13
18:28:27
2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:28

2008-03-13
18:28:28
2008-03-13
18:28:28
2008-03-13
18:28:28
2008-03-13
18:28:28

2008-03-13
18:28:28

20 (v

2008-01-01
00:00:00

1990-01-01
00:00:00
19%0-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00

1950-01-01
00:00:00

1990-01-01
00:00:00

1990-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
19%0-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
1990-01-01
00:00:00
19%0-01-01
00:00:00
19%0-01-01
00:00:00

1990-01-01
00:00:00

2009-01-01
23:59:59

2199-12-31
23:99:99
2199-12-31
23:59:59
2199-12-31
23:59:59
2199-12-31
23:59:59

2199-12-31
23159:59

2199-12-31
23:159:59

2199-12-31
23:159:59
2199-12-31
23:59:59
2199-12-31
23:59:99
2199-12-31
23:159:39
2199-12-31
23:59:59

2199-12-31
23159:59

2199-12-31
23159159

2199-12-31
22:59:159

2199-12-31
23:59:59
2199-12-31
23:59:59

2199-12-31
23:59:99

2199-12-31
23159159

2199-12-31
23159159

LastUpdated Date

2008-03-13
16:12:32

2008-03-13
17:59:43
2008-03-13
17:99:43
2008-03-13
17:159:43
2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-123
18:28:27
2008-03-13
18:28:27
2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:27

2008-03-13
18:28:28

2008-03-13
18:28:28

2008-02-13
18:28:28

2008-03-13
18:28:28

2008-03-13
18:28:28

2008-03-13
18:28:28

3. Select how many records to be displayed per page at the drop-down list of
Number of records per page. Use the left/right arrow keys to go to the
previous or next page. To export the records into a CSV file, click the CSV link
beside Export to.
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4.4.8.3.2. Display Subscription ID(s) that Have Opened Book

1. To check which subscription ID(s) have opened a Book, click the Display
Subscription ID(s) that Have Opened Book link at Other Management.
Display Subscription ID(s) that Have Opened Book page will be shown as
below.

Select a Group:
Group FVX PDF v

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go to the next page as shown
below.

From Date: 2008-01-01 ("YYY-MM-DD)
To Date: 2008-03-31 (YYY-MM-DD)
Group Name: Group F¥X PDF

Select a Book:

FvX PDF Pt

[ Submit ][ Cancel ]

3. Enter From Date and To Date. The date format should be YYYY-MM-DD (i.e.
Year-Month-Day). Select a Book and click the Submit button to go to the next
page. The subscription ID(s) that have opened the selected Book within the
specified period will be displayed as follows.

132



References

From Date: 2008-01-01

To Date: 2008-03-31
Group Name: Group FYX PDF
Book Name: FV¥X PDF

Number of records per page: 209 [w

21 items found, displaying 1 to 20.

K1,z B0l
No, Subscription 1D
1 Jasper
2 subid1
3 subid2
4 subid3
5 subid4
6 subidS
7 subidé
8 subid7?
9 subide
10 subide
11 subid10
12 subid11
13 subid12
14 subid13
15 subid14
16 subid1S
17 subid1é
12 subid17
19 subidig
20 subid3s

Export to: csY

4. Select how many records to be displayed per page at the drop-down list of
Number of records per page. Use the left/right arrow keys to go to the
previous or next page. To export the records into a CSV file, click the CSV link
beside Export to.
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4.4.8.3.3. Display Number of Licenses Created

1. To know number of licenses created, click the Display Number of Licenses
Created link at Other Management. Display Number of Licenses Created
page will be shown as below.

Select a Group:
Group F¥X PDF v

[ Submit ][ Cancel ]

2. Select a Group and click the Submit button to go the next page as shown
below.

From Date: 2008-01-01 (Y -MM-DD)
To Date: 2008-03-31 (YYYY-MM-DD)
Group Name: Group F¥X PDF

Select a Book:

FvX PDF v

[ Submit ] [ Cancel ]

3. Enter From Date and To Date. The date format should be YYYY-MM-DD (i.e.
Year-Month-Day). Select a Book and click the Submit button to go to the next
page. Number of Licenses created within the specified period for the selected
Book in the selected Group will be shown as below.

Group Name: Group F¥X PDF
Book Name: F¥X PDF
Number of licenses created: 23

Nurmber of user accounts: 23

4. The number shown beside Number of licenses created is the number of
licenses created for the selected Book in the selected Group. Number of user
accounts is not applicable to FV Xpress.
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b -

¥

fA-
? Each OS (Windows/Mac) login user account for each domain (server that
hosted FV Xpress FlipBook) is counted as a machine by FV Xpress.

In other words, if login user A and login user B share the same PC and read
the same FV Xpress FlipBook, DRM Server will count that there are two
machines have read the Book.

If a FV Xpress FlipBook is hosted at a server with domain Y and a server with
domain Z, and login user A read the same FV Xpress FlipBook from both of
these servers, DRM Server will count that there are two machines have read
the Book. Thus, it is advisable that FV Xpress FlipBook is only hosted at a
single-domain server.
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4.4.9. Others

4.4.9.1. Dynamically Adding a Subscription ID

The alternative way of adding subscription IDs into the database of the DRM
Server is through the use of scripts. This feature caters for those who need to add

subscription dynamically.

On the DRM Server, there is a script that can receive and process requests for

adding subscriptions. The URL of the script is
"http://aspl6.digitalflip.com/drm2/regusr" or

"https://asp9.digitalflip.com/drm2/regusr" (Please check with your license issuer

of the URL of the script to be used.)

The steps of using this method are:
(i) Prepare parameters:

Parameter | Description Type

Name

pb Publisher's username (given by E-Book Required
Systems to access FlipBook Registration
website)

wd Publisher's password (given together with Required
username)

uid Subscription ID (to be assigned by Required
publisher to reader)

gid Group Name of the group that is being Required
subscribed to

sd Subscription Start date (YYYY-MM-DD) Optional

ed Subscription End date (YYYY-MM-DD) Optional

anum Allow Number: Number of machines Optional
allowed to read a FlipBook

(ii) Use HTTP GET method to submit the parameters in step i to the script in
DRM Server.
For example,

http://aspl6.digitalflip.com/drm2/regusr?pb=drm25asp001&wd=xxxxxx&uid=tes
ting123&gid=group 9nov05&sd=2006-01-01&ed=2006-12-12&anum=4

If you submit the above request, you will add a subscription ID "testing123" to
group "group 9nov05". Its subscription start date is 1st January 2006 and end
date is 12 December 2006. All books in the group can be viewed on four unique

machines using this subscription ID.
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4.4.9.2. Dynamically Updating a Subscription ID

After a subscription has been added, you can also update the subscription

dynamically. The subscription information that can be updated are Subscription
Start Date, Subscription End Date and Allow Number.

On the DRM Server, there is a script that can receive and process requests for

updating subscriptions. The URL of the script is
"http://aspl6.digitalflip.com/drm2/updusr" or

"https://asp9.digitalflip.com/drm2/updusr" (Please check with your license issuer
of the URL of the script to be used.)

The steps of using this method are:

(i) Prepare parameters:

Parameter | Description Type

Name

pb Publisher's username (given by E-Book Required
Systems to access FlipBook Registration
website)

wd Publisher's password (given together with Required
username)

uid Subscription ID (to be assigned by Required
publisher to reader)

gid Group Name of the group that is being Required
subscribed to

sd Subscription Start date (YYYY-MM-DD) Optional

ed Subscription End date (YYYY-MM-DD) Optional

anum Allow Number: Number of machines Optional
allowed to read a FlipBook

(ii) Use HTTP GET method to submit the parameters in step i to the script in
DRM Server.

For example,

http://aspl6.digitalflip.com/drm2/updusr?pb=drm25asp001&wd=xxxxxx&uid=test
ing123&gid=group 9nov05&sd=2006-01-01&ed=2007-12-12&anum=10
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4.4.9.3. Subscription Types

The table below shows the differences between each Subscription Types. When
you create a Group, you are required to specify this Group is used for which type
of subscription.

Use Example Recommend
ed Settings

Sale For sale Peter buys a book and he can read it with | Book Time
Mode books, there no book time limit. Limit: No

are no book Subscription

time limit Book Times Limet: o Limt Period: No

and Publication

subscription Date: No

period. Subscription Perad - Ma Limit

Readers can

keep the Liconss Time Limit : Mo LimE

books.
Book- For Peter subscribes Magazine A from 1 May Book Time
based magazines, 05 to 1 Sep 05. He can only read Limit: No
Subscrip | thereis no Magazine A issues published during the Subscription
tion book time period of 1 May 05 and 1 Sep 05. He can Period: Yes
Mode limit. Howev | keep reading them with no book time Publication
(Magazin | er, readers limit. Date: Yes
e) can only read

their Pubilicatian Date

magazine B

issues within ;

their

subscription Eook Tima Limit : No Liri

periods. The

readers can

keep the Susbwcription Period © My, 200510 1 Sap, 206

books.

T May. 2005 i = L]
Lic@nss Time Limt: Ho Limo

Time- For library or | Peter subscribes to a library service from Book Time
based book rental 1 Apr 05 to 1 Apr 06 (Subscription Limit: Yes
Subscrip services, period). He can read all the books in the Subscription
tion there are library. However, certain books may Period: Yes
Mode book time expire (Book time limit) before 1 Apr 06 Publication
(Library) | limit (i.e., and he will not be able to read them after | Date: No

due date) the book expiry dates.

and

subscription

period (i.e.,

membership

period). Rea

ders can only

open books

within the

overlapping
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period.

Bioak Time Limit 1 Jan, 3005 % 1 Dec 2005

1 Jan, 2003

1 Dec, 2005

Subeciption Pedod: 1 Aas, 2005 1o 1 Ape, 2008

1 Ape 2005

Licanas Tise Limit - 1 g, 2005 10
1 e, 20085

1 Ape 2005

1 D, 20015

1 Ape, 2006

Note: After taking a few factors into account (book time limit, subscription period and publication
date), an effective time limit is calculated. The license time limit is the effective period that a reader

can read his book for.
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4.5. Customizable Skin Guidelines

You can customize the button graphics with your designed graphics. The size of
each button graphic must be 25 x 25 pixels (width x height) and in PNG format.

The table below shows the filename of each button graphics. You have to rename
the filename of your button graphics according to table below.

Button Name

Filename of button graphics

About Us FVAbout.png
Bookmark FVBookmark.png
Download FlipBook FVDownload.png
Flip Left FVFlip2Left.png
Flip Right FVFlip2Rite.png

Flip to Front Cover

FVFlip2Front.png

Flip to Back Cover

FVFlip2Back.png

Full Screen FVFullScreenOn.png
Return Full Screen FVFullScreenOff.png
Highlight On FVHighlightOn.png
Highlight Off FVHighlightOff.png
Help FVHelp.png
Information FVInfo.png

Notes FVNote.png

Print FVPrint.png

Save as PDF FVPdf.png

Search FVSearch.png

Select & Copy Text On

FVSelectText.png

Select & Copy Text Off

FVSelectTextOff.png

Settings

FVSetting.png

Share on Social Networks

FVShare.png

Share the FlipBook

FVEmail.png

Start Auto-Flip

FVAutoFlipOn.png

Stop Auto-Flip

FVAutoFlipOff.png

Table of Contents

FVTOC.png

Thumbnail View

FVThumbnail.png

Zoom In

FVZoomIn.png

Zoom Out

FVZoomOut.png

Switch to Single Page View

FVSinglePage.png

Switch to Double Page
View

FVDoublePage.png

Fit-To-Page FVFitToPage.png
Fit-To-Width FVFitToWidth.png
Archive FVArchive.png
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4.6. Google Analytics Tracking

As Google Analytics is a service provided by Google, it is best that you get
familiar with what Google Analytics is all about by visiting
http://www.google.com/analytics.

With earlier versions of FlipViewer Xpress Creator you will have to perform the
traditional way of adding the tracking code. However, FlipViewer Xpress Creator
now comes with a simple feature for you to simply add the Tracking ID and the
Creator will do the adding the tracking code for you at the relevant file(s).

You could enable your FlipBooks to be tracked by Google Analytics by following
the steps below:

1. Sign Up an account of Google Analytics with your Google account. Then login
to your Google Analytics account.

2. Assuming you are going to upload all your FlipBooks to a particular site (eg
http://www.abc.com/FlipBooks), you only need to create a single website profile.
If you upload some of your FlipBooks to other websites
(http://www.xyz.com/FlipBooks), you will need to create multiple website profiles.

(@) Choose the option “Add a Profile for a new domain”.

(b) Enter the URL of the folder that hosts your FlipBook as the site you would
like to track.

(c) Click the “Finish” button.

3. At the end of creation of new website profile, you'll be given a tracking code,
something like the following, except the string in the bracket is unique for each
website profile: "UA-5733805-6"

<script type="text/javascript">

var gaqg = gaq || [];

_gaqg.push([' setAccount', 'UA-5733805-6']);
_gaqg.push([' trackPageview']);
(function () {

var ga = document.createElement ('script'); ga.type =

'text/javascript'; ga.async = true;

ga.src = ('https:' == document.location.protocol ?
'https://ssl' : 'http://www') + '.google-analytics.com/ga.js';

var s = document.getElementsByTagName ('script') [0];
s.parentNode.insertBefore (ga, s);

PO

</script>
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4. Copy the Tracking ID (e.g. UA-5733805-6) and launch FlipViewer Xpress
Creator. Going through the normal process of starting a project by inserting your
source files, you will come to the settings. In the Book Settings tab, select the
Use Google Analytics check box and then enter the Tracking ID. Proceed with
the rest of the settings and publish your FlipBook. FlipViewer Xpress Creator will
add the relevant tracking codes into the HTML page that launches the FV Xpress
FlipBook, i.e. "flipviewerxpress.html".

5. Google Analytics generally updates your reports every 24 hours. This means
that it could take 24 hours for data to appear in your account after you have first
installed the tracking code. To view the Google Analytics Report for a FlipBook,
click the "View Report" link of the corresponding website profile.

b -

¥

E :
? To better manage your FlipBook analytics, you can upload each FlipBook to
a different folder of the website profile (e.g.
http://www.abc.com/FlipBooks/FlipBook1/ and
http://www.abc.com/FlipBooks/FlipBook2/ etc).

For more detail information of using Google Analytic tracking for your FlipBooks,
please refer to http://www.flipviewer.com/fvx/GAHelp/.
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5.0. Using FlipViewer Xpress
Creator License Registration

5.1. Register License to DRM Server

After you have published a FV Xpress FlipBook (Server License) using FV Xpress
Creator, you will see the DRM Server button in the final step after publishing.

4 FlipViewer ¥press Creator = e

FlipViewer Xpress FlipBook Published MyFlipBook

You have successfully published the Flip\Wiewer Xpress FlipBook.

Location of your FlipViewer Xpress FlipBook:

C:\Users'jarjar\Documents\EBookSys \FlipviewerXpressCreator \MyFlipBook _output'web

m

Location of the FlipBook License for this FlipViewer Xpress FlipBook:
C:\Users'jarjar\Documents\EBookS ys \FlipViewerXpressCreator \MyFlipBock_outputYicense

Steps to publish your FlipViewer Xpress FlipBook online:
1. Register FlipBook license with DRM Server to activate your FlipBook. CRM Server

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipaAnalyzer

3. Publish FlipBook for viewi iPad.
ublish FlipBeok for viewing on iPa Pad
4, Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FV Xpress FlipBook is the URL of the flipviewerxpress.html.” Upload
5. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enzble FlipBook to be Searched by Search Engines”

gei

Help Finish

Clicking the DRM Server button will open the FV Xpress Creator License
Registration dialog box as shown below.
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2 FlipViewer Xpress Creator E=N (S|

Book Mame: MyFlipBook

Group Mame: DefaultFyXpressGroup

The Group name “DefaultFyVXpressGroup™ has been pre-created in the DRM Server
and can be used for most publications.

For advanced users who want to create new Groups, Rights Templates and add
subscription IDs,please go to FlipBook Registration website.

The Project Name that you have specified in FV Xpress Creator will be the
default value for the Book Name. The Book Name should be a unique new name
that has never been registered to DRM Server before.

b -

¥

fA-
? If you republish the FlipBook and want to update its license on
DRM Server, please go to FlipBook Registration website.

The default Group that the Book will be added to is "DefaultFVXpressGroup".
You can enter another Group Name, which you may have created through
FlipBook Registration website.

The Rights Template that is linked to this default Group "Default FV Xpress
Group" in DRM Server is "DefaultFVXpressRightsTemplate". The summary of
the rights in this rights template is as follows:

Rights Description

Permission Value

Time Limit Forever There is no time limit for this book.

View All Pages Allow readers to view all pages of FlipBooks.

Print Pages Yes Allow readers to print contents of FlipBooks.

Zoom Pages Yes Allow readers to enlarge pages for comfort
reading.

Copy Text No Disallow readers to copy text after selecting
text from pages.

Silent License Yes Readers do not need to enter subscription
IDs upon opening FlipBooks. The feature is
designed for free magazines.

Click the Register button to register FlipBook license to DRM Server.
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If the license registration is successful, you will see the summary page as shown
below. Your FlipBook is nhow activated for viewing.

Information LiE-J

Your FlipViewer Xpress FlipBook is registered to DRM Server.
Your FlipBocok is now activated for viewing.

You can now view your FlipBook by clicking the View button in the final step.

4 FlipViewer Xpress Creator = 2

FlipViewer Xpress FlipBook Published MyFlipBook

You have successfully published the FlipViewer Xpress FlipBook.

Location of your FlipWiewer Xpress FlipBook:

C:\UsersYjarjar\Documents \EBookSys \FlipWiewerXpressCreator MyFlipBook_outputiweb View

Location of the FlipBook License for this Flipiewer Xpress FlipBook:
C:\Users'jarjar\Documents \EBookSys \FlipWiewerXpressCreator MyFlipBook _outputicense

Steps to publish your FlipViewer Xpress FlipBook online:
1. Register FlipBook license with DRM Server to activate your FlipBook. DRM Server

2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tradking. FlipAnalyzer

[%5)

. Publish FlipBook for viewing on iPad.

B

Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FV Xpress FlipBook is the URL of the "fipviewerxpress.html.” Upload

. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines”

w

b -

¥

fA-
? For advanced users who want to create new Groups, Rights Templates
and subscription IDs, please go to the FlipBook Registration website.
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6.0. Using FlipViewer Xpress
Creator Uploader

6.1. Upload FlipBook

After you have published a FV Xpress FlipBook using FV Xpress Creator, you will
see the Upload button in the final step after publishing.

4 FlipViewer Xpress Creator = [ [

FlipViewer Xpress FlipBook Published MyFlipBook

You have ully published the Flip'

Location of your FlipWiewer Xpress FlipBook:

C:\WsersYjarjar \Documents \EBookSys \FlipViewer¥pressCreator MyFlipBook _outputiweb View

Location of the FlipBook License for this FlipViewer Xpress FlipBook:
C:\Users'jarjar\Documents \EBookSys \FlipWiewerXpressCreator MyFlipBook _outputicense

Steps to publish your FlipViewer Xpress FlipBook online:

1. Register FlipBook license with DRM Server to activate your FlipBook. DRM Server
2. Register FlipBook with FlipAnalyzer Server to activate FlipBook tracking. FlipAnalyzer
3. Publish FlipBook for viewing on iPad.

B

Upload FlipBook to your Web Server. All files and sub-folders should be uploaded.
The final URL to view the FV ¥press FlipBook is the URL of the "flipviewerxpress. hitml.” Upload

&n

. To enable FlipBook to be searched by common search engines, follow steps under topic
"Enable FlipBook to be Searched by Search Engines”

Clicking the Upload button will open the FV Xpress Creator Uploader as shown
below.

The main XML file ("<Project Name>.xml") of the FlipBook that you have just
published will by default be selected at FlipBook to be Uploaded.
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2 FlipViewer Xpress Creator E=1 (S|

FlipViewer Xpress Creator Uploader

Upload FlipBook to your Web Server.

FlipBook to be Uploaded:

C:\WUsersijarjar Documents \EBookSys \FlipViewerXpressCreator

Mame of the FlipBook Folder:
MyFlipBook

Mame of Folder on Server to Upload Archive XML:

archive

URL of Archive XML as below:
hittp: /fasia2. digitalflip.comfarchive farchive. xml

Select a Site:
| |asia2 -

Selected Site

FTP Host: asia2. digitalflip. com
Host Directory: public_html

URL Prefix: http: f{asiaz. digitalflip. com

Help ‘ I Manage Sites...

Alternatively, if you have accepted the default options in the installation process,
you can open the FV Xpress Creator Uploader by using the following method:

Click Start > Programs > E-Book Systems > FlipViewer Xpress Creator >
FlipViewer Xpress Creator Uploader

FV Xpress Creator Uploader will be opened as shown below.
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2 FlipViewer Xpress Creator E=1 (S|

FlipBook to be Uploaded:

Browse...

Mame of the FlipEook Folder:

|| Select a Sites

Asigd -

Selected Site

FTP Host: asia2. digitalflip. com
Host Directory: public_html

[ URL Prefix: http: f{asiaz. digitalflip. com

Help | | Manage Sites... pload

Click the Browse... button to select the main XML file ("<Project Name>.xml")
of the FlipBook to be uploaded. All deployment files and folders related to this
FlipBook will be uploaded. By default, your FlipBook should be located at this
folder "<My Documents path>\EBookSys\FlipViewerXpressCreator\<Project
Name>_output\web\" in your PC.

Enter a name at Name of the FlipBook Folder. A folder with this name will be
created behind the URL Prefix.

Select a Site from the list to upload your FlipBook. The settings of the selected
Site will be displayed at the Selected Site column.

To add or update a Site settings, click the Manage Sites... button.

Click the Upload>> button to start uploading your FlipBook to your Web Server.
You will see the uploading is in progress as shown below.
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2 FlipViewer Xpress Creator L= [ e —)

Mumber of files uploaded: 122 of 245

Total size uploaded: 7,712,218 of 14,825,086 bytes

Cancel

Once the uploading is completed, you will see the summary page as shown below.
The final URL to view the FlipBook is the URL of the "flipviewerxpress.html". This
is the URL of the FV Xpress FlipBook to be distributed to your readers. You can
click on the first link to view the FlipBook in the browser or click the first "Copy
URL" button to copy the link.

The URL to view the Embedded Viewer (if any) of the FlipBook is the URL of the
"flipviewerxpress.html" under the "embed" folder. You can click on the second
link to view the Embedded Viewer of the FlipBook in the browser or click the
second "Copy URL" button to copy the link. You can copy the embedded code by
clicking the "Copy Embedded Code" button. To embed the Embedded Viewer on
your website, you need to pass the URL of the Embedded Viewer or the copied
Embedded Code to your website administrator. For details on how to embed an
Embedded Viewer on a website, please refer to topic "2.11. Embedded Viewer".
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2 FlipViewer Xpress Creator L= [ o )

FlipViewer Xpress Creator Uploader

Uploading is completed

¥ou have successfully uploaded your FlipBook. Clidk the link below to view yvour FlipBook.
http: ffasia2. digitalflip. com MyFlipBook flipviewerxpress. himl [

You have successfully uploaded your Embedded Viewer. Click the link below to view.
http: f/asia2. digitalflip. comMyFlipEook /fembed fipviewerxpress. hitml ’

Copy URL ]

~
PLUGINSPAGE="http: /fwww.macromedia. com/shockwave download findex. cgi? [ Copy Embedded Code ]
F1_Prod_Version=ShockwaveFlash™ >

< [EMBED =
< fobject=

Click the "Finish" button to close the FlipViewer Xpress Creator Uploader.
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6.2. Manage Sites

If you click Manage Sites button from the FV Xpress Creator Uploader, you
will see the dialog box as shown below. You can add or update or remove a site
at this dialog.

2 FlipViewer ¥press Creator L= S

MName FTP Host Part Host Directaory URL Prefix Login
http://asia2.digitalfl... digiasia2

fwxpress fyxpress.digifip... 21 fuxpress.digifip... http://fvxpress.digi... fuxpress

Configure FTP Server

l Site Mame: Asial

[ FTP Host asia 2. digitalflip.com Port: 21 Passive
Host Directory: public_html

Login: digiasiaz Eszzorrik

URL Prefix: http: ffasia2. digitalflip. com

< <Back H Test H Add H Update ” Remove

Add a New Site?

Enter a name at Site Name text box. This is the name for you to identify the site.

Enter the host name of the FTP Host and its Port number to which you upload
files. Your FTP Host is the full Internet name of a computer system, such as
asp6.digitalflip.com. Enter the full host name without any additional text. In
particular, do not add a protocol name in front of the host name. This information
can be obtained from the administrator of your Web Server.

Enter the Host Directory of the remote site where you store files that are visible
to the public.

Enter the Login and Password that you use to connect to the FTP server, and
then click the Test button to test your connection with the server.

In the URL Prefix text box, enter the URL users will type in their browsers to
open your website, but do not include any filename. The URL Prefix comprises
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the domain name and any of your website's home directory's subdirectories, but
not a filename.

After specifying all settings, click the Add button to add the site.

Update an Existing Site

Select an existing site from the list on top. The settings of the site will be shown
at Configure FTP Server column.

After modification, click the Update button to save the changes.

Remove an Existing Site
Select an existing site from the list on top.

Click the Remove button to remove the site from the list.

Test Connection

Select an existing site. Click the Test button to test whether Uploader could
connect to the FTP Server successfully. If FV Xpress Creator could not connect to
the server correctly, please check whether you have entered the FTP Server
settings correctly and you must be connected to the Internet while testing.

After you have made the changes, click the <<Back button to go back to first
step of FV Xpress Creator Uploader.

Note:
These information can be obtained from the administrator of your Web Server.
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7.0. Using FlipViewer Xpress
Creator Archive Tool

7.1. Create or Update an Archive XML

An archive of FlipBooks will be defined in an Archive XML which determines what
FlipBooks are to be displayed when readers click the "Archive" button in FV
Xpress FlipBooks.

An Archive XML can be prepared through the FV Xpress Creator Archive Tool.
After creating or updating an Archive XML through FV Xpress Creator Archive
Tool, the Archive XML needs to be uploaded to your Web Server. The URL of the
XML file needs to be registered to the FlipBooks through FV Xpress Creator or
manually.

You can open the FV Xpress Creator Archive Tool by using the following
method:

Click Start > Programs > E-Book Systems > FlipViewer Xpress
Creator > FlipViewer Xpress Creator Archive Tool

FV Xpress Creator Archive Tool will be opened as shown below.

3 FlipViewer Xpress Creator Archive Tool = 23|
FlipViewer Xpress Creator Archive Tool
Archiving Definitior
@ Create an Archive =ML Update an existing Archive XML
Local &rchive #ML Browse..
Oniine Archive XML Fietrieve
Boak to be Archived Archived Books
@ Local FlipBook Browse .. Title URL
Orline FlipBook Retriewe
Book Info
Book URL:
Title:
Luthor:
Shaws this FipBook Add/Update
Book Cover Move Up ‘ ‘ Move Down ‘ ‘ Remave | | Remove Al
Save Archive
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Create an Archive XML

3 FlipViewer Xpress Creator Archive Tool = 25|
FlipViewer Xpress Creator Archive Tool
| Archiving Definitior
@ Create an Archive =ML Update an existing Archive XML

Local Archive HML Browise.
Oniine Archive XML Fietrieve

Book to be Archived Archived Books

@ Local FlipBook  C:WsershjarianD ocumentshEB ook Sys\FlipViswenpressCreat | Browse . Title URL

Online FlipB ook Retrieve

Book Info
Book URL:  hitp:#/asia2 digitalflip.comdMyFlipE ook fipviewerspres ==

Title: MyFlipBook

Authar: E-Book Systems

[ 5how this FlipBook | | Add

Book Cover Move Up ‘ ‘ Move Down ‘ ‘ Remave | | Remove All

Help Save Archive

To create a new Archive XML, please follow the steps below:
1. Choose the "Create an Archive XML" option.

2. Click the Browse... button at "Book to be Archived" section. Select the main
XML ("<Project Name>.xml") file of the FlipBook to be included in the Archive.
By default, your FlipBook should be located at this folder "<My Documents
path>\EBookSys\FlipViewerXpressCreator\<Project Name>_output\web\" in your
machine.

3. Once the main XML file of the FlipBook is selected, you will see its book info
under "Book Info" section. Enter the URL of the FlipBook, i.e. the URL of the
"flipviewerxpress.html" which you have uploaded. When the readers click on the
book cover in the "Archive" dialog box of FV Xpress, this is the URL of the
FlipBook that will be launched. You can customize other book info

like Title and Author, if any.

4. Clicking the "Show this FlipBook" button will preview the FlipBook located in
the URL specified in the previous step. Click the "Add/Update" button to add the
FlipBook into the Archive XML. The FlipBook will be added to the "Archived
Books" list.

5. Repeat step 1 to 4 to add other FlipBooks that need to be archived together.
All the FlipBooks that are added to an Archive XML can be seen under "Archived
Books" list. Click "Move Up" and "Move Down" buttons to adjust their positions.

6. Click the "Save Archive" button to save the Archive XML in your PC. Give
a File name for the Archive XML file.
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ETE =)

Save in: | archive - ﬂ ; Bl El'

Mame Date modified Ty

Me iterns match your search.

4 L k

File name: archive Save

Save astype: | FlipViewer Archiving Defintion »| | Cancel |

7. After saving the Archive XML in your PC, click the "Upload" button to upload
the Archive XML file to your Web Server.

= FlipViewer Xpress Creator Archive Tool L= [ o )

FlipViewer Xpress Creator Archive Tool

You have successfully saved the Archive XML at the following location.

C:\Users'jarjar\Documents \EBookSys \FlipViewerXpressCreator \archive\archive. xml

Click the "Upload™ button to upload the XML to your Web Server.

Click the "Finish” button to create another Archive XML,

Update an Existing Archive XML

To update the Archive XML to include more FlipBooks or update the book
info, please follow the steps below:

1. Choose the "Update an existing Archive XML" option.
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2a. Select the "Local Archive XML" option and click the "Browse" button to

select an Archive XML from your PC

3 FlipViewer Xpress Creator Archive Tool P—

= o 83|

FlipViewer Xpress Creator Archive Tool

Archiving Definitior

) Create an Archive =ML @ Update an existing Archive XML

@ Local &rchive =ML

") DOnline Archive =ML

Boak to be Archived

C:AUeers\jarar\Documents'E B ookS pshFliphieweri<pressCreator archivel archive. xml

Browse:

Retrigve

@ Local FlipBook  C:WsershjarianD ocumentshEB ook Sys\FlipViswenpressCreat | Browse .

") Drlline FlipB ook, Retrieve

Book Info

Book URL:  hitp:#/asia2 digitalflip.comdMeFlipB ook 1 fipviewerspre == s
Title: MyFlipBock] o

Authar: E-Book Systems

| I Shaw this FipBook J I Update

Book Cover

Archived Books
Title URL
MyFlipB ook

http: /#asia2. digitalflip. com/MyFipE ook Mipviewer.
ak

...
gitalflip. com/MyFlipB o I

MyFlipB ookl

Move Up J { Move Down J { Remave I I Remove Al I

2b. Alternatively, choose the "Online Archive XML" option to update an Archive
XML that has been uploaded previously to your Web Server. Enter the URL of the
Archive XML and click the "Retrieve" button.

3 FlipViewer Xpress Creator Archive Tool = 25|

FlipViewer Xpress Creator Archive Tool

Archiving Definitior

) Create an Archive =ML

Book to be Archived

@ Local FlipBook.

_ 1 Online FlipB ook

Book Info

|l Book URL:
Titke: MyFlioBook]
Authar: E-Book Systems

@ Update an existing Archive XML
) Local Archive =ML

@ Online Archive =ML

hitp://asia2. digitalflip. com/ archive archive. sml

Browise:

Archived Books

Browse ...

Retrieve

hitp: 4/ asia2. digitalflip. coméMyFlipB ook 1 Aflipviewerspre == s

I Shaw this FipBook J I

Update

Book Cover

Title URL
MyFlipB ook

http: /#asia2. digitalflip. com/MyFipB ook Mipviewerspr...
MyFlipB ook i ! -

Move Up J [ Move Down J [ Remave I I Remove All I

3. Once an existing Archive XML is selected from PC or retrieved from an online
location, all the FlipBooks in the Archive XML file will be listed in the "Archived

Books" section.

4. Click on any of the book listed in the "Archived Books" section to view its
Book Info. You may modify the book info under "Book Info" section. After
updating, click the "Update" button to save the updates.
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5. To add a new FlipBook to the Archive XML, click the "Browse..." button at
"Books to be Archived" section and select the main XML file of the FlipBook.
Enter the URL of the FlipBook and update its book info. Click the "Update" button
to add the FlipBook to the "Archived Books" list.

6. Click the "Save Archive" button to save the Archive XML in your PC.

7. After saving the Archive XML in your PC, click the "Upload" button to upload
the Archive XML file to your Web Server. If you are updating an existing Archive
XML in your Web Server, you may want to consider uploading to the same
location.

8. Once the Archive XML is uploaded through FVX Creator Uploader, the URL of
the Archive XML will be automatically registered in the launching HTML page
(flipviewerxpress.html) for the FlipBook you have just created.

b -

-
¥

$ :
? If you are not using the FVX Creator Uploader to upload your Archive XML
file to your Web Server, the URL of the Archive XML file will not be automatically
registered in the launching HTML page (flipviewerxpress.html) for the FlipBook
you have just created. You will have to manually edit the flipviewerxpress.htmi
file to update the URL of the Archive XML file.

Using notepad or any html editor to open the flipviewerxpress.html file, locate
the line that says:

var urlOfArchivingServer = "[_URLOFARCHIVINGSERVER_]"

For example: var urlOfArchivingServer =
"http://www.flipviewer.com/FlipBooks/Archive/Archive.xml|"

Save the flipviewerxpress.html file and upload it to your Web Server together
with all the other folders/files created by FVX Creator.

7.2. Saved Archive XML

After creating or updating an Archive XML, click the "Save Archive" button will
prompt you to save the Archive XML in your local hard disk and you will see the
following step.
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= FlipViewer Xpress Creator Archive Tool L= [ o )

FlipViewer Xpress Creator Archive Tool

You have successfully saved the Archive XML at the following location.

C:\Users'jarjar\Documents \EBookSys \FlipViewerXpressCreator \archive\archive. xml

Click the "Upload™ button to upload the XML to your Web Server. IUpload

Click the “Finish™ button to create another Archive XML,

Click the "Upload" button to upload the Archive XML to your Web server or click
the "Finish" button to create another Archive XML.

7.3. Upload Archive XML

After the Archive XML is saved in your PC and the "Upload" button is clicked, you
will see the following step to upload the Archive XML to your Web Server.
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gﬂip‘u'iewer Hpress

| FlipViewer Xpress Creator Archive Tool
Upload ive XML to your Web Server.

Mame of Folder on Server to Upload Archive XML:

archive

Select a Site:
Aszig2 -

Selected Site

FTP Host: asia2. digitalflip. com
Host Directory: public_html
URL Prefix: http: /fasia2. digitalflip. com

URL of Archive XML as below:
http: /fasia2. digitalflip.com/ardhive fardhive . xml

Help ] ’ Manage Sites...

Click the "Manage Sites" button to create FTP site account of your Web Server,
if you have not done so.

If you have created a site before, select a site to upload your Archive XML from
the drop-down list of "Select a Site". The FTP information of your selected site
will be shown at "Selected Site" section.

Enter a name at "Name of Folder on Server to Upload Archive XML". This will
be the folder name that contains the Archive XML on the Web Server.

Click the "Upload" button to start uploading the Archive XML to your specified

site. You will see the progress of the uploading as shown in the following dialog
box.
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../FVX%202.5/Help%20Files/fvxcreator_archivetool2_5_helpfile/Manage_Sites.htm

3 FlipViewer Xpress Creator Archive Toal g A = = 3

FlipViewer Xpress Creator Archive Tool

Uploading is in progress

Mumber of files uploaded: 1

Total size uploaded: 45 of 1,142 bytes

Cancel

Once the Archive XML is successfully uploaded, you will see the following final
step.

2 FlipViewer Xpress Creator Archive Tool b= S

FlipViewer Xpress Creator Archive Tool

Uploading is completed

¥ou have successfully uploaded the Archive XML, Click the "Copy to Clipboard” button to copy the URL.

http: f/asia2. digitalflip. com/farchive farchive. xml

Click the "Copy URL" button to copy the URL of the Archive XML.
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7.4. Manage Sites

If you click Manage Sites button from the FV Xpress Creator Archive Tool,
you will see the dialog box as shown below. You can add or update or remove a
site at this dialog.

2 FlipViewer ¥press Creator (=] |-

[ MName FTP Host Part Host Directaory URL Prefix Login

http://asiaZ.digitalfl... digiasia2
fwxpress fyxpress.digifip... 21 fuxpress.digifip... http://fvxpress.digi... fuxpress

Configure FTP Server

l Site Mame: Asial

[ FTP Host asia 2. digitalflip.com Port: 21 Passive
Host Directory: public_html

Login: digiasiaz Eszzorrik

URL Prefix: http: ffasia2. digitalflip. com

< «<Back H Test H Add H Update ” Remove

Add a New Site?

Enter a name at Site Name text box. This is the name for you to identify the site.

Enter the host name of the FTP Host and its Port number to which you upload
files. Your FTP Host is the full Internet name of a computer system, such as
aspé6.digitalflip.com. Enter the full host name without any additional text. In
particular, do not add a protocol name in front of the host name. This information
can be obtained from the administrator of your Web Server.

Enter the Host Directory of the remote site where you store files that are visible
to the public.

Enter the Login and Password that you use to connect to the FTP server, and
then click the Test button to test your connection with the server.

In the URL Prefix text box, enter the URL that users will type in their browsers
to open your website, but do not include any filename. The URL Prefix comprises
the domain name and any of your website's home directory's subdirectories, but
not a filename.

After specifying all settings, click the Add button to add the site.
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Update an Existing Site

Select an existing site from the list on top. The settings of the site will be shown
at Configure FTP Server column.

After modification, click the Update button to save the changes.

Remove an Existing Site
Select an existing site from the list on top.

Click the Remove button to remove the site from the list.

Test Connection

Select an existing site. Click the Test button to test whether FV Xpress Creator
Archive Tool could connect to the FTP Server successfully. If it could not connect
to the server correctly, please check whether you have entered the FTP Server
settings correctly and you must be connected to the Internet while testing.

After you have made the changes, click the <<Back button to go back to the
previous step.

Note:
These information can be obtained from the administrator of your Web Server.
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8.0. Customer Support

8.1. Questions and Answers

Q1. When is the expiry date of the FV Xpress Creator?

Al. The expiry date of the FV Xpress Creator will be different for each FV Xpress
Creator ID, which will be issued by your license issuer. You can check the expiry
by clicking the FV Xpress Creator icon at the title bar and choose Update
FlipViewer Xpress Creator ID from the drop-down list. You will see the expiry
date of your FV Xpress Creator ID.

Q2. Why the publishing of FV Xpress FlipBook takes a long time?

A2. Publishing FV Xpress FlipBook requires some of your system resources (CPU,
available RAM, hard disk space, etc). Thus, it is advisable that you close other
unused applications while publishing FV Xpress FlipBook in order to speed up the
publishing process.

Sometimes, FV Xpress Creator may appear hang temporary during publishing if
the FlipBook to be published has a lot of pages or/and files with big file sizes
or/and your system resources is running low.

Q3. Why those FLVs that will be called by SWF files through ActionScript
are not showing up?

A3. After publishing is completed, you need to copy those FLV files that will be
called by SWF files through ActionScript to the resource folder of your FV Xpress
FlipBook. Your FV Xpress FlipBook is in a "web" folder within the output folder
("<Project Name>_output").

Then you need to launch the FlipViewer Xpress Creator Packager by choosing
"Start> Program Files> E-Book Systems> FlipViewer Xpress Creator>
FlipViewer Xpress Creator Packager". You need to re-package the packages
in order that the downloadable packages will include the FLV files that you have
manually copied over. Your FV Xpress FlipBook will be re-published during this
process. Thus, you need to re-upload your FV Xpress FlipBook (with the
downloadable packages) to your Web Server.

Besides, in the FLA file, the FLV path needs to be prepared in the way highlighted
in the example below.

var nc2:NetConnection = new NetConnection();
nc2.connect(null);

var fvx_video_ns2:NetStream = new NetStream(nc2);
video2.attachVideo(fvx_video_ns2);

function playMovie2() {
if(lisStarted) {

var path = "video2.flv";
if (_global.isXpress) {

path = _global.parent_path + path;
b2
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fvx_video_ns2.play(path);
isStarted = true;

¥ else {
fvx_video_ns2.pause();

b

pauseButton2._visible = true;

playButton2._visible = false;

Q4. Why do I not able to listen to the audio in the Flash that is being
controlled by ActionScript?

A4. In Adobe Flash, in the function to create a "Sound" object, i.e. "var
myvoice:Sound = new Sound(this);", please add a "this" inside the "Sound"
function call.

var myvoice:Sound = new Sound(this);
myvoice.attachSound("mouseover_voice");
myvoice.start();

Q5. How to create links to flip to pages within the same FV Xpress
FlipBook?

A5. To create links to flip to pages within the same FlipBook, please refer to
section "Create Links in Adobe Acrobat".

Q6. Why do I not able to see my FV Xpress FlipBook even though I have
uploaded the FlipBook?

A6. Please make sure that you have followed steps mentioned at General
Publishing Flow topic.

You may have more questions, please go to Customer Support.
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8.2. Customer Support

Email Support:

If you have any questions or comments about FlipViewer Xpress Creator, our

Customer Support team can be contacted via email at
supportstd@ebooksys.com

Please include the following information so that we may serve you better:

1. FlipViewer Xpress Creator version

2. Type of computer you are using

3. Windows version (e.g. Windows 7, Windows Vista etc.)
4. Your questions or comments

Other Contacts:

If you have marketing or resellers related enquiries, please contact us at:

sales@ebooksys.com

If you have web site related enquiries, please contact us at:

webmaster@ebooksys.com

For more information, please visit our web sites at:

http://www.flipviewer.com
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